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KUKA
1 Introduction

1.1 Target group

This documentation is aimed at users with the following knowledge and skills:

m Basic knowledge of the industrial robot

@ | For optimal use of our products, we recommend that our customers
1 take part in a course of training at KUKA College. Information about
the training program can be found at www.kuka.com or can be ob-
tained directly from our subsidiaries.

1.2 Industrial robot documentation

The industrial robot documentation consists of the following parts:

Documentation for the manipulator

Documentation for the robot controller

Operating and programming instructions for the KUKA System Software
Documentation relating to options and accessories

Parts catalog on storage medium

Each of these sets of instructions is a separate document.

1.3 Representation of warnings and notes

Safety These warnings are relevant to safety and must be observed.

A DANGER These warnings mean that it is certain or highly probable

that death or severe physical injury will occur, if no pre-
cautions are taken.

These warnings mean that death or severe physical inju
| /A WARNING | ry may occur, if no precautions are taken.

These warnings mean that minor physical injuries may
IA CAUTION I occur, if no precautions are taken.

NOTICE These warnings mean that damage to property may oc-

cur, if no precautions are taken.

These warnings contain references to safety-relevant information or
A general safety measures. These warnings do not refer to individual
hazards or individual precautionary measures.

Notes These hints serve to make your work easier or contain references to further
information.

@ | Tip to make your work easier or reference to further information.

1

1.4 Trademarks

Windows is a trademark of Microsoft Corporation.

Issued: 20.07.2012 Version: KSS 8.2 END V2 en (PDF




KUKA KUKA System Software 8.2

WordPad is a trademark of Microsoft Corporation.
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2 Product description

2.1 Overview of the industrial robot

The industrial robot consists of the following components:

Manipulator

Robot controller
Teach pendant
Connecting cables
Software

Options, accessories

‘tnn

Fig. 2-1: Example of an industrial robot

1 Manipulator 3 Robot controller
2 Connecting cables 4 Teach pendant
2.2 Overview of the software components
Overview The following software components are used:

m  KUKA System Software 8.2
= Windows XPe V3.0.0

2.3 Overview of KUKA System Software (KSS)

Description The KUKA System Software (KSS) is responsible for all the basic operator
control functions of the industrial robot.

Path planning

I/0O management

Data and file management

etc.
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smartHMI

Additional technology packages, containing application-specific instructions
and configurations, can be installed.

The user interface of the KUKA System Software is called KUKA smartHMI
(smart Human-Machine Interface).

Features:

User administration

Program editor

KRL (KUKA Robot Language)
Inline forms for programming
Message display
Configuration window

etc.

(>>> 4.2 "KUKA smartHMI user interface" Page 41)

@ | Depending on customer-specific settings, the user interface may vary
1 from the standard interface.

24 KUKA USB sticks

12 /221

The following KUKA USB sticks exist for the KR C4 robot controller:

= KUKA USB stick 2.0 NB 4 GB
Not bootable
Art. no. 00-197-266
=  KUKA USB stick 2.0 Recovery 4 GB
Bootable
Component of the product KUKA.RecoveryUSB 1.0, art. no. 00-198-642

If a task requires the use of a specific stick, this is indicated in the description
of the task.

Fig. 2-2: KUKA USB stick 2.0 NB 4 GB, not bootable (art. no. 00-197-266)
n
. /

Fig. 2-3: KUKA USB stick 2.0 Recovery 4 GB, bootable (art. no. 00-198-
642)

Issued: 20.07.2012 Version: KSS 8.2 END V2 en (PDF



KUKA
3 Safety

3.1 General

3.11 Liability

The device described in this document is either an industrial robot or a com-
ponent thereof.

Components of the industrial robot:

Manipulator

Robot controller

Teach pendant

Connecting cables

External axes (optional)

e.g. linear unit, turn-tilt table, positioner
m  Software

m  Options, accessories

The industrial robot is built using state-of-the-art technology and in accor-
dance with the recognized safety rules. Nevertheless, misuse of the industrial
robot may constitute a risk to life and limb or cause damage to the industrial
robot and to other material property.

The industrial robot may only be used in perfect technical condition in accor-
dance with its intended use and only by safety-conscious persons who are ful-
ly aware of the risks involved in its operation. Use of the industrial robot is
subject to compliance with this document and with the declaration of incorpo-
ration supplied together with the industrial robot. Any functional disorders af-
fecting the safety of the industrial robot must be rectified immediately.

Safety infor- Safety information cannot be held against KUKA Roboter GmbH. Even if all
mation safety instructions are followed, this is not a guarantee that the industrial robot
will not cause personal injuries or material damage.

No modifications may be carried out to the industrial robot without the autho-
rization of KUKA Roboter GmbH. Additional components (tools, software,
etc.), not supplied by KUKA Roboter GmbH, may be integrated into the indus-
trial robot. The user is liable for any damage these components may cause to
the industrial robot or to other material property.

In addition to the Safety chapter, this document contains further safety instruc-
tions. These must also be observed.

3.1.2 Intended use of the industrial robot

The industrial robot is intended exclusively for the use designated in the “Pur-
pose” chapter of the operating instructions or assembly instructions.

@ | Further information is contained in the “Purpose” chapter of the oper-
l ating instructions or assembly instructions of the industrial robot.

Using the industrial robot for any other or additional purpose is considered im-
permissible misuse. The manufacturer cannot be held liable for any damage
resulting from such use. The risk lies entirely with the user.

Operating the industrial robot and its options within the limits of its intended
use also involves observance of the operating and assembly instructions for
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the individual components, with particular reference to the maintenance spec-
ifications.

Misuse Any use or application deviating from the intended use is deemed to be imper-
missible misuse. This includes e.g.:

Transportation of persons and animals

Use as a climbing aid

Operation outside the permissible operating parameters

Use in potentially explosive environments

Operation without additional safeguards

Outdoor operation

313 EC declaration of conformity and declaration of incorporation

This industrial robot constitutes partly completed machinery as defined by the
EC Machinery Directive. The industrial robot may only be put into operation if
the following preconditions are met:

m  The industrial robot is integrated into a complete system.

Or: The industrial robot, together with other machinery, constitutes a com-
plete system.

Or: All safety functions and safeguards required for operation in the com-
plete machine as defined by the EC Machinery Directive have been added
to the industrial robot.

m  The complete system complies with the EC Machinery Directive. This has
been confirmed by means of an assessment of conformity.

Declaration of The system integrator must issue a declaration of conformity for the complete

conformity system in accordance with the Machinery Directive. The declaration of confor-
mity forms the basis for the CE mark for the system. The industrial robot must
be operated in accordance with the applicable national laws, regulations and
standards.

The robot controller is CE certified under the EMC Directive and the Low Volt-
age Directive.

Declaration of The industrial robot as partly completed machinery is supplied with a declara-

incorporation tion of incorporation in accordance with Annex Il B of the EC Machinery Direc-
tive 2006/42/EC. The assembly instructions and a list of essential
requirements complied with in accordance with Annex | are integral parts of
this declaration of incorporation.

The declaration of incorporation declares that the start-up of the partly com-
pleted machinery remains impermissible until the partly completed machinery
has been incorporated into machinery, or has been assembled with other parts
to form machinery, and this machinery complies with the terms of the EC Ma-
chinery Directive, and the EC declaration of conformity is present in accor-
dance with Annex Il A.

The declaration of incorporation, together with its annexes, remains with the
system integrator as an integral part of the technical documentation of the
complete machinery.

314 Terms used

STOP 0, STOP 1 and STOP 2 are the stop definitions according to EN 60204-
1:2006.
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Term

Description

Axis range

Range of each axis, in degrees or millimeters, within which it may move.
The axis range must be defined for each axis.

Stopping distance

Stopping distance = reaction distance + braking distance

The stopping distance is part of the danger zone.

Workspace

The manipulator is allowed to move within its workspace. The work-
space is derived from the individual axis ranges.

Operator
(User)

The user of the industrial robot can be the management, employer or
delegated person responsible for use of the industrial robot.

Danger zone

The danger zone consists of the workspace and the stopping distances.

Service life

The service life of a safety-relevant component begins at the time of
delivery of the component to the customer.

The service life is not affected by whether the component is used in a
robot controller or elsewhere or not, as safety-relevant components are
also subject to ageing during storage.

KCP

The KCP (KUKA Control Panel) teach pendant has all the operator con-
trol and display functions required for operating and programming the
industrial robot.

The KCP variant for the KR C4 is called KUKA smartPAD. The general
term “KCP”, however, is generally used in this documentation.

Manipulator

The robot arm and the associated electrical installations

Safety zone

The safety zone is situated outside the danger zone.

Safe operational stop

The safe operational stop is a standstill monitoring function. It does not
stop the robot motion, but monitors whether the robot axes are station-
ary. If these are moved during the safe operational stop, a safety stop
STOP 0 is triggered.

The safe operational stop can also be triggered externally.

When a safe operational stop is triggered, the robot controller sets an
output to the field bus. The output is set even if not all the axes were sta-
tionary at the time of triggering, thereby causing a safety stop STOP 0 to
be triggered.

Safety STOP 0

A stop that is triggered and executed by the safety controller. The safety
controller immediately switches off the drives and the power supply to
the brakes.

Note: This stop is called safety STOP 0 in this document.

Safety STOP 1

A stop that is triggered and monitored by the safety controller. The brak-
ing process is performed by the non-safety-oriented part of the robot
controller and monitored by the safety controller. As soon as the manip-
ulator is at a standstill, the safety controller switches off the drives and
the power supply to the brakes.

When a safety STOP 1 is triggered, the robot controller sets an output to
the field bus.

The safety STOP 1 can also be triggered externally.
Note: This stop is called safety STOP 1 in this document.

KUKA
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Term Description

Safety STOP 2 A stop that is triggered and monitored by the safety controller. The brak-
ing process is performed by the non-safety-oriented part of the robot
controller and monitored by the safety controller. The drives remain acti-
vated and the brakes released. As soon as the manipulator is at a stand-
still, a safe operational stop is triggered.

When a safety STOP 2 is triggered, the robot controller sets an output to
the field bus.

The safety STOP 2 can also be triggered externally.

Note: This stop is called safety STOP 2 in this document.

Stop category 0 The drives are deactivated immediately and the brakes are applied. The
manipulator and any external axes (optional) perform path-oriented
braking.

Note: This stop category is called STOP 0 in this document.

Stop category 1 The manipulator and any external axes (optional) perform path-main-
taining braking. The drives are deactivated after 1 s and the brakes are
applied.

Note: This stop category is called STOP 1 in this document.

Stop category 2 The drives are not deactivated and the brakes are not applied. The
manipulator and any external axes (optional) are braked with a path-
maintaining braking ramp.

Note: This stop category is called STOP 2 in this document.

System integrator System integrators are people who safely integrate the industrial robot
(plant integrator) into a complete system and commission it.

T1 Test mode, Manual Reduced Velocity (<= 250 mm/s)

T2 Test mode, Manual High Velocity (> 250 mm/s permissible)

External axis Motion axis which is not part of the manipulator but which is controlled

using the robot controller, e.g. KUKA linear unit, turn-tilt table, Posiflex.

3.2 Personnel

The following persons or groups of persons are defined for the industrial robot:

m  User
= Personnel

derstood the industrial robot documentation, including the safety

: All persons working with the industrial robot must have read and un-
chapter.

User The user must observe the labor laws and regulations. This includes e.g.:

m  The user must comply with his monitoring obligations.
®m The user must carry out instructions at defined intervals.

Personnel Personnel must be instructed, before any work is commenced, in the type of
work involved and what exactly it entails as well as any hazards which may ex-
ist. Instruction must be carried out regularly. Instruction is also required after
particular incidents or technical modifications.

Personnel includes:
m System integrator
m  Operators, subdivided into:

Start-up, maintenance and service personnel
Operating personnel
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Cleaning personnel

Installation, exchange, adjustment, operation, maintenance and re-
A pair must be performed only as specified in the operating or assembly

instructions for the relevant component of the industrial robot and only
by personnel specially trained for this purpose.

System integrator  The industrial robot is safely integrated into a complete system by the system
integrator.

The system integrator is responsible for the following tasks:

Installing the industrial robot

Connecting the industrial robot

Performing risk assessment

Implementing the required safety functions and safeguards
Issuing the declaration of conformity

Attaching the CE mark

Creating the operating instructions for the complete system

Operator The operator must meet the following preconditions:

m  The operator must be trained for the work to be carried out.

= Work on the industrial robot must only be carried out by qualified person-
nel. These are people who, due to their specialist training, knowledge and
experience, and their familiarization with the relevant standards, are able
to assess the work to be carried out and detect any potential hazards.

Example The tasks can be distributed as shown in the following table.

System inte-

Tasks Operator Programmer
grator

Switch robot controller
on/off

Start program
Select program
Select operating mode

Calibration
(tool, base)

Master the manipulator
Configuration
Programming

Start-up

Maintenance

Repair
Decommissioning
Transportation

X X X

x
x

X | X | X | X[ X]| X|X]|X

Work on the electrical and mechanical equipment of the industrial ro-
A bot may only be carried out by specially trained personnel.

3.3 Workspace, safety zone and danger zone

Workspaces are to be restricted to the necessary minimum size. A workspace
must be safeguarded using appropriate safeguards.
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The safeguards (e.g. safety gate) must be situated inside the safety zone. In
the case of a stop, the manipulator and external axes (optional) are braked
and come to a stop within the danger zone.

The danger zone consists of the workspace and the stopping distances of the
manipulator and external axes (optional). It must be safeguarded by means of
physical safeguards to prevent danger to persons or the risk of material dam-
age.

Fig. 3-1: Example of axis range A1

1 Workspace 3  Stopping distance
2 Manipulator 4  Safety zone
3.4 Triggers for stop reactions

Stop reactions of the industrial robot are triggered in response to operator ac-
tions or as a reaction to monitoring functions and error messages. The follow-
ing tables show the different stop reactions according to the operating mode
that has been set.

Trigger T1, T2 AUT, AUT EXT
Start key released STOP 2 -

STOP key pressed STOP 2

Drives OFF STOP 1

“Motion enable” input STOP 2

drops out

Robot controller switched STOP O

off (power failure)

Internal error in non- STOP 0 or STOP 1

safety-oriented part of the

robot controller (dependent on the cause of the error)

Operating mode changed Safety stop 2
during operation
Safety gate opened (oper- - Safety stop 1

ator safety)

18 / 221 Issued: 20.07.2012 Version: KSS 8.2 END V2 en (PDF



KUKA

Trigger T1, T2 AUT, AUT EXT
Enabling switch released Safety stop 2 -
Enabling switch pressed Safety stop 1 -

fully down or error

E-STOP pressed Safety stop 1

Error in safety controller Safety stop 0

or periphery of the safety

controller

3.5 Safety functions

3.5.1 Overview of the safety functions

The following safety functions are present in the industrial robot:

Mode selection

Operator safety (= connection for the guard interlock)

EMERGENCY STOP device

Enabling device

External safe operational stop

External safety stop 1 (not for the controller variant “KR C4 compact”)
External safety stop 2

Velocity monitoring in T1

The safety functions of the industrial robot meet the following requirements:

m Category 3 and Performance Level d in accordance with EN ISO 13849-
1:2008

m  SIL 2 according to EN 62061

The requirements are only met on the following condition, however:
=  The EMERGENCY STOP device is pressed at least once every 6 months.
The following components are involved in the safety functions:

Safety controller in the control PC
KUKA Control Panel (KUKA smartPAD)
Cabinet Control Unit (CCU)

Resolver Digital Converter (RDC)
KUKA Power Pack (KPP)

KUKA Servo Pack (KSP)

Safety Interface Board (SIB) (if used)

There are also interfaces to components outside the industrial robot and to
other robot controllers.

A DANGER In the absence of operational safety functions and safe-

guards, the industrial robot can cause personal injury or
material damage. If safety functions or safeguards are dismantled or deacti-
vated, the industrial robot may not be operated.

During system planning, the safety functions of the overall system
must also be planned and designed. The industrial robot must be in-
tegrated into this safety system of the overall system.
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3.5.2 Safety controller
The safety controller is a unit inside the control PC. It links safety-relevant sig-
nals and safety-relevant monitoring functions.
Safety controller tasks:
m  Switching off the drives; applying the brakes
m  Monitoring the braking ramp
m  Standstill monitoring (after the stop)
= Velocity monitoring in T1
m Evaluation of safety-relevant signals
m  Setting of safety-oriented outputs
3.5.3 Mode selection
The industrial robot can be operated in the following modes:
= Manual Reduced Velocity (T1)
= Manual High Velocity (T2)
= Automatic (AUT)
= Automatic External (AUT EXT)
@ | Do not change the operating mode while a program is running. If the
l operating mode is changed during program execution, the industrial
robot is stopped with a safety stop 2.
ORES Use Velocities
ing mode
= Program verification:
. Programmed velocity, maxi-
For tesF operation, pro- mum 250 mm/s
T gramming and teach-
ing = Jog mode:
Jog velocity, maximum 250 mm/
s
= Program verification:
T2 For test operation Programmed velocity
= Jog mode: Not possible
For industrial robots = Program mode:
AUT without higher-level Programmed velocity
controllers = Jog mode: Not possible
For industrial robots = Program mode:
AUT EXT | with higher-level con- Programmed velocity
trollers, e.g. PLC = Jog mode: Not possible
3.54 Operator safety

The operator safety signal is used for interlocking physical safeguards, e.g.
safety gates. Automatic operation is not possible without this signal. In the
event of a loss of signal during automatic operation (e.g. safety gate is
opened), the manipulator stops with a safety stop 1.

Operator safety is not active in the test modes T1 (Manual Reduced Velocity)
and T2 (Manual High Velocity).
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Following a loss of signal, automatic operation must not
| /\ WARNING | be resumed merely by closing the safeguard; it must first
additionally be acknowledged. It is the responsibility of the system integrator
to ensure this. This is to prevent automatic operation from being resumed in-
advertently while there are still persons in the danger zone, e.g. due to the
safety gate closing accidentally.

m  The acknowledgement must be designed in such a way that an actual
check of the danger zone can be carried out first. Acknowledgement
functions that do not allow this (e.g. because they are automatically trig-
gered by closure of the safeguard) are not permissible.

m Failure to observe this may result in death to persons, severe injuries or
considerable damage to property.

3.5.5 EMERGENCY STOP device

The EMERGENCY STOP device for the industrial robot is the EMERGENCY
STOP device on the KCP. The device must be pressed in the event of a haz-
ardous situation or emergency.

Reactions of the industrial robot if the EMERGENCY STOP device is pressed:

= The manipulator and any external axes (optional) are stopped with a safe-
ty stop 1.

Before operation can be resumed, the EMERGENCY STOP device must be
turned to release it.

Tools and other equipment connected to the manipulator
|A WARNING | must be integrated into the EMERGENCY STOP circuit
on the system side if they could constitute a potential hazard.

Failure to observe this precaution may result in death, severe injuries or con-
siderable damage to property.

There must always be at least one external EMERGENCY STOP device in-
stalled. This ensures that an EMERGENCY STOP device is available even
when the KCP is disconnected.

(>>> 3.5.7 "External EMERGENCY STOP device" Page 22)

3.5.6 Logging off the higher-level safety controller

If the robot controller is connected to a higher-level safety controller, switching
off the robot controller inevitably terminates this connection.

= If the X11 interface is used, this triggers an EMERGENCY STOP for the
overall system.

m If the PROFIsafe interface is used, the KUKA safety controller generates
a signal that prevents the higher-level controller from triggering an EMER-
GENCY STOP for the overall system.

If the PROFIsafe interface is used: In his risk assess-
| /\ WARNING | ment, the system integrator must take into consideration
whether the fact that switching off the robot controller does not trigger an
EMERGENCY STOP of the overall system could constitute a hazard and, if
so, how this hazard can be countered.
Failure to take this into consideration may result in death to persons, severe
injuries or considerable damage to property.
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If a robot controller is switched off, the E-STOP device on
| /\ WARNING | the KCP is no longer functional. The user is responsible
for ensuring that the KCP is either covered or removed from the system. This
serves to prevent operational and non-operational EMERGENCY STOP de-
vices from becoming interchanged.

Failure to observe this precaution may result in death to persons, severe in-
juries or considerable damage to property.

3.5.7 External EMERGENCY STOP device

There must be EMERGENCY STOP devices available at every operator sta-
tion that can initiate a robot motion or other potentially hazardous situation.
The system integrator is responsible for ensuring this.

There must always be at least one external EMERGENCY STOP device in-
stalled. This ensures that an EMERGENCY STOP device is available even
when the KCP is disconnected.

External EMERGENCY STOP devices are connected via the customer inter-
face. External EMERGENCY STOP devices are not included in the scope of
supply of the industrial robot.

3.5.8 Enabling device

The enabling devices of the industrial robot are the enabling switches on the
KCP.

There are 3 enabling switches installed on the KCP. The enabling switches
have 3 positions:

= Not pressed

m  Center position

®m  Panic position

In the test modes, the manipulator can only be moved if one of the enabling
switches is held in the central position.

m Releasing the enabling switch triggers a safety stop 2.

m  Pressing the enabling switch down fully (panic position) triggers a safety
stop 1.

m ltis possible, for a short time, to hold 2 enabling switches in the center po-
sition simultaneously. This makes it possible to adjust grip from one en-
abling switch to another one. If 2 enabling switches are held
simultaneously in the center position for a longer period of time, this trig-
gers a safety stop after several seconds.

If an enabling switch malfunctions (jams), the industrial robot can be stopped
using the following methods:

m Press the enabling switch down fully
m  Actuate the EMERGENCY STOP system
m Release the Start key

The enabling switches must not be held down by adhe-
| /\ WARNING | sive tape or other means or manipulated in any other

way.
Death, serious injuries or major damage to property may result.
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3.5.9 External enabling device

External enabling devices are required if it is necessary for more than one per-
son to be in the danger zone of the industrial robot. They are connected to the
robot controller via an interface or via PROFIsafe.

@ | Which interface can be used for connecting external enabling devices
l is described in the “Planning” chapter of the robot controller operating
instructions.

External enabling devices are not included in the scope of supply of the indus-
trial robot.

3.5.10 External safe operational stop

The safe operational stop can be triggered via an input on the customer inter-
face. The state is maintained as long as the external signal is FALSE. If the
external signal is TRUE, the manipulator can be moved again. No acknowl-
edgement is required.

3.5.11 External safety stop 1 and external safety stop 2

Safety stop 1 and safety stop 2 can be triggered via an input on the customer
interface. The state is maintained as long as the external signal is FALSE. If
the external signal is TRUE, the manipulator can be moved again. No ac-
knowledgement is required.

o | Noexternal safety stop 1 is available for the controller variant “KR C4
1 compact”.

3.5.12 Velocity monitoring in T1

The velocity at the TCP is monitored in T1 mode. If, due to an error, the veloc-
ity exceeds 250 mm/s, a safety stop 0 is triggered.

3.6 Additional protective equipment

3.6.1 Jog mode

In the operating modes T1 (Manual Reduced Velocity) and T2 (Manual High
Velocity), the robot controller can only execute programs in jog mode. This
means that it is necessary to hold down an enabling switch and the Start key
in order to execute a program.

m Releasing the enabling switch triggers a safety stop 2.

m  Pressing the enabling switch down fully (panic position) triggers a safety
stop 1.

m Releasing the Start key triggers a STOP 2.

3.6.2 Software limit switches

The axis ranges of all manipulator and positioner axes are limited by means of
adjustable software limit switches. These software limit switches only serve as
machine protection and must be adjusted in such a way that the manipulator/
positioner cannot hit the mechanical end stops.
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The software limit switches are set during commissioning of an industrial ro-
bot.

@ | Furtherinformation is contained in the operating and programming in-
1 structions.

3.6.3 Mechanical end stops

Depending on the robot variant, the axis ranges of the main and wrist axes of
the manipulator are partially limited by mechanical end stops.

Additional mechanical end stops can be installed on the external axes.

NOTICE If the manipulator or an external axis hits an obstruction

or a mechanical end stop or axis range limitation, this
can result in material damage to the industrial robot. The manipulator must
be taken out of operation and KUKA Roboter GmbH must be consulted be-
fore it is put back into operation (>>> 10 "KUKA Service" Page 209).

3.64 Mechanical axis range limitation (optional)

Some manipulators can be fitted with mechanical axis range limitation in axes
A1 to A3. The adjustable axis range limitation systems restrict the working
range to the required minimum. This increases personal safety and protection
of the system.

In the case of manipulators that are not designed to be fitted with mechanical
axis range limitation, the workspace must be laid out in such a way that there
is no danger to persons or material property, even in the absence of mechan-
ical axis range limitation.

If this is not possible, the workspace must be limited by means of photoelectric
barriers, photoelectric curtains or obstacles on the system side. There must be
no shearing or crushing hazards at the loading and transfer areas.

@ | This option is not available for all robot models. Information on spe-
1 cific robot models can be obtained from KUKA Roboter GmbH.

3.6.5 Axis range monitoring (optional)

Some manipulators can be fitted with dual-channel axis range monitoring sys-
tems in main axes A1 to A3. The positioner axes may be fitted with additional
axis range monitoring systems. The safety zone for an axis can be adjusted
and monitored using an axis range monitoring system. This increases person-
al safety and protection of the system.

@ | This option is not available for all robot models. Information on spe-
1 cific robot models can be obtained from KUKA Roboter GmbH.

3.6.6 Devices for moving the manipulator without the robot controller (options)

Description The following devices are available for moving the manipulator after an acci-
dent or malfunction:
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m Release device

The release device can be used for the main axis drive motors and, de-
pending on the robot variant, also for the wrist axis drive motors.

=  Brake release device
The brake release device is designed for robot variants whose motors are
not freely accessible.

The devices are only for use in exceptional circumstances and emergencies,
e.g. for freeing people.

@ | These options are not available for all robot models. Information on
1 specific robot models can be obtained from KUKA Roboter GmbH.

The motors reach temperatures during operation which
IA CAUTION I can cause burns to the skin. Contact must be avoided.
Appropriate safety precautions must be taken, e.g. protective gloves must be
worn.

Procedure Moving the manipulator with the release device:
1. Switch off the robot controller and secure it (e.g. with a padlock) to prevent
unauthorized persons from switching it on again.
2. Remove the protective cap from the motor.

3. Push the release device onto the corresponding motor and move the axis
in the desired direction.

The directions are indicated with arrows on the motors. It is necessary to
overcome the resistance of the mechanical motor brake and any other
loads acting on the axis.

Moving an axis with the release device can damage the
| /A WARNING | motor brake. This can result in personal injury and mate-
rial damage. After using the release device, the motor must be exchanged.

If a robot axis has been moved by the release device, all
| /\ WARNING | robot axes must be remastered. Serious infuries or dam-
age to property may otherwise result.

Procedure Moving the manipulator with the brake release device:

Use of the brake release device may result in unexpect-
| /A WARNING | ed robot motions, especially sagging of the axes. During
use of the brake release device, attention must be paid to motion of this kind
in order to be able to prevent physical injuries or damage to property. Stand-
ing under moving axes is not permitted.

1. Switch off the robot controller and secure it (e.g. with a padlock) to prevent
unauthorized persons from switching it on again.

2. Connect the brake release device to the base frame of the robot:

Unplug connector X30 from interface A1. Plug connector X20 of the brake
release device into interface A1.

3. Select the brakes to be released (main axes, wrist axes) via the selection
switch on the brake release device.

4. Press the button on the hand-held device.

The brakes of the main axes or wrist axes are released and the robot can
be moved manually.
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e | Further information about the brake release device can be found in
1 the documentation for the brake release device.

3.6.7 Labeling on the industrial robot

All plates, labels, symbols and marks constitute safety-relevant parts of the in-
dustrial robot. They must not be modified or removed.

Labeling on the industrial robot consists of:

Identification plates
Warning labels
Safety symbols
Designation labels
Cable markings
Rating plates

e | Furtherinformation is contained in the technical data of the operating
1 instructions or assembly instructions of the components of the indus-
trial robot.

3.6.8 External safeguards

The access of persons to the danger zone of the industrial robot must be pre-
vented by means of safeguards. It is the responsibility of the system integrator
to ensure this.

Physical safeguards must meet the following requirements:

m  They meet the requirements of EN 953.

m  They prevent access of persons to the danger zone and cannot be easily
circumvented.

m They are sufficiently fastened and can withstand all forces that are likely
to occur in the course of operation, whether from inside or outside the en-
closure.

m  They do not, themselves, represent a hazard or potential hazard.

m  The prescribed minimum clearance from the danger zone is maintained.
Safety gates (maintenance gates) must meet the following requirements:

m  They are reduced to an absolute minimum.

= The interlocks (e.g. safety gate switches) are linked to the operator safety
input of the robot controller via safety gate switching devices or safety
PLC.

m  Switching devices, switches and the type of switching conform to the re-
quirements of Performance Level d and category 3 according to EN ISO
13849-1.

m  Depending on the risk situation: the safety gate is additionally safeguarded
by means of a locking mechanism that only allows the gate to be opened
if the manipulator is safely at a standstill.

®m The button for acknowledging the safety gate is located outside the space
limited by the safeguards.

@ | Further information is contained in the corresponding standards and
1 regulations. These also include EN 953.
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Other safety Other safety equipment must be integrated into the system in accordance with
equipment the corresponding standards and regulations.
3.7 Overview of operating modes and safety functions

The following table indicates the operating modes in which the safety functions

are active.
Safety functions T1 T2 AUT AUT EXT
Operator safety - - active active
EMERGENCY STOP device active active active active
Enabling device active active - -
Reduced. \./elo.0|ty during pro- active ) ) )
gram verification
Jog mode active active - -
Software limit switches active active active active

3.8 Safety measures

3.8.1 General safety measures

The industrial robot may only be used in perfect technical condition in accor-
dance with its intended use and only by safety-conscious persons. Operator
errors can result in personal injury and damage to property.

It is important to be prepared for possible movements of the industrial robot
even after the robot controller has been switched off and locked. Incorrect in-
stallation (e.g. overload) or mechanical defects (e.g. brake defect) can cause
the manipulator or external axes to sag. If work is to be carried out on a
switched-off industrial robot, the manipulator and external axes must first be
moved into a position in which they are unable to move on their own, whether
the payload is mounted or not. If this is not possible, the manipulator and ex-
ternal axes must be secured by appropriate means.

In the absence of operational safety functions and safe-
A DANGER guards, the industrial robot can cause personal injury or

material damage. If safety functions or safeguards are dismantled or deacti-
vated, the industrial robot may not be operated.

Standing underneath the robot arm can cause death or
| /\ WARNING | serious injuries. For this reason, standing underneath the
robot arm is prohibited!

The motors reach temperatures during operation which
IA CAUTION I can cause burns to the skin. Contact must be avoided.
Appropriate safety precautions must be taken, e.g. protective gloves must be
worn.

KCP The user must ensure that the industrial robot is only operated with the KCP
by authorized persons.

If more than one KCP is used in the overall system, it must be ensured that
each KCP is unambiguously assigned to the corresponding industrial robot.
They must not be interchanged.
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The operator must ensure that decoupled KCPs are im-
| /\ WARNING | mediately removed from the system and stored out of
sight and reach of personnel working on the industrial robot. This serves to
prevent operational and non-operational EMERGENCY STOP devices from
becoming interchanged.

Failure to observe this precaution may result in death, severe injuries or con-
siderable damage to property.

Faults The following tasks must be carried out in the case of faults in the industrial
robot:

m  Switch off the robot controller and secure it (e.g. with a padlock) to prevent
unauthorized persons from switching it on again.

m Indicate the fault by means of a label with a corresponding warning (tag-
out).

m  Keep a record of the faults.
m Eliminate the fault and carry out a function test.

Modifications After modifications to the industrial robot, checks must be carried out to ensure
the required safety level. The valid national or regional work safety regulations
must be observed for this check. The correct functioning of all safety circuits
must also be tested.

New or modified programs must always be tested first in Manual Reduced Ve-
locity mode (T1).

After modifications to the industrial robot, existing programs must always be
tested first in Manual Reduced Velocity mode (T1). This applies to all compo-
nents of the industrial robot and includes modifications to the software and
configuration settings.

3.8.2 Transportation

Manipulator The prescribed transport position of the manipulator must be observed. Trans-
portation must be carried out in accordance with the operating instructions or
assembly instructions of the robot.

Robot controller The prescribed transport position of the robot controller must be observed.
Transportation must be carried out in accordance with the operating instruc-
tions or assembly instructions of the robot controller.

Avoid vibrations and impacts during transportation in order to prevent damage
to the robot controller.

External axis The prescribed transport position of the external axis (e.g. KUKA linear unit,

(optional) turn-tilt table, etc.) must be observed. Transportation must be carried out in ac-
cordance with the operating instructions or assembly instructions of the exter-
nal axis.

3.8.3 Start-up and recommissioning

Before starting up systems and devices for the first time, a check must be car-
ried out to ensure that the systems and devices are complete and operational,
that they can be operated safely and that any damage is detected.

The valid national or regional work safety regulations must be observed for this
check. The correct functioning of all safety circuits must also be tested.
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3 Safet

The passwords for logging onto the KUKA System Software as “Ex-
pert” and “Administrator” must be changed before start-up and must
only be communicated to authorized personnel.

A DANGER The robot controller is preconfigured for the specific in-

dustrial robot. If cables are interchanged, the manipula-
tor and the external axes (optional) may receive incorrect data and can thus
cause personal injury or material damage. If a system consists of more than
one manipulator, always connect the connecting cables to the manipulators
and their corresponding robot controllers.

If additional components (e.g. cables), which are not part of the scope
A of supply of KUKA Roboter GmbH, are integrated into the industrial

robot, the user is responsible for ensuring that these components do
not adversely affect or disable safety functions.

NOTICE If the internal cabinet temperature of the robot controller

differs greatly from the ambient temperature, condensa-
tion can form, which may cause damage to the electrical components. Do not
put the robot controller into operation until the internal temperature of the
cabinet has adjusted to the ambient temperature.

The following tests must be carried out before start-up and recommissioning:

General test:

It must be ensured that:

®m The industrial robot is correctly installed and fastened in accordance with
the specifications in the documentation.

m  There are no foreign bodies or loose parts on the industrial robot.

m  All required safety equipment is correctly installed and operational.

= The power supply ratings of the industrial robot correspond to the local
supply voltage and mains type.

m  The ground conductor and the equipotential bonding cable are sufficiently
rated and correctly connected.

m  The connecting cables are correctly connected and the connectors are
locked.
Test of the safety functions:

A function test must be carried out for the following safety functions to ensure
that they are functioning correctly:

Local EMERGENCY STOP device

External EMERGENCY STOP device (input and output)

Enabling device (in the test modes)

Operator safety

All other safety-relevant inputs and outputs used

Other external safety functions

Test of reduced velocity control:
This test is to be carried out as follows:

1. Program a straight path with the maximum possible velocity.
2. Calculate the length of the path.

3. Execute the path in T1 mode with the override set to 100% and time the
motion with a stopwatch.

KUKA
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It must be ensured that no persons are present within the
| /\ WARNING | danger zone during path execution. Death or severe in-

juries may result.

4. Calculate the velocity from the length of the path and the time measured
for execution of the motion.

Control of reduced velocity is functioning correctly if the following results are
achieved:

m The calculated velocity does not exceed 250 mm/s.

m  The manipulator executes the path as programmed (i.e. in a straight line,
without deviations).

Machine data It must be ensured that the rating plate on the robot controller has the same
machine data as those entered in the declaration of incorporation. The ma-
chine data on the rating plate of the manipulator and the external axes (option-
al) must be entered during start-up.

A DANGER The industrial robot must not be moved if incorrect ma-

chine data are loaded. Death, severe injuries or consid-
erable damage to property may otherwise result. The correct machine data
must be loaded.

Following modifications to the machine data, the safety configuration must be
checked.

@ | Further information is contained in the Operating and Programming
1 Instructions for System Integrators.

Following modifications to the machine data, control of the reduced velocity
must be checked.

3.8.3.1 Start-up mode

Description The industrial robot can be set to Start-up mode via the smartHMI user inter-
face. In this mode, the manipulator can be moved in T1 or CRR mode in the
absence of the safety periphery. (CRR is an operating mode specifically for
use with SafeOperation.)
= [If the X11 interface is used:

Start-up mode is always possible if all input signals have the state “logic
zero”. If this is not the case, the robot controller prevents or terminates
Start-up mode.

m If the PROFlsafe interface is used:

If a connection to a higher-level safety system exists or is established, the
robot controller prevents or terminates Start-up mode.

Hazards Possible hazards and risks involved in using Start-up mode:

m A person walks into the manipulator’'s danger zone.

= An unauthorized person moves the manipulator.

® In ahazardous situation, a disabled external EMERGENCY STOP device
is actuated and the manipulator is not shut down.

Additional measures for avoiding risks in Start-up mode:

m Cover disabled EMERGENCY STOP devices or attach a warning sign in-
dicating that the EMERGENCY STOP device is out of operation.
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m If there is no safety fence, other measures must be taken to prevent per-
sons from entering the manipulator’s danger zone, e.g. use of warning
tape.

m  Use of Start-up mode must be minimized — and avoided where possible —
by means of organizational measures.

Use Intended use of Start-up mode:

= Only service personnel who have received safety instruction may use
Start-up mode.

m Start-up in T1 mode or CRR mode when the external safeguards have not
yet been installed or put into operation. The danger zone must be delimit-
ed at least by means of warning tape.

m  Fault localization (periphery fault).

A DANGER Use of Start-up mode disables all external safeguards.

The service personnel are responsible for ensuring that
there is no-one in or near the danger zone of the manipulator as long as the
safeguards are disabled.

Failure to observe this may result in death to persons, injuries or damage to
property.

Misuse Any use or application deviating from the designated use is deemed to be im-
permissible misuse. This includes, for example, use by any other personnel.

KUKA Roboter GmbH accepts no liability for damage or injury caused thereby.
The risk lies entirely with the user.

3.84 Manual mode

Manual mode is the mode for setup work. Setup work is all the tasks that have
to be carried out on the industrial robot to enable automatic operation. Setup
work includes:

= Jog mode

m Teach

®m  Programming

m  Program verification

The following must be taken into consideration in manual mode:

= [fthe drives are not required, they must be switched off to prevent the ma-
nipulator or the external axes (optional) from being moved unintentionally.
New or modified programs must always be tested first in Manual Reduced
Velocity mode (T1).

m  The manipulator, tooling or external axes (optional) must never touch or
project beyond the safety fence.

m  Workpieces, tooling and other objects must not become jammed as a re-
sult of the industrial robot motion, nor must they lead to short-circuits or be
liable to fall off.

m  All setup work must be carried out, where possible, from outside the safe-
guarded area.

If the setup work has to be carried out inside the safeguarded area, the follow-
ing must be taken into consideration:
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In Manual Reduced Velocity mode (T1):
m Ifit can be avoided, there must be no other persons inside the safeguard-
ed area.

If it is necessary for there to be several persons inside the safeguarded ar-
ea, the following must be observed:

Each person must have an enabling device.
All persons must have an unimpeded view of the industrial robot.
Eye-contact between all persons must be possible at all times.
m  The operator must be so positioned that he can see into the danger area
and get out of harm’s way.
In Manual High Velocity mode (T2):
= This mode may only be used if the application requires a test at a velocity
higher than Manual Reduced Velocity.
m Teaching and programming are not permissible in this operating mode.
m Before commencing the test, the operator must ensure that the enabling
devices are operational.
m The operator must be positioned outside the danger zone.

®m  There must be no other persons inside the safeguarded area. It is the re-
sponsibility of the operator to ensure this.

3.8.5 Simulation

Simulation programs do not correspond exactly to reality. Robot programs cre-
ated in simulation programs must be tested in the system in Manual Reduced
Velocity mode (T1). It may be necessary to modify the program.

3.8.6 Automatic mode

Automatic mode is only permissible in compliance with the following safety
measures:

= All safety equipment and safeguards are present and operational.
m  There are no persons in the system.
m The defined working procedures are adhered to.

If the manipulator or an external axis (optional) comes to a standstill for no ap-
parent reason, the danger zone must not be entered until an EMERGENCY
STOP has been triggered.

3.8.7 Maintenance and repair

After maintenance and repair work, checks must be carried out to ensure the
required safety level. The valid national or regional work safety regulations
must be observed for this check. The correct functioning of all safety circuits
must also be tested.

The purpose of maintenance and repair work is to ensure that the system is
kept operational or, in the event of a fault, to return the system to an operation-
al state. Repair work includes troubleshooting in addition to the actual repair
itself.

The following safety measures must be carried out when working on the indus-
trial robot:

= Carry out work outside the danger zone. If work inside the danger zone is
necessary, the user must define additional safety measures to ensure the
safe protection of personnel.
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= Switch off the industrial robot and secure it (e.g. with a padlock) to prevent
it from being switched on again. If it is necessary to carry out work with the
robot controller switched on, the user must define additional safety mea-
sures to ensure the safe protection of personnel.

m [fitis necessary to carry out work with the robot controller switched on, this
may only be done in operating mode T1.

= Label the system with a sign indicating that work is in progress. This sign
must remain in place, even during temporary interruptions to the work.

=  The EMERGENCY STOP systems must remain active. If safety functions
or safeguards are deactivated during maintenance or repair work, they
must be reactivated immediately after the work is completed.

Before work is commenced on live parts of the robot sys-
| /\ WARNING | tem, the main switch must be turned off and secured
against being switched on again. The system must then be checked to en-
sure that it is deenergized.

It is not sufficient, before commencing work on live parts, to execute an
EMERGENCY STOP or a safety stop, or to switch off the drives, as this does
not disconnect the robot system from the mains power supply in the case of
the drives of the new generation. Parts remain energized. Death or severe
injuries may result.

Faulty components must be replaced using new components with the same
article numbers or equivalent components approved by KUKA Roboter GmbH
for this purpose.

Cleaning and preventive maintenance work is to be carried out in accordance
with the operating instructions.

Robot controller Even when the robot controller is switched off, parts connected to peripheral
devices may still carry voltage. The external power sources must therefore be
switched off if work is to be carried out on the robot controller.

The ESD regulations must be adhered to when working on components in the
robot controller.

Voltages in excess of 50 V (up to 780 V) can be present in various components
for several minutes after the robot controller has been switched off! To prevent
life-threatening injuries, no work may be carried out on the industrial robot in
this time.

Water and dust must be prevented from entering the robot controller.

Counterbal- Some robot variants are equipped with a hydropneumatic, spring or gas cylin-
ancing system der counterbalancing system.

The hydropneumatic and gas cylinder counterbalancing systems are pressure
equipment and, as such, are subject to obligatory equipment monitoring. De-
pending on the robot variant, the counterbalancing systems correspond to cat-
egory 0, Il or Ill, fluid group 2, of the Pressure Equipment Directive.

The user must comply with the applicable national laws, regulations and stan-
dards pertaining to pressure equipment.

Inspection intervals in Germany in accordance with Industrial Safety Order,
Sections 14 and 15. Inspection by the user before commissioning at the instal-
lation site.

The following safety measures must be carried out when working on the coun-
terbalancing system:

m  The manipulator assemblies supported by the counterbalancing systems
must be secured.

= Work on the counterbalancing systems must only be carried out by quali-
fied personnel.
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Hazardous The following safety measures must be carried out when handling hazardous
substances substances:

m Avoid prolonged and repeated intensive contact with the skin.

m  Avoid breathing in oil spray or vapors.

m  Clean skin and apply skin cream.

To ensure safe use of our products, we recommend that our custom-
A ers regularly request up-to-date safety data sheets from the manufac-
turers of hazardous substances.

3.8.8 Decommissioning, storage and disposal

The industrial robot must be decommissioned, stored and disposed of in ac-
cordance with the applicable national laws, regulations and standards.

3.8.9 Safety measures for “single point of control”

Overview If certain components in the industrial robot are operated, safety measures
must be taken to ensure complete implementation of the principle of “single
point of control” (SPOC).

Components:

Submit interpreter

PLC

OPC Server

Remote control tools

Tools for configuration of bus systems with online functionality
KUKA.RobotSensorinterface

This must be clarified for each specific application; this is the respon-

: The implementation of additional safety measures may be required.
sibility of the system integrator, programmer or user of the system.

Since only the system integrator knows the safe states of actuators in the pe-
riphery of the robot controller, it is his task to set these actuators to a safe
state, e.g. in the event of an EMERGENCY STOP.

T, T2 In the test modes, the components referred to above may only access the in-
dustrial robot if the following signals have the following states:

Signal State required for SPOC
$USER_SAF TRUE
$SPOC_MOTION_ENABLE TRUE
Submit inter- If motions, (e.g. drives or grippers) are controlled with the submit interpreter or
preter, PLC the PLC via the I/O system, and if they are not safeguarded by other means,

then this control will take effect even in T1 and T2 modes or while an EMER-
GENCY STOP is active.

If variables that affect the robot motion (e.g. override) are modified with the
submit interpreter or the PLC, this takes effect even in T1 and T2 modes or
while an EMERGENCY STOP is active.

Safety measures:

= In the test modes, the system variable $OV_PRO must not be written to
by the submit interpreter or the PLC.
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OPC server,
remote control
tools

Tools for configu-
ration of bus

m Do not modify safety-relevant signals and variables (e.g. operating mode,
EMERGENCY STOP, safety gate contact) via the submit interpreter or
PLC.

If modifications are nonetheless required, all safety-relevant signals and
variables must be linked in such a way that they cannot be set to a dan-
gerous state by the submit interpreter or PLC.

These components can be used with write access to modify programs, outputs
or other parameters of the robot controller, without this being noticed by any
persons located inside the system.

Safety measures:

m  KUKA stipulates that these components are to be used exclusively for di-
agnosis and visualization.

Programs, outputs or other parameters of the robot controller must not be
modified using these components.

m If these components are used, outputs that could cause a hazard must be
determined in a risk assessment. These outputs must be designed in such
a way that they cannot be set without being enabled. This can be done us-
ing an external enabling device, for example.

If these components have an online functionality, they can be used with write
access to modify programs, outputs or other parameters of the robot control-
ler, without this being noticed by any persons located inside the system.

systems
m  WorkVisual from KUKA
=  Tools from other manufacturers
Safety measures:
m Inthe test modes, programs, outputs or other parameters of the robot con-
troller must not be modified using these components.
3.9 Applied norms and regulations
Name Definition Edition
2006/42/EC Machinery Directive: 2006
Directive 2006/42/EC of the European Parliament and of
the Council of 17 May 2006 on machinery, and amending
Directive 95/16/EC (recast)
2004/108/EC EMC Directive: 2004
Directive 2004/108/EC of the European Parliament and of
the Council of 15 December 2004 on the approximation of
the laws of the Member States relating to electromagnetic
compatibility and repealing Directive 89/336/EEC
97/23/EC Pressure Equipment Directive: 1997
Directive 97/23/EC of the European Parliament and of the
Council of 29 May 1997 on the approximation of the laws
of the Member States concerning pressure equipment
(Only applicable for robots with hydropneumatic counter-
balancing system.)
EN ISO 13850 Safety of machinery: 2008
Emergency stop - Principles for design
EN ISO 13849-1 Safety of machinery: 2008
Safety-related parts of control systems - Part 1: General
principles of design

KUKA
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Name Definition Edition

EN ISO 13849-2 Safety of machinery: 2008
Safety-related parts of control systems - Part 2: Validation

EN ISO 12100 Safety of machinery: 2010
General principles of design, risk assessment and risk
reduction

EN ISO 10218-1 Industrial robots: 2011
Safety

EN 614-1 Safety of machinery: 2006
Ergonomic design principles - Part 1: Terms and general
principles

EN 61000-6-2 Electromagnetic compatibility (EMC): 2005
Part 6-2: Generic standards; Immunity for industrial envi-
ronments

EN 61000-6-4 Electromagnetic compatibility (EMC): 2007

Part 6-4: Generic standards; Emission standard for indus-
trial environments

EN 60204-1 Safety of machinery: 2006

Electrical equipment of machines - Part 1: General
requirements
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4 Operation

4.1 KUKA smartPAD teach pendant

411 Front view

Function The smartPAD is the teach pendant for the industrial robot. The smartPAD has
all the operator control and display functions required for operating and pro-
gramming the industrial robot.

The smartPAD has a touch screen: the smartHMI can be operated with a fin-
ger or stylus. An external mouse or external keyboard is not necessary.

@ | The general term “KCP” (KUKA Control Panel) is often used in this
1 documentation for the smartPAD.

Overview

Fig. 4-1: KUKA smartPAD, front view
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ltem | Description

1 Button for disconnecting the smartPAD
(>>> 4.1.3 "Disconnecting and connecting the smartPAD"
Page 40)
2 Keyswitch for calling the connection manager. The switch can only

be turned if the key is inserted.

The operating mode can be changed by using the connection man-
ager.
(>>> 4.10 "Changing operating mode" Page 52)

3 EMERGENCY STOP button. Stops the robot in hazardous situa-
tions. The EMERGENCY STOP button locks itself in place when it
is pressed.

4 Space Mouse: For moving the robot manually.

(>>> 4.12 "Jogging the robot" Page 54)
5 Jog keys: For moving the robot manually.

(>>>4.12 "Jogging the robot" Page 54)

6 Key for setting the program override
7 Key for setting the jog override
8 Main menu key: Shows the menu items on the smartHMI

(>>> 4.4 "Calling the main menu" Page 44)

9 Status keys. The status keys are used primarily for setting param-
eters in technology packages. Their exact function depends on the
technology packages installed.

10 Start key: The Start key is used to start a program.

11 Start backwards key: The Start backwards key is used to start a
program backwards. The program is executed step by step.

12 STOP key: The STOP key is used to stop a program that is run-
ning.

13 Keyboard key

Displays the keyboard. It is generally not necessary to press this
key to display the keyboard, as the smartHMI detects when key-
board input is required and displays the keyboard automatically.

(>>> 4.2.3 "Keypad" Page 44)
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4 Operation

Overview
v
i
Fig. 4-2: KUKA smartPAD, rear view
1 Enabling switch 4 USB connection
2 Start key (green) 5 Enabling switch
3 Enabling switch 6 Identification plate
Description Element Description
|dentification Identification plate
plate

Start key The Start key is used to start a program.

The enabling switch has 3 positions:

= Not pressed
m  Center position
m Panic position

Only for FAT32-formatted USB sticks.

Enabling

switch The enabling switch must be held in the center position
in operating modes T1 and T2 in order to be able to jog
the manipulator.
In the operating modes Automatic and Automatic Exter-
nal, the enabling switch has no function.
The USB connection is used, for example, for archiving

:-_’SB connec- and restoring data.

ion

KUKA
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41.3 Disconnecting and connecting the smartPAD

Description The smartPAD can be disconnected while the robot controller is running.

If the smartPAD is disconnected, the system can no lon-
| /\ WARNING | ger be switched off by means of the EMERGENCY
STOP device on the smartPAD. For this reason, an external EMERGENCY
STOP must be connected to the robot controller.

The user is responsible for ensuring that the smartPAD is immediately re-
moved from the system when it has been disconnected. The smartPAD must
be stored out of sight and reach of personnel working on the industrial robot.
This prevents operational and non-operational EMERGENCY STOP devices
from becoming interchanged.

Failure to observe these precautions may result in death to persons, severe
injuries or considerable damage to property.

Procedure Disconnection:

1. Press the disconnect button on the smartPAD.
A message and a counter are displayed on the smartHMI. The counter
runs for 30 s. During this time, the smartPAD can be disconnected from
the robot controller.

e | [fthe smartPAD is disconnected without the counter running, this trig-
l gers an EMERGENCY STOP. The EMERGENCY STOP can only be
canceled by plugging the smartPAD back in.

2. Disconnect the smartPAD from the robot controller.

If the counter expires without the smartPAD having been disconnected,
this has no effect. The disconnect button can be pressed again at any time
to display the counter again.

Connection:
m  Connect the smartPAD to the robot controller.

A smartPAD can be connected at any time. Precondition: Same smartPAD
variant as the disconnected device. The EMERGENCY STOP and enabling
switches are operational again 30 s after connection. The smartHMI is auto-
matically displayed again. (This may take longer than 30 s.)

The connected smartPAD assumes the current operating mode of the robot
controller.

@ | The current operating mode is not, in all cases, the same as that be-
l fore the smartPAD was disconnected: if the robot controller is part of
a RoboTeam, the operating mode may have been changed after dis-
connection, e.g. by the master.

The user connecting a smartPAD to the robot controller
| /\ WARNING | must subsequently stay with the smartPAD for at least
30 s, i.e. until the EMERGENCY STOP and enabling switches are operation-
al once again. This prevents another user from trying to activate a non-oper-
ational EMERGENCY STOP in an emergency situation, for example.
Failure to observe this may result in death to persons, injuries or damage to
property.
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4.2 KUKA smartHMI user interface

PR
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—L_'__f Mada e X
Tl @tm_useracﬁon dat : :
. @ tm_useraction src : i
i L--‘f T i E_@
--------- L) steu A3
KUKA_DISK (C:\)
KUKA_DATA (D:\) | A4

1_Dkiartle) calartand E10 Didor

Fig. 4-3: KUKA smartHMI user interface

Iltem | Description
1 Status bar (>>> 4.2.1 "Status bar" Page 42)
2 Message counter

The message counter indicates how many messages of each mes-
sage type are active. Touching the message counter enlarges the
display.

3 Message window

By default, only the last message is displayed. Touching the mes-
sage window expands it so that all active messages are displayed.

An acknowledgeable message can be acknowledged with OK. All
acknowledgeable messages can be acknowledged at once with
All OK.

4 Space Mouse status indicator

This indicator shows the current coordinate system for jogging with
the Space Mouse. Touching the indicator displays all coordinate
systems, allowing a different one to be selected.
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ltem | Description
5 Space Mouse alignment indicator

Touching this indicator opens a window in which the current align-
ment of the Space Mouse is indicated and can be changed.

(>>> 4.12.8 "Defining the alignment of the Space Mouse"
Page 62)

6 Jog keys status indicator

This indicator shows the current coordinate system for jogging with
the jog keys. Touching the indicator displays all coordinate sys-
tems, allowing a different one to be selected.

7 Jog key labels

If axis-specific jogging is selected, the axis numbers are displayed
here (A1, A2, etc.). If Cartesian jogging is selected, the coordinate
system axes are displayed here (X, Y, Z, A, B, C).

Touching the label causes the selected kinematics group to be dis-
played.

8 Program override

(>>> 6.5.4 "Setting the program override (POV)" Page 139)

9 Jog override

(>>> 4.12.3 "Setting the jog override (HOV)" Page 59)

10 Button bar. The buttons change dynamically and always refer to
the window that is currently active in the smartHMI.

At the right-hand end is the Edit button. This can be used to call
numerous commands relating to the Navigator.

11 Clock

The clock displays the system time. Touching the clock displays
the system time in digital format, together with the current date.
12 WorkVisual icon

If no project can be opened, the icon has a small red X in the bot-
tom left-hand corner. This is the case, for example, if the files be-
longing to the project are missing. In such a case, the system is
only partially available, e.g. the safety configuration cannot be
opened.

4.21 Status bar

The status bar indicates the status of certain central settings of the industrial
robot. In most cases, touching the display opens a window in which the set-
tings can be modified.

T

| | N | |
ISIIOII"II m

Fig. 4-4: KUKA smartHMI status bar
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Item | Description
1 Main menu key. Shows the menu items on the smartHMI.

(>>> 4.4 "Calling the main menu" Page 44)
2 Robot name. The robot name can be changed.

(>>> 4.15.11 "Displaying/editing robot data" Page 74)
3 If a program has been selected, the name is displayed here.
4 Submit interpreter status indicator

(>>> 4.2.2 "Submit interpreter” status indicator" Page 43)

5 Drives status indicator. The drives can be switched on or off here.
(>>> 6.5.5 "Switching drives on/off" Page 139)

6 Robot interpreter status indicator. Programs can be reset or can-
celed here.

(>>> 6.5.6 "Robot interpreter status indicator" Page 140)
(>>> 6.2.1 "Selecting and deselecting a program” Page 134)

(>>> 6.5.11 "Resetting a program” Page 142)
7 Current operating mode

(>>> 4.10 "Changing operating mode" Page 52)

8 POV/HOV status indicator. Indicates the current program override
and the current jog override.

(>>> 6.5.4 "Setting the program override (POV)" Page 139)

(>>> 4.12.3 "Setting the jog override (HOV)" Page 59)

9 Program run mode status indicator. Indicates the current program
run mode.

(>>> 6.5.2 "Program run modes" Page 138)
10 Tool/base status indicator. Indicates the current tool and base.

(>>> 4.12.4 "Selecting the tool and base" Page 59)
11 Incremental jogging status indicator.

(>>>4.12.10 "Incremental jogging" Page 64)

4.2.2 “Submit interpreter” status indicator
Icon Color Description
— Yellow Submit interpreter is selected. The block
g pointer is situated on the first line of the se-
| | lected SUB program.
Green Submit interpreter is running.

Red Submit interpreter has been stopped.

—
s

Gray Submit interpreter is deselected.

|
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4.2.3 Keypad

The smartPAD has a touch screen: the smartHMI can be operated with a fin-
ger or stylus.

There is a keypad on the smartHMI for entering letters and numbers. The sm-
artHMI detects when the entry of letters or numbers is required and automati-
cally displays the keypad.

The keypad only ever displays the characters that are required. If, for example,
a box is edited in which only numbers can be entered, then only numbers are
displayed and not letters.

Calbraiio (W] Y./ 4-poini

Tool no. II

Tool name:

Select the tod

Fig. 4-5: Example keypad

4.3 Switching on the robot controller and starting the KSS

Procedure ®  Turn the main switch on the robot controller to ON.
The operating system and the KSS start automatically.

If the KSS does not start automatically, e.g. because the Startup function has
been disabled, execute the file StartKRC.exe in the directory C:\KRC.

If the robot controller is logged onto the network, the start may take longer.

44 Calling the main menu

Procedure ®m  Press “Main menu” key on the KCP. The Main menu window is opened.

The display is always the same as that which was in the window before it
was last closed.

Description Properties of the Main Menu window:

®m  The main menu is displayed in the left-hand column.

= Touching a menu item that contains an arrow opens the corresponding
submenu (e.g. Configure).

Depending on how many nested submenus are open, the Main Menu col-
umn may no longer be visible, with only the submenus remaining visible.

=  The arrow key in the top right-hand corner closes the most recently
opened submenu.

m  The Home key in the top right-hand corner closes all open submenus.
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= The most recently selected menu items are displayed in the bottom sec-
tion (maximum 6).

This makes it possible to select these menu items again directly without
first having to close other submenus that might be open.

= The white cross on the left-hand side closes the window.

Inputs/outputs

SUBMIT interpreter

Display Status keys

Diagnasis User group

Start-up Miscellansous

Shutdown Safety configuration

Help External axes

Fig. 4-6: Example: Configuration submenu is open.

4.5 Exiting or restarting KSS

Precondition = For certain options: “Expert” user group
Procedure 1. Select the menu item Shutdown in the main menu.
2. Select the desired options.
3. Press Shut down control PC or Reboot control PC.
4. Confirm the request for confirmation with Yes. The System Software is ter-

minated and restarted in accordance with the selected option.
After the restart, the following message is displayed:

=  Cold start of controller
= Or, if Reload files has been selected: Initial cold start of controller

NOTICE If, on shutting down, the option Reboot control PC was

selected, the main switch on the robot controller must not
be pressed until the reboot has been completed. System files may otherwise
be destroyed.
If this option was not selected on shutting down, the main switch can be
pressed once the controller has shut down.

Issued: 20.07.2012 Version: KSS 8.2 END V2 en (PDF 45/ 221



KUKA

46 / 221

KUKA System Software 8.2

Description

Default settings for switching off the controller via main switch
Start type

() Cold start I_l (@ Hibernate ‘

Power-off delay time
- H -|-Jl49[s] l:

Settings valid next time the system is switched off using the main switch

[ "] Force cold start

() Reload files
e
Instant actions
Shutdown options
i fc“d"“"m“t"'l I_l Reboot control PC ‘
Drive bus
I | ﬂ - J
Fig. 4-7: Shutdown window
Option ‘ Description
Default settings for switching off the controller via main switch
Cold start After a power failure, the robot controller starts

with a cold start.

(A power failure and start are generally triggered
by switching the main switch on the robot con-
troller off and on.)

Can only be selected in the “Expert” user group.

(>>> "Start types" Page 48)

Hibernate After a power failure, the robot controller starts
with Hibernate.

Can only be selected in the “Expert” user group.

(>>> "Start types" Page 48)

Power-off delay time | Wait time before the robot controller is shut
down. This ensures that the system does not
immediately shut down, for example, in the event
of very brief power failures, but bridges the
power failure.

Can only be changed in the “Expert” user group.

Settings valid next time the system is switched off using the main
switch

These settings only apply to the next start.

Force cold start Activated: The next start is a cold start.

Only available if Hibernate has been selected.
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Option Description
Reload files Activated: The next start is an initial cold start.

This option must be selected in the following
cases:

m If XML files have been changed directly, i.e.
the user has opened the file and modified it.

(Any other changes to XML files, e.g. if the ro-
bot controller modifies them in the back-
ground, are irrelevant.)

m Ifhardware components are to be exchanged
after shutdown.

Can only be selected in the “Expert” user group.
Only available if Cold start or Force cold start
has been selected.

Depending on the hardware, the initial cold start
takes approx. 30 to 150 seconds longer than a
normal cold start.

Power-off delay time | Activated: The wait time is adhered to the next
time the system is shut down.

Deactivated: The wait time is ignored the next
time the system is shut down.

Instant actions

Shut down control Only available in operating modes T1 and T2.

pC The robot controller is shut down

Reboot control PC Only available in operating modes T1 and T2.
The robot controller is shut down and then
restarted.

Drive bus Only available in operating modes T1 and T2.

OFF / ON The drive bus can be switched off or on.

Drive bus status indicator:

= Green: Drive bus is on.
= Red: Drive bus is off.
= Gray: Status of the drive bus is unknown.
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Start types Start type Description

Cold start After a cold start the robot controller displays the Navi-
gator. No program is selected. The robot controller is
reinitialized, e.g. all user outputs are set to FALSE.

Note: If XML files have been changed directly, i.e. the
user has opened the file and modified it, these changes
are taken into consideration in the case of a cold start
with Reload files. This cold start is called an “initial
cold start”.

In the case of a cold start without Reload files, these
changes are not taken into consideration.

Hibernate After a start with Hibernate, the previously selected
robot program can be resumed. The state of the kernel
system: programs, block pointer, variable contents and
outputs, is completely restored.

Additionally, all programs that were open parallel to the
robot controller are reopened and have the same state
that they had before the system was shut down. The
last state of Windows is also restored.

4.6 Switching the robot controller off

Procedure ®  Turn the main switch on the robot controller to OFF.
The robot controller automatically backs up data.

The main switch on the robot controller must not be op-
NOTICE erated if the KSS has been exited with the option Reboot

control PC and the reboot has not yet been completed. System files may
otherwise be destroyed.

4.7 Setting the user interface language

Procedure 1. In the main menu, select Configuration > Miscellaneous > Language.
2. Select the desired language. Click OK to confirm.

4.8 Online documentation and online help

4.8.1 Calling online documentation

Description The documentation of the KUKA System Software can be displayed on the ro-
bot controller. Certain technology packages also have documentation that can
be displayed on the robot controller.

Procedure 1. Inthe main menu, select Help > Documentation. Then select either Sys-
tem Software or the menu item for the technology package.

The KUKA Embedded Information Service window is opened. The table
of contents of the documentation is displayed.

2. Touch a chapter. The topics it contains are displayed.
3. Touch a topic. The description is displayed.
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Example
©)
S
. KUKA Embedded Informatio) Service =

L [ 3 i Home KUKA System Software 8.2

5.6.3.2 Entering the external TCP numerically

Precondition
B The following numerical values are known, e.g. from CAD data:

B Distance between the TCP of the fixed tool and the origin of the WORLD coordinate
system (X, Y, Z)

B Rotation of the axes of the fixed tool relative to the WORLD coordinate system (A,
B, C)

B Operating mode T1

Procedure

1. In the main menu, select Start-up > Calibrate > Fixed tool > Numeric input.
2. Assign a number and a name for the fixed tool. Confirm with Next.

3. Enter data. Confirm with Next.

4. Press Save.

Fig. 4-8: Online documentation — Example from the KUKA System Soft-
ware

Item | Description

1,2 | Displays the table of contents.

3 Displays the previous topic in the table of contents.

4 Displays the next topic.

4.8.2 Calling online help

Description

Procedure

The online help refers to the messages. The online help can be called in the
following ways:

m Call the help for a message that is currently displayed in the message win-
dow.

m Display an overview of the possible messages and call the help for a mes-
sage there.

Calling the online help for a message in the message window

Most messages contain a button with a question mark. Online help is available
for these messages.

1. Touch the button containing the question mark. The KUKA Embedded In-
formation Service — Message page window is opened.
The window contains a variety of information about the message.
(>>> Fig. 4-9)

2. The window often also contains information about the causes of the mes-
sage and the corresponding solutions. Details can be displayed:

a. Touch the magnifying glass button next to the cause. The detail page
is opened. (>>> Fig. 4-10)
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Open the descriptions of the cause and solution.

If the message has several possible causes: the magnifying glass but-
tons with arrows can be used to jump to the previous or next detail

page.

Procedure Displaying an overview of the messages and calling the online help for
a message there

1. In the main menu, select Help > Messages. Then select either System
Software or the menu item for the technology package.

The KUKA Embedded Information Service — Index page window is
opened. The messages are sorted by module (“module” refers here to a
subsection of the software).

2. Touch an entry. The messages of this module are displayed.

3. Touch a message. The message page is displayed.
The window contains a variety of information about the message.
(>>> Fig. 4-9)

4. The window often also contains information about the causes of the mes-
sage and the corresponding solutions. Details can be displayed:

a. Touch the magnifying glass button next to the cause. The detail page
is opened. (>>> Fig. 4-10)

Open the descriptions of the cause and solution.

If the message has several possible causes: the magnifying glass but-
tons with arrows can be used to jump to the previous or next detail

page.
Message page il ol
(1) (2) (3)
I. VUS| CIMDeOOad g aon | >ervic |
L 5 Home Message page
i KSS00001 & N |
EMERGENCY 5TOP CEP

Effect

= Path-maintaining EMERGENCY STOP
= Input of active commands (robot motions, program start) is blocied.

Follow-up message

= K5501200
Ackn. EMERGENCY STOP

Possible cause(s)

1. Cause: EMERGENCY STOP button on the operator panel (g
pressed
Solution: Unlock the EMERGENCY STOP button on the KUKA
smartPAD
2. Cause: Operator panel disconnected without first pressing ,f'+
the disconnection button

Solution: Disconnect the operator panel correctly

Fig. 4-9: Message page — Example from the KUKA System Software
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ltem Description
1 Displays the previous page.
2 This button is only active if the other arrow button has been used

to jump to the previous page. This button can then be used to
return to the original page.

3 Displays the list with the software modules.
4 Message number and text
5 Information about the message

There may be less information available than in the example.

6 Displays details about this cause/solution. (>>> Fig. 4-10)
Detail page | KUKA Embedded InformationService
K5500001 b
EMERGEMNCY STOP e

¥ Cause: EMERGEMCY STOP button on the aperator panel pressed

Description
The EMERGENCY STOP button on the KCP has been pressed.

¥ Solution: Unlock the EMERGENCY STOP button on the KUKA smartPAD
Procedure

+ Turn the EMERGENCY STOP button dockwise (direction indicated by
the arrow) to release it (position 1).

EMERGEMCY STOP button on the KUKA smartPAD

Q. Qe

Fig. 4-10: Detail page — Example from the KUKA System Software

4.9 Changing user group

Procedure 1. Select Configuration > User group in the main menu. The current user
group is displayed.
2. Press Default to switch to the default user group. (Default is not available
if the default user group is already selected.)
Press Login... to switch to a different user group. Select the desired user
group.
3. If prompted: Enter password and confirm with Log-on.
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Description Different functions are available in the KSS, depending on the user group. The
following user groups are available:

Operator
User group for the operator. This is the default user group.
User

User group for the operator. (By default, the user groups “Operator” and
“User” are defined for the same target group.)

Expert

User group for the programmer. This user group is protected by means of
a password.

Safety recovery

User group for the start-up technician. This user can activate and config-
ure the safety configuration of the robot.

This user group is protected by means of a password.
Safety maintenance

This user group is only relevant if KUKA.SafeOperation or KUKA.Saf-
eRangeMonitoring is used. The user group is protected by means of a
password.

Administrator

The range of functions is the same as that for the user group “Expert”. It is
additionally possible, in this user group, to integrate plug-ins into the robot
controller.

This user group is protected by means of a password.

The default password is “kuka”.

When the system is booted, the default user group is selected.

If the mode is switched to AUT or AUT EXT, the robot controller switches to
the default user group for safety reasons. If a different user group is desired,
this must be selected subsequently.

If no actions are carried out in the user interface within a certain period of time,
the robot controller switches to the default user group for safety reasons. The
default setting is 300 s.

410 Changing operating mode

@ | Do not change the operating mode while a program is running. If the
1 operating mode is changed during program execution, the industrial

robot is stopped with a safety stop 2.

Precondition

Procedure 1.

The robot controller is not executing a program.
Key for the switch for calling the connection manager

On the smartPAD, turn the switch for the connection manager. The con-
nection manager is displayed.

Select the operating mode.
Return the switch for the connection manager to its original position.

The selected operating mode is displayed in the status bar of the smart-
PAD.
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OpEIEL: Use Velocities
ing mode
= Program verification:
. Programmed velocity, maxi-
For test operation, pro- mum 250 mm/s
T1 gramming and teach-
ing ® Jog mode:
Jog velocity, maximum 250 mm/
s
= Program verification:
T2 For test operation Programmed velocity
m Jog mode: Not possible
For industrial robots Program mode:
AUT without higher-level Programmed velocity
controllers = Jog mode: Not possible
For industrial robots = Program mode:
AUT EXT | with higher-level con- Programmed velocity
trollers, e.g. PLC = Jog mode: Not possible

The following Cartesian coordinate systems are defined in the robot controller:

4.11 Coordinate systems
Overview

= WORLD

= ROBROOT

= BASE

= TOOL

$ROBRO

Fig. 4-11: Overview of coordinate systems

Description WORLD

KUKA
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The WORLD coordinate system is a permanently defined Cartesian coordi-
nate system. It is the root coordinate system for the ROBROOT and BASE co-
ordinate systems.

By default, the WORLD coordinate system is located at the robot base.
ROBROOT

The ROBROOT coordinate system is a Cartesian coordinate system, which is
always located at the robot base. It defines the position of the robot relative to
the WORLD coordinate system.

By default, the ROBROOT coordinate system is identical to the WORLD coor-
dinate system. $ROBROOT allows the definition of an offset of the robot rela-
tive to the WORLD coordinate system.

BASE

The BASE coordinate system is a Cartesian coordinate system that defines
the position of the workpiece. It is relative to the WORLD coordinate system.

By default, the BASE coordinate system is identical to the WORLD coordinate
system. It is offset to the workpiece by the user.

(>>> 5.7.2 "Base calibration" Page 106)
TOOL

The TOOL coordinate system is a Cartesian coordinate system which is locat-
ed at the tool center point.

By default, the origin of the TOOL coordinate system is located at the flange
center point. (In this case it is called the FLANGE coordinate system.) The
TOOL coordinate system is offset to the tool center point by the user.

(>>> 5.7.1 "Tool calibration" Page 99)

Angles of rotation of the robot coordinate systems

Angle Rotation about axis

Angle A Rotation about the Z axis
Angle B Rotation about the Y axis
Angle C Rotation about the X axis

412 Jogging the robot

Description There are 2 ways of jogging the robot:

m  Cartesian jogging
The TCP is jogged in the positive or negative direction along the axes of a
coordinate system.

m  Axis-specific jogging
Each axis can be moved individually in a positive and negative direction.
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Fig. 4-12: Axis-specific jogging

There are 2 operator control elements that can be used for jogging the robot:

= Jog keys
m Space Mouse

Overview

(>>>4.12.6 "Cartesian jog- | (>>> 4.12.5 "Axis-specific
ging with the jog keys" jogging with the jog keys"
Page 60) Page 60)

(>>>4.12.9 "Cartesian jog- | Axis-specific jogging with
ging with the Space Mouse" | the Space Mouse is possi-

Page 63) ble, but is not described
here.
4121 “Jog options” window
Description All parameters for jogging the robot can be set in the Jogging Options win-
dow.
Procedure Open the Jogging Options window:

1. Open a status indicator on the smartHMI, e.g. the POV status indicator.

(Not possible for the Submit interpreter, Drives and Robot interpreter
status indicators.)

A window opens.
2. Press Options. The Jogging Options window is opened.

For most parameters, it is not necessary to open the Jogging Options win-
dow. They can be set directly via the smartHMI status indicators.
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4.121.1 “General” tab
Program Override
o |+ w00%) >

[ T —

Program Run Mode

e/ Q] oA

Motion Step  Single Step

Fig. 4-13: General tab

Description Item | Description

1 Set program override

(>>> 6.5.4 "Setting the program override (POV)" Page 139)
2 Set jog override

(>>> 4.12.3 "Setting the jog override (HOV)" Page 59)

3 Select the program run mode

(>>> 6.5.2 "Program run modes" Page 138)

4.12.1.2 “Keys” tab

Activate Keys Incremental Jogging Mode

Continuous 2

Fig. 4-14: Keys tab
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Description Item | Description
1 Activate jog mode “Jog keys”

(>>> 4.12.2 "Activating the jog mode" Page 59)

2 Select a kinematics group. The kinematics group defines the axes
to which the jog keys refer.

Default: Robot axes (= A1 to AB)

Depending on the system configuration, other kinematics groups
may be available.

(>>> 4.13 "Jogging external axes" Page 65)
3 Select the coordinate system for jogging with the jog keys
4 Incremental jogging

(>>>4.12.10 "Incremental jogging" Page 64)

4.12.1.3 “Mouse” tab

Jogging Options
Activate Mouss Mouse Settings
(—= da @;...[ ® jel (O el (O )e
On/Off Dominant 6D XYZ ABC
©
Coordinate Systam
o 2 oE e
SYnc. Axis World Base Tcp
‘ General ‘ Keys | Mouss | Kcp Pos. l Act. Tool/Base ‘
Fig. 4-15: Mouse tab
Description Item | Description
1 Activate jog mode “Space Mouse”

(>>> 4.12.2 "Activating the jog mode" Page 59)
2 Configure the Space Mouse

(>>> 4.12.7 "Configuring the Space Mouse" Page 60)
3 Select the coordinate system for jogging with the Space Mouse
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4.12.1.4 “KCP pos.” tab

Jogging Options
Move the Kcp to the Angle 0°
right position...

®

Fig. 4-16: Kcp Pos. tab

Description Iltem | Description
1 (>>> 4.12.8 "Defining the alignment of the Space Mouse"
Page 62)

4.12.1.5 “Cur. tool/base” tab

Tool Selection
Oy — o
Base Selection
@1 L-J
@—— IpoMode Selection
@ O
Flange  Ext. Tool

Fig. 4-17: Act. Tool/Base tab

$NULLFRAME (o] h. 4

$NULLFRAME [0] =

Il

Description Item | Description
1 The current tool is displayed here. A different tool can be selected.

(>>> 4.12.4 "Selecting the tool and base" Page 59)

The display Unknown [?] means that no tool has yet been calibrat-
ed.
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2 The current base is displayed here. A different base can be select-
ed.

(>>> 4.12.4 "Selecting the tool and base" Page 59)

The display Unknown [?] means that no base has yet been cali-
brated.

3 Select the interpolation mode:

= Flange: The tool is mounted on the mounting flange.
m ext. Tool: The tool is a fixed tool.

412.2 Activating the jog mode

Procedure

Description

1. Open the Jogging Options window.
(>>>4.12.1 "Jog options” window" Page 55)
2. To activate the jog mode “Jog keys”:
On the Keys tab, activate the Activate Keys check box.
To activate the jog mode “Space Mouse”:
On the Mouse tab, activate the Activate Mouse check box.

Both jog modes “Jog keys” and “Space Mouse” can be activated simultane-

ously. If the robot is jogged using the keys, the Space Mouse is disabled until
the robot comes to a standstill. If the Space Mouse is actuated, the keys are
disabled.

4.12.3 Setting the jog override (HOV)

Description

Procedure

Alternative
procedure

Jog override determines the velocity of the robot during jogging. The velocity
actually achieved by the robot with a jog override setting of 100% depends on
various factors, including the robot type. The velocity cannot exceed 250 mm/
s however.

1. Touch the POV/HOV status indicator. The Overrides window is opened.

2. Setthe desired jog override. It can be set using either the plus/minus keys
or by means of the slide controller.

Plus/minus keys: The value can be set to 100%, 75%, 50%, 30%,
10%, 3%, 1%

Slide controller: The override can be adjusted in 1% steps.

3. Touch the POV/HOV status indicator again. (Or touch the area outside the
window.)

The window closes and the selected override value is applied.

@ | The Jog options window can be opened via Options in the Over-

l rides window.

Alternatively, the override can be set using the plus/minus key on the right-
hand side of the KCP.

The value can be set to 100%, 75%, 50%, 30%, 10%, 3%, 1%.

412.4 Selecting the tool and base

Description

A maximum of 16 TOOL and 32 BASE coordinate systems can be saved in
the robot controller. One tool (TOOL coordinate system) and one base (BASE
coordinate system) must be selected for Cartesian jogging.

KUKA
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Procedure

Touch the Tool/base status indicator. The Act. Tool/Base window is
opened.

Select the desired tool and base.
The window closes and the selection is applied.

4.12.5 Axis-specific jogging with the jog keys

Precondition

Procedure

The jog mode “Jog keys” is active.
Operating mode T1

Select Axes as the coordinate system for the jog keys.
Set jog override.

Hold down the enabling switch.

Axes A1 to A6 are displayed next to the jog keys.

Press the Plus or Minus jog key to move an axis in the positive or negative
direction.

@ | The position of the robot during jogging can be displayed: select Dis-
l play > Actual position in the main menu.

4.12.6 Cartesian jogging with the jog keys

Precondition

Procedure

The jog mode “Jog keys” is active.

Operating mode T1

Tool and base have been selected.

(>>> 4.12.4 "Selecting the tool and base" Page 59)

Select World, Base or Tool as the coordinate system for the jog keys.
Set jog override.
Hold down the enabling switch.
The following designations are displayed next to the jog keys:
X, Y, Z: for the linear motions along the axes of the selected coordinate
system

A, B, C: for the rotational motions about the axes of the selected coor-
dinate system

Press the Plus or Minus jog key to move the robot in the positive or nega-
tive direction.

@ | The position of the robot during jogging can be displayed: select Dis-
1 play > Actual position in the main menu.

412.7 Configuring the Space Mouse

Procedure

1.

2.

Open the Jogging Options window and select the Mouse tab.
(>>>4.12.1 "“Jog options” window" Page 55)
Mouse Settings group:
Dominant check box:
Activate or deactivate dominant mode as desired.
6D/XYZ/ABC option box:

Select whether the TCP is to be moved using translational motions, ro-
tational motions, or both.
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3. Close the Jogging Options window.

Description
Mouse Settings
L - - B
| ® s | O} O Ja
Dominant 6D X2 ABC

Fig. 4-18: Mouse settings

Dominant check box:

Depending on the dominant mode, the Space Mouse can be used to move just
one axis or several axes simultaneously.

Check box Description

Active Dominant mode is activated. Only the coordinate axis
with the greatest deflection of the Space Mouse is
moved.

Inactive Dominant mode is deactivated. Depending on the axis
selection, either 3 or 6 axes can be moved simultane-
ously.

Option Description

6D The robot can be moved by pulling, pushing, rotating or

tilting the Space Mouse.

The following motions are possible with Cartesian jog-
ging:

m  Translational motions in the X, Y and Z directions
= Rotational motions about the X, Y and Z axes

XYz The robot can only be moved by pulling or pushing the
Space Mouse.

The following motions are possible with Cartesian jog-
ging:
m  Translational motions in the X, Y and Z directions

ABC The robot can only be moved by rotating or tilting the
Space Mouse.

The following motions are possible with Cartesian jog-
ging:
m Rotational motions about the X, Y and Z axes
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Fig. 4-20: Rotating and tilting the Space Mouse

412.8 Defining the alignment of the Space Mouse

Description

The functioning of the Space Mouse can be adapted to the location of the user
so that the motion direction of the TCP corresponds to the deflection of the
Space Mouse.

The location of the user is specified in degrees. The reference point for the
specification in degrees is the junction box on the base frame. The position of
the robot arm or axes is irrelevant.

Default setting: 0°. This corresponds to a user standing opposite the junction
box.
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Fig. 4-21: Space Mouse: 0° and 270°

Precondition m  Operating mode T1

Procedure 1. Open the Jog options window and select the KCP pos. tab.
Move the Kcp to the Angle 0°
right position...

General . Mouse Kcp Pos. Act.

Fig. 4-22: Defining the alignment of the Space Mouse

2. Drag the KCP to the position corresponding to the location of the user (in
45° steps).

3. Close the Jog options window.

@ | Switching to Automatic External mode automatically resets the align-
1 ment of the Space Mouse to 0°.

412.9 Cartesian jogging with the Space Mouse

Precondition m  The jog mode “Space Mouse” is active.
m  Operating mode T1
= Tool and base have been selected.
(>>> 4.12.4 "Selecting the tool and base" Page 59)
= The Space Mouse is configured.
(>>>4.12.7 "Configuring the Space Mouse" Page 60)
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m  The alignment of the Space Mouse has been defined.
(>>> 4.12.8 "Defining the alignment of the Space Mouse" Page 62)

Procedure 1. Select World, Base or Tool as the coordinate system for the
Space Mouse.

2. Setjog override.
Hold down the enabling switch.
4. Move the robot in the desired direction using the Space Mouse.

w

@ | The position of the robot during jogging can be displayed: select Dis-
l play > Actual position in the main menu.

412.10 Incremental jogging

Description Incremental jogging makes it possible to move the robot a defined distance,
e.g. 10 mm or 3°. The robot then stops by itself.

Incremental jogging can be activated for jogging with the jog keys. Incremental
jogging is not possible in the case of jogging with the Space Mouse.

Areas of application:

m Positioning of equidistant points
= Moving a defined distance away from a position, e.g. in the event of a fault
m  Mastering with the dial gauge

The following options are available:

Setting Description

Continuous Incremental jogging is deactivated.
100 mm / 10° 1 increment = 100 mm or 10°

10 mm/ 3° 1 increment = 10 mm or 3°
1mm/1° 1 increment =1 mmor 1°

0.1 mm/ 0.005° 1 increment = 0.1 mm or 0.005°

Increments in mm:

m Valid for Cartesian jogging in the X, Y or Z direction.
Increments in degrees:

m Valid for Cartesian jogging in the A, B or C direction.

= Valid for axis-specific jogging.

Precondition m  The jog mode “Jog keys” is active.
m  Operating mode T1

Procedure 1. Select the size of the increment in the status bar.

2. Jog the robot using the jog keys. Jogging can be Cartesian or axis-specif-
ic.

Once the set increment has been reached, the robot stops.

@ | |f the robot motion is interrupted, e.g. by releasing the enabling
1 switch, the interrupted increment is not resumed with the next motion;
a new increment is started instead.
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413 Jogging external axes

Precondition

Procedure

Description

External axes cannot be moved using the Space Mouse. If “Space Mouse”
mode is selected, only the robot can be jogged with the Space Mouse. The ex-
ternal axes, on the other hand, must be jogged using the jog keys.

The jog mode “Jog keys” is active.
m  Operating mode T1

1. Select the desired kinematics group, e.g. External axes, on the Keys tab
in the Jog options window.

The type and number of kinematics groups available depend on the sys-
tem configuration.

2. Setjog override.
3. Hold down the enabling switch.

The axes of the selected kinematics group are displayed next to the jog
keys.

4. Press the Plus or Minus jog key to move an axis in the positive or negative
direction.

Depending on the system configuration, the following kinematics groups may
be available.

Kinematics group Description

Robot Axes The robot axes can be moved using the jog keys.
The external axes cannot be jogged.

External Axes All configured external axes (e.g. external axes
E1 to E5) can be moved using the jog keys.

NAME / The axes of an external kinematics group can be

External Kinematics moved using the jog keys.

Groupn The name is taken from the system variable
$ETn_NAME (n = number of the external kinemat-
ic system). If SETn_NAME is empty, the default
name External Kinematics Groupn is dis-

played.
[User-defined kinemat- | The axes of a user-defined kinematics group can
ics group] be moved using the jog keys.

The name corresponds to the name of the user-
defined kinematics group.

414 Bypassing workspace monitoring

Description

Workspaces can be configured for a robot. Workspaces serve to protect the
system.

There are 2 types of workspace:

m  The workspace is an exclusion zone.

The robot may only move outside the workspace.
= Only the workspace is a permitted zone.

The robot may not move outside the workspace.

Exactly what reactions occur when the robot violates a workspace depends on
the configuration.

One possible reaction, for example, is that the robot stops and an error mes-
sage is generated. The workspace monitoring must be bypassed in such a
case. The robot can then move back out of the prohibited workspace.

KUKA
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Precondition

Procedure

User group “Expert”
m  Operating mode T1

1. In the main menu, select Configuration > Miscellaneous > Workspace
monitoring > Override.

2. Move the robot manually out of the prohibited workspace.

Once the robot has left the prohibited workspace, the workspace monitor-
ing is automatically active again.

415 Monitor functions

4.15.1 Displaying the actual position

Procedure

Description

1. Inthe main menu, select Display > Actual position. The Cartesian actual
position is displayed.

2. To display the axis-specific actual position, press Axis-specific.

3. Todisplay the Cartesian actual position again, press Cartesian.

Actual position, Cartesian:

The current position (X, Y, Z) and orientation (A, B, C) of the TCP are dis-
played. In addition to this, the current TOOL and BASE coordinate systems
and the Status and Turn are displayed.

Actual position, axis-specific:

The current position of axes A1 to A6 is indicated. If external axes are being
used, the position of the external axes is also displayed.

The actual position can also be displayed while the robot is moving.

r

" Robot Position (Cartesian) |
Name [ Value | Unit | '
Position A8 spec.
X 2930.00 mm
Y 0.00 mm
z 695.00 mm
Orientation
A 0.00 deg
B 90.00 deg
G 0.00 deg
Robot Position
B 010 bin
T 000000 bin

Fig. 4-23: Actual position, Cartesian
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4 Operation
Robot Position (Axis Spedfic)
| Aois [ Pos. [deg, mm]] Motor [deg] | —
I A 0.00 0.00
F A2 -90.00 22530.00
A3 90.00 -24228.95
el 0.00 0.00
4| A5 0.00 0.00
I As 0.00 0.00
8 ElL 0.00 0.00
Fig. 4-24: Actual position, axis-specific
4.15.2 Displaying digital inputs/outputs
Procedure 1. In the main menu, select Display > Inputs/outputs > Digital 1/O.

2. To display a specific input/output:
Click on the Go to button. The Go to: box is displayed.
Enter the number and confirm with the Enter key.
The display jumps to the input/output with this number.

No.l \faiuel State [Name IA
130 O Eingang

140 () SYS Eingang

Description

+100

141 O Eingang

142 @ SIM Eingang

143 O Eingang

A 4
144 () Fingang I|
Inputs | Outputs

Fig. 4-25: Digital inputs

KUKA

Issued: 20.07.2012 Version: KSS 8.2 END V2 en (PDF

67 /221



KUKA KUKA System Software 8.2

77

[L_ wW@irg -

No.| Value| State |Narr|e |A -100
991 O Ausgang
+100
992 O Ausgang
993 @ SYS Ausgang Goto
994 O SYS Ausgang value
995 ()  SYS Ausgang
Name
v
L 99 (™  sys Ausgang
Inputs Outputs
Fig. 4-26: Digital outputs
ltem | Description
1 Input/output number
2 Value of the input/output. The icon is red if the input or output is
TRUE.

3 SIM entry: The input/output is simulated.

SYS entry: The value of the input/output is saved in a system vari-
able. This input/output is write-protected.

4 Name of the input/output

The following buttons are available:

Button Description

-100 Toggles back 100 inputs or outputs in the display.

+100 Toggles forward 100 inputs or outputs in the dis-
play.

Go to The number of the input or output being searched
for can be entered.

Value Toggles the selected input/output between TRUE
and FALSE. Precondition: The enabling switch is
pressed.

This button is not available in AUT EXT mode,
and is only available for inputs if simulation is ac-
tivated.

Name The name of the selected input or output can be
changed.

4.15.3 Displaying analog inputs/outputs
Procedure 1. In the main menu, select Display > Inputs/outputs > Analog I/O.

2. To display a specific input/output:
Click on the Go to button. The Go to: box is displayed.
Enter the number and confirm with the Enter key.
The display jumps to the input/output with this number.

The following buttons are available:
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Button Description

Go to The number of the input or output being searched
for can be entered.

Voltage A voltage can be entered for the selected output.
= -10...10V
This button is only available for outputs.

Name The name of the selected input or output can be
changed.

4154 Displaying inputs/outputs for Automatic External

Procedure = In the main menu, select Display > Inputs/outputs > Automatic Exter-
nal.
Description
® ®
" ot hatic External - Mo MJ)—
St Term Type |
1
2| Type programno. . PGNO TYPE 1
3|@ stwidth programno, e PGNO_LENGTH 8
4|@ Fist bit programno. o PGNO_FBIT 33
5(() Parity bit o PGNO_PARITY 41
6 O Programno. valid . PGNO_VALID 42
7| Programstart o $EXT_START 1026
‘B|@ Move enable o $MOVE_ENABLE 1025
9| ()  Ermror confirmation o SCONF_MESS 1026
10 o Drives off (invers) . SDRIVES_OFF 1025
11|(3)  Drives on o $DRIVES_ON 140
12|/@  Actiate nterface o $1_O_ACT 1025

Fig. 4-27: Automatic External inputs (detail view)

920 2 908

Term Type Value
1
2@ Alarm stop active o $ALARM_STOP 1013
? User safety switch closed B8  SUSER_SAF 1011
To Drives ready B8  SPERLRDY 1012
5|@  Robot calbrated B8  SROB_CAL 1001
?O Interface active . $I_O_ACTCONF 140
To Error collection e $STOPMESS 1010
?. Internal emergency stop we IntEstop 1002
Fig. 4-28: Automatic External outputs (detail view)
Item Description
1 Number
2 Status

= Gray: inactive (FALSE)
® Red: active (TRUE)
3 Long text name of the input/output
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Item Description
4 Type

= Green: input/output

m  Yellow: variable or system variable ($...)
5 Name of the signal or variable

6 Input/output number or channel number

Columns 4, 5 and 6 are only displayed if Details has been pressed.

The following buttons are available:

Button Description

Config. Switches to the configuration of the Automatic
External interface.

Inputs/Outputs Toggles between the windows for inputs and out-
puts.

Details/Normal Toggles between the Details and Normal views.

4.15.5 Displaying cyclical flags

Procedure 1. In the main menu, select Display > Variable > Cyclical flags. The Cycli-
cal flags window is opened.

2. Todisplay a specific flag:
Click on the Go to button. The Go to: box is displayed.
Enter the number and confirm with the Enter key.
The display jumps to the flag with this number.

Description @ O @ @

[lﬂ'h"r-.-' e

No. |Va]ue|1'~lame i |Deﬁmhnn sl 100

1 O Merker
+100

2 () Merker
3 (O Merker Go to
4 (O Merker p—

5 () Merker

& () Merker

v
7 (1 Merker

Fig. 4-29: Cyclical flags

ltem | Description

1 Number of the flag
Value of the flag. The icon is red if a flag is set.
Name of the flag

The conditions linked to the setting of a cyclical flag are indicated
here.

AlWN
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The following buttons are available:

Button Description

-100 Toggles back 100 flags in the display.

+100 Toggles forward 100 flags in the display.

Go to The number of the flag being searched for can be
entered.

Name The name of the selected flag can be modified.

4.15.6 Displaying flags

Procedure 1. In the main menu, select Display > Variable > Flags. The Flags window
is opened.

2. Todisplay a specific flag:
Click on the Go to button. The Go to: box is displayed.
Enter the number and confirm with the Enter key.
The display jumps to the flag with this number.

Description
" @
Nl::.| Value |Name ; | - _100
1 0 Flag
+100
2 () Flag
3 () Flag Go to
4 () Flag Value
5. () Flag
Name
& () Flag
v
7 {1 Elan
Fig. 4-30: Flags
Item | Description
1 Number of the flag
2 Value of the flag. The icon is red if a flag is set.
3 Name of the flag
The following buttons are available:
Button Description
-100 Toggles back 100 flags in the display.
+100 Toggles forward 100 flags in the display.
Go to The number of the flag being searched for can be
entered.

KUKA
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Button Description

Value Toggles the selected flag between TRUE and
FALSE. Precondition: The enabling switch is
pressed.
This button is not available in AUT EXT mode.

Name The name of the selected flag can be modified.

4.15.7 Displaying counters

Procedure 1. In the main menu, select Display > Variable > Counter. The Counter
window is opened.

2. Todisplay a specific counter:
Click on the Go to button. The Go to: box is displayed.
Enter the number and confirm with the Enter key.
The display jumps to the counter with this number.

Description

\r’due| MName | -
1 0 Zaehler
2 0 Zaehler
3 0 Zaehler Goto
B e
e
5 0 Zaehler
Mams
e
) 0 Zaehler
v
7 0 Zachler
Fig. 4-31: Counter
Iltem | Description
1 Counter number
4 Value of the counter.
5 Name of counter
The following buttons are available:
Button Description
Go to The number of the counter being searched for
can be entered.
Value A value can be entered for the selected counter.
Name The name of the selected counter can be modi-
fied.

Issued: 20.07.2012 Version: KSS 8.2 END V2 en (PDF

72/ 221



ool KUKA
415.8 Displaying timers

Procedure 1. In the main menu, select Display > Variable > Timer. The Timer window
is opened.

2. To display a specific timer:
Click on the Go to button. The Go to: box is displayed.
Enter the number and confirm with the Enter key.
The display jumps to the timer with this number.

Description
;)-w-

I"clu 5tatus| |\|’alue[m |Name |‘
1 B 0 Timer —
0 Timer
Go to
|
0 Timer Status
—
s W 0 Timer
Value
R———
& [ 0 Timer e —
w Name
rd - 0 Timer ||

Fig. 4-32: Timer

ltem | Description
1 Number of the timer
2 Status of the timer

m If the timer is activated, this is indicated in green.
m If the timer is deactivated, this is indicated in red.
3 State of the timer

m If the value of the timer is > 0, the timer flag is set (red check
mark).

m If the value of the timer is < 0, no timer flag is set.
4 Value of the timer (unit: ms)
5 Name of timer

The following buttons are available:

Button Description

Go to The number of the timer being searched for can
be entered.

State Toggles the selected timer between TRUE and
FALSE. Precondition: The enabling switch is
pressed.

Value A value can be entered for the selected timer.

Name The name of the selected timer can be modified.
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4.15.9 Displaying calibration data

Procedure 1. In the main menu, select Start-up > Calibrate > Calibration points and
the desired menu item:

Tool type
Base type
External axis
2. Enter the number of the tool, base or external kinematic system.
The calibration method and the calibration data are displayed.

4.15.10 Displaying information about the robot and robot controller

Procedure m  Select Help > Info in the main menu.
Description The information is required, for example, when requesting help from KUKA
Customer Support.

The tabs contain the following information:

Tab Description

Info Robot controller type

Robot controller version
User interface version
Kernel system version
Robot name

Robot type and configuration
Service life

The operating hours meter is running as long as the
drives are switched on. Alternatively, the operating
hours can also be displayed via the variable $ROB-
RUNTIME.

Number of axes

List of external axes

Machine data version

Control PC name

Operating system versions

Storage capacities

Options Additionally installed options and technology packages
Comments Additional comments

Modules Names and versions of important system files

Robot

System

The Save button exports the contents of the Modules
tab to the file C:\AKRC\ROBOTER\LOG\OCXVER.TXT.

4.15.11 Displaying/editing robot data

Precondition m T1 or T2 operating mode
= No program is selected.

Procedure = In the main menu, select Start-up > Robot data.
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Description oot ot
_ i P
Serial number —ﬁ\!}
0.00 —
Runtime [Hours] — \2 )
#KR2210_2 5 C4 FLR ZH210 B
Machine data - —\3)
my_rob Yy
Robot name Y- —i.4)
ronts01\transfer\test | {en
MNetwork archive path W \ \ \3)
Domainfuser {-H@
User password LD
my_archives ——"/—sﬂ
Archive name V- \,r:]
T
Incorporate robot name into ':E/l
archive name.
Import Transfer Transfer Save RDC
PID»RDC | | MAM»RDC | | CAL»RDC data

Fig. 4-33: Robot data window

ltem | Description
1 Serial number

2 Operating hours. The operating hours meter is running as long as
the drives are switched on. Alternatively, the operating hours can
also be displayed via the variable SROBRUNTIME.

3 Machine data name
4 Robot name. The robot name can be changed.
5 Robot controller data can be archived to a network path.

(>>> 6.8.3 "Archiving on the network" Page 147)

The archive path is defined here.

6 If archiving to the network requires a user name and password,
7 these can be entered here. It is then no longer necessary to enter
them every time for archiving.

8 This box is only displayed if the check box Incorporate robot
name into
archive name. is not activated.

A name for the archive file can be defined here.

9 m  Check box active: The robot name is used as the name for the
archive file. If no robot name is defined, the name archive is
used.

m  Check box not active: A separate name can be defined for
the archive file.

The buttons are not available in the user group “User”.
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5 Start-up and recommissioning

5 Start-up and recommissioning

5.1 Start-up wizard

Description Start-up can be carried out using the Start-up wizard. This guides the user
through the basic start-up steps.

Precondition = No program is selected.
m  Operating mode T1

Procedure m  Select Start-up > Start-up wizard in the main menu.

5.2 Checking the machine data

Description The correct machine data must be loaded. This must be checked by compar-
ing the loaded machine data with the machine data on the rating plate.

If machine data are reloaded, the version of the machine data must corre-
spond exactly to the KSS version. This is ensured if the machine data supplied
together with the KSS release are used.

A DANGER The industrial robot must not be moved if incorrect ma-

chine data are loaded. Death, severe injuries or consid-
erable damage to property may otherwise result. The correct machine data
must be loaded.

"

KUKA Roboter GmbH Y
Augsburg =
Germany MU
\ Typ Type Type KR XXX LXXX Xx-2 K-W-F XxxXYZ \
\ Artikel-Nr.  Article-No.  No.d"article XXXXXXXXXX ‘
SerieNr.  SerialNo.  No.Série XO00KX |
‘ Hergestellt Manufactured Fabrique 2004-02 ‘
‘ Gewicht  Weight Poids 1200 kg ‘
\ $TRAFONAME[]="#....." TRAFO1513321654984649352841 \
l...\MADA\ MADA15133216549846493554861‘

Fig. 5-1: Rating plate

Precondition m  T1 or T2 operating mode
=  No program is selected.

Procedure 1. In the main menu, select Start-up > Robot data.
The Robot Data window is opened.
2. Compare the following entries:
In the Robot data window: the entry in the Machine data box

On the rating plate on the base of the robot: the entry in the line $TRA-
FONAME()=“# ..... ?

KUKA

Issued: 20.07.2012 Version: KSS 8.2 END V2 en (PDF

77 /221



KUKA

78 / 221

KUKA System Software 8.2

@ | The file path of the machine data on the CD is specified on the rating
1 plate in the line ...\AMADAL\.

5.3 Jogging the robot without a higher-level safety controller

Description

Precondition

Procedure

To jog the robot without a higher-level safety controller, Start-up mode must
first be activated. The robot can then be jogged in T1 mode. If SafeOperation
is used, the robot can also be jogged in CRR.

If the RoboTeam option is used, it is only possible to activate Start-up mode
and jog the robot using the local smartPAD.

A DANGER External safeguards are disabled in Start-up mode. Ob-

serve the safety instructions relating to Start-up mode.
(>>> 3.8.3.1 "Start-up mode" Page 30)

The robot controller automatically deactivates Start-up mode in the following
cases:
m If no operator action has been carried out within 30 min of activation.

m Ifthe smartPAD is switched to passive mode or disconnected from the ro-
bot controller.

m If the PROFIsafe interface is used: when a connection to a higher-level
safety controller is established.

m If the X11 interface is used: when some input signals no longer have the
state “logic zero”.
In Start-up mode, the system switches to the following simulated input image:

The external EMERGENCY STOP is not active.
The safety gate is open.

No safety stop 1 has been requested.

No safety stop 2 has been requested.

No safe operational stop has been requested.
Only for VKR C4: E2 is closed.

If SafeOperation or SafeRangeMonitoring is used, Start-up mode also influ-
ences other signals.

e | Information about the effects of Start-up mode in conjunction with Sa-
1 feOperation or SafeRangeMonitoring can be found in the documen-
tation SafeOperation and SafeRangeMonitoring.

If the PROFIsafe interface is used: no connection to a higher-level safety
controller

m If the X11 interface is used: all input signals have the state “logic zero”.
m  Operating mode T1 or CRR

®m In the case of VKR C4: no E2/E7 signals are activated via a USB stick or
retrofit interface.

® In the case of RoboTeam: the local smartPAD is used.

= In the main menu, select Start-up > Service > Start-up mode.
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Menu Description
Start-up mode is active. Touching
«/ Start-up mods the menu item deactivates the
mode.
Start-up mode is not active. Touch-
Start-up made ing the menu item activates the

mode.

5.4 Checking the activation of the positionally accurate robot model

Description If a positionally accurate robot is used, it must be checked that the positionally

accurate robot model is activated.

In the case of positionally accurate robots, position deviations resulting from
workpiece tolerances and elastic effects of the individual robots are compen-
sated for. The positionally accurate robot positions the programmed TCP any-
where in the Cartesian workspace within the tolerance limits. The model
parameters of the positionally accurate robot are determined at a calibration
station and permanently saved on the robot (RDC).

@ | The positionally accurate robot model is only valid for the robot as de-

1 livered.

Following conversion or retrofitting of the robot, e.g. with an arm ex-
tension or a new wrist, the robot must be recalibrated.

Functions A positionally accurate robot has the following functions:

®m Increased positioning accuracy, approximately by the factor 10
m Increased path accuracy

@ | A precondition for the increased positioning and path accuracy is the
l correct input of the load data into the robot controller.

= Simplified transfer of programs if the robot is exchanged (no reteaching)

= Simplified transfer of programs after offline programming with WorkVisual
(no reteaching)

Procedure 1. In the main menu, select Help > Info.

2. Check on the Robot tab that the positionally accurate robot model is acti-
vated. (= specification Positionally accurate robot).

5.5 Mastering

Overview Every robot must be mastered. Only if the robot has been mastered can it
move to programmed positions and be moved using Cartesian coordinates.
During mastering, the mechanical position and the electronic position of the ro-
bot are aligned. For this purpose, the robot is moved to a defined mechanical
position, the mastering position. The encoder value for each axis is then
saved.

The mastering position is similar, but not identical, for all robots. The exact po-
sitions may even vary between individual robots of a single robot type.
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Fig. 5-2: Mastering position — approximate position

A robot must be mastered in the following cases:

Case Comments
During commissioning -
After maintenance work during (>>> 5.5.6 "Reference mastering"

which the robot loses its mastering, | Page 89)
e.g. exchange of motor or RDC
When the robot has been moved ---

without the robot controller (e.g.
with the release device)

After exchanging a gear unit Before carrying out a new master-
After an impact with an end stop at | ing procedure, the old mastering
more than 250 mm/s data must first be deleted! Master-

ing data are deleted by manually

After a collision. .
unmastering the axes.

(>>> 5.5.8 "Manually unmastering
axes" Page 97)

5.5.1 Mastering methods

The mastering methods that can be used for a robot depend on the type of
gauge cartridge with which it is equipped. The types differ visually in terms of
the size of their protective caps.
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Type of gauge cartridge Mastering methods
Gauge cartridge for EMD Mastering with the EMD
(Electronic Mastering Device) (>>> 5.5.3 "Mastering with the

EMD" Page 82)

Mastering with the dial gauge

(>>> 5.5.4 "Mastering with the dial
gauge" Page 87)

Reference mastering

In the case of robots with EMD
gauge cartridges, reference master-

ing is only used for mastering after
certain maintenance work.

Protective cap with fine thread, M20

(>>> 5.5.6 "Reference mastering"
Page 89)

Gauge cartridge for MEMD For A1 to A5: mastering with the
MEMD

(Micro Electronic Mastering Device)
For A6: mastering to the mark

(>>> 5.5.7 "Mastering with the
MEMD and mark" Page 90)

Protective cap with fine thread, M8

5.5.2 Moving axes to the pre-mastering position

Description The axes must be moved to the pre-mastering position before every mastering
operation. To do so, each axis is moved so that the mastering marks line up.

Fig. 5-3: Moving an axis to the pre-mastering position

The following figure shows where on the robot the mastering marks are situ-
ated. Depending on the specific robot model, the positions may deviate slightly
from those illustrated.
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Fig. 5-4: Mastering marks on the robot

Precondition = The jog mode “Jog keys” is active.
m  Operating mode T1

NOTICE If A4 and A6 are moved to the pre-mastering position,

ensure that the energy supply system — if present — is in
its correct position and not rotated through 360°.

e | Robots that are mastered with the MEMD have no pre-mastering po-
1 sition for A6. Only A1 to A5 have to be moved to the pre-mastering
position.

Procedure 1. Select Axes as the coordinate system for the jog keys.
2. Hold down the enabling switch.
Axes A1 to A6 are displayed next to the jog keys.

3. Press the Plus or Minus jog key to move an axis in the positive or negative
direction.

4. Move each axis, starting from A1 and working upwards, so that the mas-
tering marks line up.

5.5.3 Mastering with the EMD

Overview In EMD mastering, the axis is automatically moved by the robot controller to
the mastering position. Mastering is carried out first without and then with a
load. It is possible to save mastering data for different loads.
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Step Description
1 First mastering

(>>> 5.5.3.1 "First mastering (with EMD)" Page 83)

First mastering is carried out without a load.
2 Teach offset

(>>> 5.5.3.2 "Teach offset (with EMD)" Page 85)

“Teach offset” is carried out with a load. The difference from
the first mastering is saved.
3 If required: Master load with offset

(>>> 5.5.3.3 "Check load mastering with offset (with EMD)"
Page 86)

“Load mastering with offset” is carried out with a load for
which an offset has already been taught.

Area of application:

m  Checking first mastering

m Restoring first mastering if it has been lost (e.g. follow-
ing exchange of motor or collision). Since an offset that
has been taught is retained, even if mastering is lost, the
robot controller can calculate the first mastering.

5.5.3.1 First mastering (with EMD)

Precondition m  Thereis noload on the robot; i.e. there is no tool, workpiece or supplemen-
tary load mounted.

m All axes are in the pre-mastering position.
= No program is selected.
m  Operating mode T1

The EMD must always be screwed onto the gauge car-
NOTICE tridge without the signal cable attached. Only then may

the signal cable be attached to the EMD. Otherwise, the signal cable could
be damaged.

Similarly, when removing the EMD, the signal cable must always be removed
from the EMD first. Only then may the EMD be removed from the gauge car-
tridge.

After mastering, remove the signal cable from connection X32. Failure to do
so may result in interference signals or damage.

Procedure

1. Select Start-up > Master > EMD > With load correction > First master-
ing in the main menu.

A window opens. All axes to be mastered are displayed. The axis with the
lowest number is highlighted.

2. Remove the cover from connection X32.
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Fig. 5-5: Removing cover from X32

3. Connect the signal cable to X32.

Fig. 5-6: Connecting signal cable to X32

4. Remove the protective cap of the gauge cartridge on the axis highlighted
in the window. (Turned around, the EMD can be used as a screwdriver.)

Fig. 5-7: Removing protective cap from gauge cartridge

5. Screw the EMD onto the gauge cartridge.
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Fig. 5-8: Screwing EMD onto gauge cartridge

6. Attach the signal cable to the EMD, aligning the red dot on the connector
with the groove in the EMD.

Fig. 5-9: Attaching signal cable to EMD

7. Press Master.
8. Press an enabling switch and the Start key.

When the EMD has passed through the reference notch, the mastering po-
sition is calculated. The robot stops automatically. The values are saved.
The axis is no longer displayed in the window.

9. Remove the signal cable from the EMD. Then remove the EMD from the
gauge cartridge and replace the protective cap.

10. Repeat steps 4 to 9 for all axes to be mastered.
11. Close the window.
12. Remove signal cable from connection X32.

5.5.3.2 Teach offset (with EMD)

Description Teach offset is carried out with a load. The difference from the first mastering
is saved.

If the robot is operated with different loads, Teach offset must be carried out
for every load. In the case of grippers used for picking up heavy workpieces,
Teach offset must be carried out for the gripper both with and without the
workpiece.
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Precondition Same ambient conditions (temperature, etc.) as for first mastering.

The load is mounted on the robot.

All axes are in the pre-mastering position.
No program is selected.

Operating mode T1

NOTICE The EMD must always be screwed onto the gauge car-

tridge without the signal cable attached. Only then may
the signal cable be attached to the EMD. Otherwise, the signal cable could
be damaged.
Similarly, when removing the EMD, the signal cable must always be removed
from the EMD first. Only then may the EMD be removed from the gauge car-
tridge.
After mastering, remove the signal cable from connection X32. Failure to do
so may result in interference signals or damage.

Procedure

1. Select Start-up > Master > EMD > With load correction > Teach offset
in the main menu.

2. Enter tool number. Confirm with Tool OK.

A window opens. All axes for which the tool has not yet been taught are
displayed. The axis with the lowest number is highlighted.

3. Remove the cover from connection X32 and connect the signal cable.

4. Remove the protective cap of the gauge cartridge on the axis highlighted
in the window. (Turned around, the EMD can be used as a screwdriver.)

5. Screw the EMD onto the gauge cartridge.

6. Attach the signal cable to the EMD, aligning the red dot on the connector
with the groove in the EMD.

7. Press Learn.
8. Press an enabling switch and the Start key.

When the EMD has passed through the reference notch, the mastering po-
sition is calculated. The robot stops automatically. A window opens. The
deviation of this axis from the first mastering is indicated in degrees and
increments.

9. Click on OK to confirm. The axis is no longer displayed in the window.

10. Remove the signal cable from the EMD. Then remove the EMD from the
gauge cartridge and replace the protective cap.

11. Repeat steps 4 to 10 for all axes to be mastered.
12. Close the window.
13. Remove signal cable from connection X32.

5.5.3.3 Check load mastering with offset (with EMD)

Description Area of application:

m  Checking first mastering

m Restoring first mastering if it has been lost (e.g. following exchange of mo-
tor or collision). Since an offset that has been taught is retained, even if
mastering is lost, the robot controller can calculate the first mastering.

@ | Anaxis canonly be checked if all axes with lower numbers have been
l mastered.

Precondition = Same ambient conditions (temperature, etc.) as for first mastering.

m A load for which Teach offset has been carried out is mounted on the ro-
bot.

86 / 221 Issued: 20.07.2012 Version: KSS 8.2 END V2 en (PDF



KUKA

m All axes are in the pre-mastering position.
= No program is selected.
m  Operating mode T1

NOTICE The EMD must always be screwed onto the gauge car-

tridge without the signal cable attached. Only then may
the signal cable be attached to the EMD. Otherwise, the signal cable could
be damaged.
Similarly, when removing the EMD, the signal cable must always be removed
from the EMD first. Only then may the EMD be removed from the gauge car-
tridge.
After mastering, remove the signal cable from connection X32. Failure to do
so may result in interference signals or damage.

Procedure

1. In the main menu, select Start-up > Master > EMD > With load correc-
tion > Master load > With offset.

2. Enter tool number. Confirm with Tool OK.

A window opens. All axes for which an offset has been taught with this tool
are displayed. The axis with the lowest number is highlighted.

3. Remove the cover from connection X32 and connect the signal cable.

4. Remove the protective cap of the gauge cartridge on the axis highlighted
in the window. (Turned around, the EMD can be used as a screwdriver.)

5. Screw the EMD onto the gauge cartridge.

6. Attach the signal cable to the EMD, aligning the red dot on the connector
with the groove in the EMD.

7. Press Check.
8. Hold down an enabling switch and press the Start key.

When the EMD has passed through the reference notch, the mastering po-
sition is calculated. The robot stops automatically. The difference from
“Teach offset” is displayed.

9. If required, press Save to save the values. The old mastering values are
deleted.

To restore a lost first mastering, always save the values.

@ | Axes A4, A5 and A6 are mechanically coupled. This means:

l If the values for A4 are deleted, the values for A5 and A6 are also de-
leted.

If the values for A5 are deleted, the values for A6 are also deleted.

10. Remove the signal cable from the EMD. Then remove the EMD from the
gauge cartridge and replace the protective cap.

11. Repeat steps 4 to 10 for all axes to be mastered.
12. Close the window.
13. Remove signal cable from connection X32.

5.54 Mastering with the dial gauge

Description In dial mastering, the axis is moved manually by the user to the mastering po-
sition. Mastering is always carried out with a load. It is not possible to save
mastering data for different loads.
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Fig. 5-10: Dial gauge

The load is mounted on the robot.
m All axes are in the pre-mastering position.

m  The jog mode “Jog keys” is active and the coordinate system Axis has
been selected.

= No program is selected.
m  Operating mode T1

Precondition

Procedure 1. In the main menu, select Start-up > Master > Dial.

A window opens. All axes that have not been mastered are displayed. The
axis that must be mastered first is selected.

2. Remove the protective cap from the gauge cartridge on this axis and
mount the dial gauge on the gauge cartridge.

Using the Allen key, loosen the screws on the neck of the dial gauge. Turn
the dial so that it can be viewed easily. Push the pin of the dial gauge in as
far as the stop.

Using the Allen key, tighten the screws on the neck of the dial gauge.
3. Reduce jog override to 1%.

4. Jog axis from “+” to “-”. At the lowest position of the reference notch, rec-
ognizable by the change in direction of the pointer, set the dial gauge to 0.

If the axis inadvertently overshoots the lowest position, jog the axis back-
wards and forwards until the lowest position is reached. It is immaterial
whether the axis is moved from “+” to “-” or from “-” to “+”.

5. Move the axis back to the pre-mastering position.

6. Move the axis from “+” to “-” until the pointer is about 5-10 scale divisions
before zero.

7. Switch to incremental jogging.
8. Move the axis from “+” to “-” until zero is reached.

@ | |f the axis overshoots zero, repeat steps 5 to 8.

9. Press Master. The axis that has been mastered is removed from the win-
dow.

10. Remove the dial gauge from the gauge cartridge and replace the protec-
tive cap.

11. Switch back from incremental jogging to the normal jog mode.
12. Repeat steps 2 to 11 for all axes to be mastered.
13. Close the window.
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5.5.5 Mastering external axes

Description m  KUKA external axes can be mastered using either the EMD or the dial
gauge.
= Non-KUKA external axes can be mastered using the dial gauge. If master-
ing with the EMD is desired, the external axis must be fitted with gauge
cartridges.

Procedure ®m  The procedure for mastering external axes is the same as that for master-
ing robot axes. Alongside the robot axes, the configured external axes now
also appear in the axis selection window.

Master the following axes with the electronic measure tool EMD.
Mastering must he made without load:

Robot axis 2

Robot axis 3

Robot axis 4

Robot axis 5

Robot axis 6

Fig. 5-11: Selection list of axes to be mastered

@ | Mastering in the case of industrial robots with more than 2 external
1 axes: if the system contains more than 8 axes, it may be necessary
to connect the signal cable of the EMD to the second RDC.

5.5.6 Reference mastering

The procedure described here must not be used when commission
A ing the robot.

Description Reference mastering is suitable if maintenance work is due on a correctly
mastered robot and it is to be expected that the robot will lose its mastering.
Examples:

m  Exchange of RDC
= Exchange of motor

The robot is moved to the $MAMES position before the maintenance work is
commenced. Afterwards, the axis values of this system variable are reas-
signed to the robot by means of reference mastering. The state of the robot is
then the same as before the loss of mastering. Taught offsets are retained. No
EMD or dial gauge is required.

In the case of reference mastering, it is irrelevant whether or not there is a load
mounted on the robot. Reference mastering can also be used for external ax-
es.
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Preparation

Precondition

Procedure

= Move the robot to the SMAMES position before commencing the mainte-
nance work. To do so, program a point PTP $MAMES and move the robot
to it. This is only possible in the user group “Expert”!

The robot must not move to the default HOME position
| /\ WARNING | instead of to SMAMES. $SMAMES may be, but is not al-
ways, identical to the default HOME position. Only in the $MAMES position
will the robot be correctly mastered by means of reference mastering. If the
robot is reference mastered at any position other than SMAMES, this may re-

sult in injury and material damage.

No program is selected.
Operating mode T1
The position of the robot was not changed during the maintenance work.

If the RDC has been exchanged: the robot data have been transferred
from the hard drive to the RDC (this can only be done in the user group
“Expert™)

1. In the main menu, select Start-up > Master > Reference.
The option window Reference mastering is opened. All axes that have
not been mastered are displayed. The axis that must be mastered first is
selected.

2. Press Master. The selected axis is mastered and removed from the option
window.

3. Repeat step 2 for all axes to be mastered.

5.5.7 Mastering with the MEMD and mark

Overview

In MEMD mastering, the axis is automatically moved by the robot controller to
the mastering position. Mastering is carried out first without and then with a
load. It is possible to save mastering data for different loads.

A6 is not mastered using the MEMD, but with the aid of a mark. The procedure
is described in the sections describing MEMD mastering.

Step Description
1 First mastering

(>>> 5.5.7.1 "First mastering (with MEMD)" Page 91)

First mastering is carried out without a load.
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Step Description
2 Teach offset

(>>> 5.5.7.2 "Teach offset (with MEMD)" Page 94)

“Teach offset” is carried out with a load. The difference from
the first mastering is saved.

3 If required: Master load with offset

(>>> 5.5.7.3 "Check load mastering with offset (with
MEMD)" Page 95)

“Load mastering with offset” is carried out with a load for
which an offset has already been taught.

Area of application:

m  Checking first mastering

m  Restoring first mastering if it has been lost (e.g. follow-
ing exchange of motor or collision). Since an offset that
has been taught is retained, even if mastering is lost, the
robot controller can calculate the first mastering.

MEMD

Fig. 5-12: MEMD case

1 MEMD box 3 MEMD
2 Screwdriver 4 Cables

The thinner cable is the signal cable. It connects the MEMD to the MEMD box.

The thicker cable is the EtherCAT cable. It is connected to the MEMD box and
to the robot at X32.

NOTICE Leave the signal cable connected to the MEMD box and

disconnect it as little as possible. The pluggability of the
M8 sensor connector is limited. Frequent connection/disconnection can re-
sult in damage to the connector.

5.5.7.1 First mastering (with MEMD)

Precondition m  Thereis noload on the robot; i.e. there is no tool, workpiece or supplemen-
tary load mounted.

m A1 to A5 are in the pre-mastering position.
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= No program is selected.
m  Operating mode T1

Procedure 1. In the main menu, select Start-up > Master > EMD > With load correc-
tion > First mastering.

A window opens. All axes to be mastered are displayed. The axis with the
lowest number is highlighted.

2. Remove the cover from connection X32.

Fig. 5-13: X32 without cover
3. Connect the EtherCAT cable to X32 and to the MEMD box.

Fig. 5-14: EtherCAT cable at X32 and MEMD box

4. Remove the protective cap of the gauge cartridge on the axis highlighted
in the window.
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Fig. 5-15: Removing protective cap from gauge cartridge

5. Screw the MEMD onto the gauge cartridge.

Fig. 5-16: Screwing MEMD onto gauge cartridge

6. Press Master.
7. Press an enabling switch and the Start key.

When the MEMD has passed through the reference notch, the mastering
position is calculated. The robot stops automatically. The values are
saved. The axis is no longer displayed in the window.

8. Remove the MEMD from the gauge cartridge and replace the protective
cap.

9. Repeat steps 4 to 8 for all axes to be mastered, except A6.
10. Close the window.
11. Move AG6 to the mastering position:

A6 has very fine marks in the metal. Align these marks exactly with one
another.
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@ | WWhen moving to the mastering position, it is important to look at the
1 fixed mark in a straight line from in front. If the mark is observed from
the side, the movable mark cannot be aligned accurately enough.
This results in incorrect mastering.

Fig. 5-17: Mastering position A6 — view from above

12. In the main menu, select Start-up > Master > Reference.
The option window Reference mastering is opened. A6 is displayed and
is selected.

13. Press Master. A6 is mastered and removed from the option window.

14. Close the window.

15. Disconnect the EtherCAT cable from X32 and the MEMD box.

NOTICE Leave the signal cable connected to the MEMD box and

disconnect it as little as possible. The pluggability of the
M8 sensor connector is limited. Frequent connection/disconnection can re-
sult in damage to the connector.

5.5.7.2 Teach offset (with MEMD)

Description

Precondition

Procedure

Teach offset is carried out with a load. The difference from the first mastering
is saved.

If the robot is operated with different loads, Teach offset must be carried out
for every load. In the case of grippers used for picking up heavy workpieces,
Teach offset must be carried out for the gripper both with and without the
workpiece.

Same ambient conditions (temperature, etc.) as for first mastering.
The load is mounted on the robot.

A1 to A5 are in the pre-mastering position.

No program is selected.

Operating mode T1

1. Select Start-up > Master > EMD > With load correction > Teach offset
in the main menu.

2. Enter tool number. Confirm with Tool OK.
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A window opens. All axes for which the tool has not yet been taught are
displayed. The axis with the lowest number is highlighted.

3. Remove the cover from connection X32.
4. Connect the EtherCAT cable to X32 and to the MEMD box.

5. Remove the protective cap of the gauge cartridge on the axis highlighted
in the window.

6. Screw the MEMD onto the gauge cartridge.
7. Press Learn.
8. Press an enabling switch and the Start key.

When the MEMD has passed through the reference notch, the mastering
position is calculated. The robot stops automatically. A window opens. The
deviation of this axis from the first mastering is indicated in degrees and
increments.

9. Click on OK to confirm. The axis is no longer displayed in the window.

10. Remove the MEMD from the gauge cartridge and replace the protective
cap.

11. Repeat steps 5 to 10 for all axes to be mastered, except A6.
12. Close the window.
13. Move A6 to the mastering position:

A6 has very fine marks in the metal. Align these marks exactly with one
another.

@ | WWhen moving to the mastering position, it is important to look at the
l fixed mark in a straight line from in front. If the mark is observed from
the side, the movable mark cannot be aligned accurately enough.
This results in incorrect mastering.

14. In the main menu, select Start-up > Master > Reference.

The option window Reference mastering is opened. A6 is displayed and
is selected.

15. Press Master. A6 is mastered and removed from the option window.
16. Close the window.
17. Disconnect the EtherCAT cable from X32 and the MEMD box.

NOTICE Leave the signal cable connected to the MEMD box and

disconnect it as little as possible. The pluggability of the
M8 sensor connector is limited. Frequent connection/disconnection can re-
sult in damage to the connector.

5.5.7.3 Check load mastering with offset (with MEMD)

Description Area of application:

m  Checking first mastering

m Restoring first mastering if it has been lost (e.g. following exchange of mo-
tor or collision). Since an offset that has been taught is retained, even if
mastering is lost, the robot controller can calculate the first mastering.

@ | Anaxis can only be checked if all axes with lower numbers have been
l mastered.

The value determined for A6 is not displayed, i.e. first
IA CAUTION I mastering cannot be checked. It is possible to restore
lost first mastering, however.

Precondition m  Same ambient conditions (temperature, etc.) as for first mastering.
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m A load for which Teach offset has been carried out is mounted on the ro-
bot.

m A1 to A5 are in the pre-mastering position.
= No program is selected.
m  Operating mode T1

Procedure 1. In the main menu, select Start-up > Master > EMD > With load correc-
tion > Master load > With offset.

2. Enter tool number. Confirm with Tool OK.

A window opens. All axes for which an offset has been taught with this tool
are displayed. The axis with the lowest number is highlighted.

3. Remove the cover from connection X32.
4. Connect the EtherCAT cable to X32 and to the MEMD box.

5. Remove the protective cap of the gauge cartridge on the axis highlighted
in the window.

6. Screw the MEMD onto the gauge cartridge.
7. Press Check.
8. Hold down an enabling switch and press the Start key.

When the MEMD has passed through the reference notch, the mastering
position is calculated. The robot stops automatically. The difference from
“Teach offset” is displayed.

9. If required, press Save to save the values. The old mastering values are
deleted.

To restore a lost first mastering, always save the values.

@ | Axes A4, A5 and A6 are mechanically coupled. This means:

l If the values for A4 are deleted, the values for A5 and A6 are also de-
leted.

If the values for A5 are deleted, the values for A6 are also deleted.

10. Remove the MEMD from the gauge cartridge and replace the protective
cap.

11. Repeat steps 5 to 10 for all axes to be mastered, except A6.

12. Close the window.

13. Move A6 to the mastering position:

A6 has very fine marks in the metal. Align these marks exactly with one
another.

@ | WWhen moving to the mastering position, it is important to look at the
l fixed mark in a straight line from in front. If the mark is observed from
the side, the movable mark cannot be aligned accurately enough.
This results in incorrect mastering.

14. In the main menu, select Start-up > Master > Reference.
The option window Reference mastering is opened. A6 is displayed and
is selected.

15. Press Master to restore lost first mastering. A6 is removed from the option
window.

16. Close the window.

17. Disconnect the EtherCAT cable from X32 and the MEMD box.

NOTICE Leave the signal cable connected to the MEMD box and

disconnect it as little as possible. The pluggability of the
M8 sensor connector is limited. Frequent connection/disconnection can re-
sult in damage to the connector.
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5.5.8 Manually unmastering axes

Description The mastering values of the individual axes can be deleted. The axes do not
move during unmastering.

@ | Axes A4, A5 and A6 are mechanically coupled. This means:

1 If the values for A4 are deleted, the values for A5 and A6 are also de-
leted.

If the values for A5 are deleted, the values for A6 are also deleted.

NOTICE The software limit switches of an unmastered robot are

deactivated. The robot can hit the end stop buffers, thus
damaging the robot and making it necessary to exchange the buffers. An un-
mastered robot must not be jogged, if at all avoidable. If it must be jogged,
the jog override must be reduced as far as possible.

Precondition No program is selected.

m  Operating mode T1

Procedure 1. In the main menu, select Start-up > Master > Unmaster. A window
opens.

Select the axis to be unmastered.

Press Unmaster. The mastering data of the axis are deleted.
Repeat steps 2 and 3 for all axes to be unmastered.

Close the window.

o kN

5.6 Modifying software limit switches

There are 2 ways of modifying the software limit switches:

m  Enter the desired values manually.
m  Or automatically adapt the limit switches to one or more programs.

The robot controller determines the minimum and maximum axis positions
occurring in the program. These values can then be set as software limit
switches.

“Expert” user group
m T1, T2 or AUT mode

Precondition

Procedure Modifying software limit switches manually:

1. Inthe main menu, select Start-up > Service > Software limit switch. The
Software limit switch window is opened.

2. Modify the limit switches as required in the columns Negative and Posi-
tive.

3. Save the changes with Save.

Adapting software limit switches to a program:

1. Inthe main menu, select Start-up > Service > Software limit switch. The
Software limit switch window is opened.

2. Click on Auto detection. The following message is displayed: Auto detec-
tion is running.

3. Start the program to which the limit switches are to be adapted. Execute
the program completely and then cancel it.

The maximum and minimum position reached by each axis is displayed in
the Software limit switch window.
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4. Repeat step 3 for all programs to which the limit switches are to be adapt-
ed.

The maximum and minimum position reached by each axis in all executed
programs is displayed in the Software limit switch window.

5. Once all desired programs have been executed, press End in the Soft-
ware limit switch window.

6. Press Save to save the determined values as software limit switches.
7. If required, modify the automatically determined values manually.

e | Recommendation: Reduce the determined minimum values by 5°. In-
1 crease the determined maximum values by 5°.

This margin prevents the axes from reaching the limit switches during
program execution and thus triggering a stop.

8. Save the changes with Save.

Description Software limit switch window:

®

’i**-' ftware imit switer |

Axis Negative Current position Positive Auto
detection
Al [°] }185.00 0.00 185.00
End
A2 [°] -146.00 0.00 0.00
Save
A3 [°] -119.00 0.00 155.00
a4 [°] -350.00 0.00 350.00
A5 [°] -125.00 0.00 125.00
A6 [°] -350.00 0.00 350.00

Fig. 5-18: Before automatic determination

ltem Description

1 Current negative limit switch
2 Current position of the axis

3 Current positive limit switch
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P @

| OTOwWare Himic SwWit |

Axis Minirmurm Current position Ma:lﬁimum Auto
detection
Al [7] 0.00 0.00 0.00
End
A2 [7] 0.00 0.00 0.00
Save
A3 [7] 0.00 0.00 0.00
&4 [°] 0.00 0.00 0.00
A5 [°] 0.00 0.00 0.00
A6 [°] 0.00 0.00 0.00
Fig. 5-19: During automatic determination
ltem Description
4 Minimum position of the axis since the start of determination
5 Maximum position of the axis since the start of determination
Buttons The following buttons are available (only in the “Expert” user group):
Button Description
Auto detection Starts the automatic determination:

The robot controller writes the minimum and
maximum positions adopted by the axes from
now on to the columns Minimum and Maximum
in the Software limit switch window.

End Ends the automatic determination. Transfers the
calculated minimum/maximum positions to the
columns Negative and Positive, but does not yet
save them.

Save Saves the values in the columns Negative and
Positive as software limit switches.

5.7 Calibration

5.71 Tool calibration

Description During tool calibration, the user assigns a Cartesian coordinate system (TOOL
coordinate system) to the tool mounted on the mounting flange.

The TOOL coordinate system has its origin at a user-defined point. This is
called the TCP (Tool Center Point). The TCP is generally situated at the work-
ing point of the tool.

@ | Inthe case of a fixed tool, the type of calibration described here must
1 not be used. A separate type of calibration must be used for fixed
tools. (>>> 5.7.3 "Fixed tool calibration" Page 110)
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Advantages of tool calibration:

= The tool can be moved in a straight line in the tool direction.

The tool can be rotated about the TCP without changing the position of the
TCP.

= In program mode: The programmed velocity is maintained at the TCP
along the path.

A maximum of 16 TOOL coordinate systems can be saved. Variable:
TOOL_DATAJ[1...16].

The following data are saved:

= XY, Z
Origin of the TOOL coordinate system relative to the FLANGE coordinate
system

= AB,C:

Orientation of the TOOL coordinate system relative to the FLANGE coor-
dinate system

Fig. 5-20: TCP calibration principle

Overview Tool calibration consists of 2 steps:
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Step Description
1 Definition of the origin of the TOOL coordinate system
The following methods are available:
m  XYZ 4-point
(>>>5.7.1.1 "TCP calibration: XYZ 4-point method"
Page 101)

m  XYZ Reference
(>>>5.7.1.2 "TCP calibration: XYZ Reference method"
Page 103)
2 Definition of the orientation of the TOOL coordinate sys-
tem

The following methods are available:

= ABC 2-point

(>>> 5.7.1.4 "Defining the orientation: ABC 2-point meth-
od" Page 104)

=  ABC World

(>>> 5.7.1.3 "Defining the orientation: ABC World meth-
od" Page 104)

If the calibration data are already known, they can be entered directly.
(>>> 5.7.1.5 "Numeric input" Page 106)

5.7.1.1 TCP calibration: XYZ 4-point method

@ | The XYZ 4-point method cannot be used for palletizing robots.

Description The TCP of the tool to be calibrated is moved to a reference point from 4 dif-
ferent directions. The reference point can be freely selected. The robot con-
troller calculates the TCP from the different flange positions.

@ | The 4 flange positions at the reference point must be sufficiently dif-
1 ferent from one another.
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Fig. 5-21: XYZ 4-Point method

Precondition The tool to be calibrated is mounted on the mounting flange.

m  Operating mode T1

Procedure 1. In the main menu, select Start-up > Calibrate > Tool > XYZ 4-point.
2. Assign a number and a name for the tool to be calibrated. Confirm with
Next.

3. Move the TCP to a reference point. Press Calibrate. Answer the request
for confirmation with Yes.

4. Move the TCP to the reference point from a different direction. Press Cal-
ibrate. Answer the request for confirmation with Yes.

5. Repeat step 4 twice.

6. Enter the payload data. (This step can be skipped if the payload data are
entered separately instead.)

(>>> 5.8.3 "Entering payload data" Page 124)
7. Confirm with Next.

8. If required, coordinates and orientation of the calibrated points can be dis-
played in increments and degrees (relative to the FLANGE coordinate sys-
tem). For this, press Meas. points. Then return to the previous view by
pressing Back.

9. Either: press Save and then close the window via the Close icon.

Or: press ABC 2-point or ABC World. The previous data are automatical-
ly saved and a window is opened in which the orientation of the TOOL co-
ordinate system can be defined.

(>>> 5.7.1.4 "Defining the orientation: ABC 2-point method" Page 104)

(>>> 5.7.1.3 "Defining the orientation: ABC World method" Page 104)
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5.7.1.2 TCP calibration: XYZ Reference method

Description

Precondition

Preparation

Procedure

In the case of the XYZ Reference method, a new tool is calibrated with a tool
that has already been calibrated. The robot controller compares the flange po-
sitions and calculates the TCP of the new tool.

(@
| P

Fig. 5-22: XYZ Reference method

m A previously calibrated tool is mounted on the mounting flange.
m  Operating mode T1

Calculate the TCP data of the calibrated tool:

1. In the main menu, select Start-up > Calibrate > Tool > XYZ Reference.
Enter the number of the calibrated tool.

The tool data are displayed. Note the X, Y and Z values.

Close the window.

Ao nN

In the main menu, select Start-up > Calibrate > Tool > XYZ Reference.
Assign a number and a name for the new tool. Confirm with Next.
Enter the TCP data of the calibrated tool. Confirm with Next.

Move the TCP to a reference point. Press Calibrate. Answer the request
for confirmation with Yes.

Move the tool away and remove it. Mount the new tool.

6. Move the TCP of the new tool to the reference point. Press Calibrate. An-
swer the request for confirmation with Yes.

7. Enter the payload data. (This step can be skipped if the payload data are
entered separately instead.)

(>>> 5.8.3 "Entering payload data" Page 124)
8. Confirm with Next.

9. Ifrequired, coordinates and orientation of the calibrated points can be dis-
played in increments and degrees (relative to the FLANGE coordinate sys-
tem). For this, press Meas. points. Then return to the previous view by
pressing Back.

10. Either: press Save and then close the window via the Close icon.

Or: press ABC 2-point or ABC World. The previous data are automatical-
ly saved and a window is opened in which the orientation of the TOOL co-
ordinate system can be defined.

(>>> 5.7.1.4 "Defining the orientation: ABC 2-point method" Page 104)

(>>> 5.7.1.3 "Defining the orientation: ABC World method" Page 104)

oD~

o
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5.7.1.3 Defining the orientation: ABC World method

Description The axes of the TOOL coordinate system are aligned parallel to the axes of
the WORLD coordinate system. This communicates the orientation of the
TOOL coordinate system to the robot controller.

There are 2 variants of this method:

= 5D: Only the tool direction is communicated to the robot controller. By de-
fault, the tool direction is the X axis. The directions of the other axes are
defined by the system and cannot be detected easily by the user.

Area of application: e.g. MIG/MAG welding, laser cutting or waterjet cutting
m  6D: The directions of all 3 axes are communicated to the robot controller.
Area of application: e.g. for weld guns, grippers or adhesive nozzles

Precondition The tool to be calibrated is mounted on the mounting flange.
= The TCP of the tool has already been measured.

m  Operating mode T1

@ | The following procedure applies if the tool direction is the default tool
1 direction (= X axis). If the tool direction has been changed to Y or Z,
the procedure must also be changed accordingly.

In the main menu, select Start-up > Calibrate > Tool > ABC World.
Enter the number of the tool. Confirm with Next.
Select a variant in the box 5D/6D. Confirm with Next.
If 5D is selected:
Align +Xtoo parallel to -ZyworLp- (+X1o0oL = tool direction)
If 6D is selected:
Align the axes of the TOOL coordinate system as follows.
+Xt1ooL parallel to -ZyorLp- (+X100L = tool direction)

+YT1o0oL parallel to +YworLD

+Z100L Parallel to +XyworLD
5. Press Calibrate. Answer the request for confirmation with Yes.

Procedure

PoON=

@ | The following two steps are eliminated if the procedure is not called
l via the main menu, but by means of the ABC World button after TCP
calibration.

6. Enter the payload data. (This step can be skipped if the payload data are
entered separately instead.)

(>>> 5.8.3 "Entering payload data" Page 124)
7. Confirm with Next.

8. Ifrequired, coordinates and orientation of the calibrated points can be dis-
played in increments and degrees (relative to the FLANGE coordinate sys-
tem). For this, press Meas. points. Then return to the previous view by
pressing Back.

9. Press Save.

5.7.1.4 Defining the orientation: ABC 2-point method
Description The axes of the TOOL coordinate system are communicated to the robot con-
troller by moving to a point on the X axis and a point in the XY plane.

This method is used if it is necessary to define the axis directions with partic-
ular precision.
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Fig. 5-23: ABC 2-Point method

Precondition = The tool to be calibrated is mounted on the mounting flange.
The TCP of the tool has already been measured.
Operating mode T1

@ | The following procedure applies if the tool direction is the default tool
1 direction (= X axis). If the tool direction has been changedto Y or Z,
the procedure must also be changed accordingly.

Procedure 1. In the main menu, select Start-up > Calibrate > Tool > ABC 2-point.
2. Enter the number of the mounted tool. Confirm with Next.

3. Move the TCP to any reference point. Press Calibrate. Answer the re-
quest for confirmation with Yes.

4. Move the tool so that the reference point on the X axis has a negative X
value (i.e. move against the tool direction). Press Calibrate. Answer the
request for confirmation with Yes.

5. Move the tool so that the reference point in the XY plane has a negative Y
value. Press Calibrate. Answer the request for confirmation with Yes.

@ | 'he following two steps are eliminated if the procedure is not called
1 via the main menu, but by means of the ABC 2-point button after
TCP calibration.
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6. Enter the payload data. (This step can be skipped if the payload data are
entered separately instead.)

(>>> 5.8.3 "Entering payload data" Page 124)
7. Confirm with Next.

8. Ifrequired, coordinates and orientation of the calibrated points can be dis-
played in increments and degrees (relative to the FLANGE coordinate sys-
tem). For this, press Meas. points. Then return to the previous view by
pressing Back.

9. Press Save.

5.7.1.5 Numeric input

Description

Precondition

Procedure

The tool data can be entered manually.
Possible sources of data:

= CAD
m Externally calibrated tool
®m  Tool manufacturer specifications

@ | Inthe case of palletizing robots with 4 axes, e.g. KR 180 PA, the tool
1 data must be entered numerically. The XYZ and ABC methods can-

not be used as reorientation of these robots is highly restricted.

The following values are known:
X, Y and Z relative to the FLANGE coordinate system
A, B and C relative to the FLANGE coordinate system
m  Operating mode T1

In the main menu, select Start-up > Calibrate > Tool > Numeric input.

2. Assign a number and a name for the tool to be calibrated. Confirm with
Next.

3. Enter the tool data. Confirm with Next.

4. Enter the payload data. (This step can be skipped if the payload data are
entered separately instead.)

(>>> 5.8.3 "Entering payload data" Page 124)

5. Ifonline load data verification is available (this depends on the robot type):
configure as required.

(>>> 5.8.5 "Online load data check" Page 125)
6. Confirm with Next.
7. Press Save.

5.7.2 Base calibration

Description

During base calibration, the user assigns a Cartesian coordinate system
(BASE coordinate system) to a work surface or the workpiece. The BASE co-
ordinate system has its origin at a user-defined point.

o | |f the workpiece is mounted on the mounting flange, the type of cali-
1 bration described here must not be used. A separate type of calibra-
tion must be used for workpieces mounted on the mounting flange.

(>>> 5.7.3 "Fixed tool calibration" Page 110)

Advantages of base calibration:

m The TCP can be jogged along the edges of the work surface or workpiece.
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= Points can be taught relative to the base. If it is necessary to offset the
base, e.g. because the work surface has been offset, the points move with
it and do not need to be retaught.

A maximum of 32 BASE coordinate systems can be saved. Variable:
BASE_DATA[1...32].

Overview There are 2 ways of calibrating a base:

= 3-point method (>>> 5.7.2.1 "3-point method" Page 107)

= Indirect method (>>> 5.7.2.3 "Indirect method" Page 109)
(>>> 5.7.2.2 "Indirect method" Page 108)

If the calibration data are already known, they can be entered directly.

5.7.21 3-point method

Description The robot moves to the origin and 2 further points of the new base. These 3
points define the new base.

Fig. 5-24: 3-point method

Precondition m A previously calibrated tool is mounted on the mounting flange.
= Operating mode T1

Procedure 1. In the main menu, select Start-up > Calibrate > Base > ABC 3-point.
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2. Assign a number and a name for the base. Confirm with Next.
Enter the number of the mounted tool. Confirm with Next.

4. Move the TCP to the origin of the new base. Press Calibrate. Answer the
request for confirmation with Yes.

5. Move the TCP to a point on the positive X axis of the new base. Press Cal-
ibrate. Answer the request for confirmation with Yes.

6. Move the TCP to a point in the XY plane with a positive Y value. Press Cal-
ibrate. Answer the request for confirmation with Yes.

7. Ifrequired, coordinates and orientation of the calibrated points can be dis-
played in increments and degrees (relative to the FLANGE coordinate sys-
tem). For this, press Meas. points. Then return to the previous view by
pressing Back.

8. Press Save.

w

5.7.2.2 Indirect method

Description The indirect method is used if it is not possible to move to the origin of the
base, e.g. because it is inside a workpiece or outside the workspace of the ro-
bot.

The TCP is moved to 4 points in the base, the coordinates of which must be
known. The robot controller calculates the base from these points.

Fig. 5-25: Indirect method

Precondition = A calibrated tool is mounted on the mounting flange.

= The coordinates of 4 points in the new base are known, e.g. from CAD da-
ta. The 4 points are accessible to the TCP.

m  Operating mode T1

Procedure 1. In the main menu, select Start-up > Calibrate > Base > Indirect.
2. Assign a number and a name for the base. Confirm with Next.
3. Enter the number of the mounted tool. Confirm with Next.
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4. Enterthe coordinates of a known point in the new base and move the TCP
to this point. Press Calibrate. Answer the request for confirmation with
Yes.

5. Repeat step 4 three times.

6. If required, coordinates and orientation of the calibrated points can be dis-
played in increments and degrees (relative to the FLANGE coordinate sys-
tem). For this, press Meas. points. Then return to the previous view by
pressing Back.

7. Press Save.

5.7.2.3 Indirect method

Description The indirect method is used if it is not possible to move to the origin of the
base, e.g. because it is inside a workpiece or outside the workspace of the ro-
bot.

The TCP is moved to 4 points in the base, the coordinates of which must be
known. The robot controller calculates the base from these points.

Fig. 5-26: Indirect method

Precondition

A calibrated tool is mounted on the mounting flange.

= The coordinates of 4 points in the new base are known, e.g. from CAD da-
ta. The 4 points are accessible to the TCP.

Operating mode T1

Procedure In the main menu, select Start-up > Calibrate > Base > Indirect.
Assign a number and a name for the base. Confirm with Next.
Enter the number of the mounted tool. Confirm with Next.

Enter the coordinates of a known point in the new base and move the TCP
to this point. Press Calibrate. Confirm with Next.

Repeat step 4 three times.
6. Press Save.

PoON =

o
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5.7.3 Fixed tool calibration

Overview Calibration of a fixed tool consists of 2 steps:
Step Description
1 Calibration of the TCP of the fixed tool

The TCP of a fixed tool is called an external TCP.
(>>> 5.7.3.1 "Calibrating an external TCP" Page 110)

If the calibration data are already known, they can be entered
directly.

(>>> 5.7.3.2 "Entering the external TCP numerically”
Page 112)

2 Calibration of the workpiece
The following methods are available:

= Direct method

(>>> 5.7.3.3 "Workpiece calibration: direct method"
Page 112)

= Indirect method

(>>> 5.7.3.4 "Workpiece calibration: indirect method"
Page 113)

The robot controller saves the external TCP as the BASE coordinate system
and the workpiece as the TOOL coordinate system. A maximum of 32 BASE
coordinate systems and 16 TOOL coordinate systems can be saved.

5.7.3.1 Calibrating an external TCP

Description First of all, the TCP of the fixed tool is communicated to the robot controller.
This is done by moving a calibrated tool to it.

Then, the orientation of the coordinate system of the fixed tool is communicat-
ed to the robot controller. For this purpose, the coordinate system of the cali-
brated tool is aligned parallel to the new coordinate system. There are 2
variants:

5D: Only the tool direction of the fixed tool is communicated to the robot
controller. By default, the tool direction is the X axis. The orientation of the
other axes is defined by the system and cannot be detected easily by the
user.

6D: The orientation of all 3 axes is communicated to the robot controller.
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Fig. 5-27: Moving to the external TCP

/

ZFLANGE

YFLANGE ii

Fig. 5-28: Aligning the coordinate systems parallel to one another

Precondition = A previously calibrated tool is mounted on the mounting flange.
= Operating mode T1

@ | The following procedure applies if the tool direction is the default tool
l direction (= X axis). If the tool direction has been changed to Y or Z,

the procedure must also be changed accordingly.

Procedure In the main menu, select Start-up > Calibrate > Fixed tool > Tool.
Assign a number and a name for the fixed tool. Confirm with Next.
Enter the number of the calibrated tool. Confirm with Next.

Select a variant in the box 5D/6D. Confirm with Next.

Move the TCP of the calibrated tool to the TCP of the fixed tool. Press Cal-
ibrate. Answer the request for confirmation with Yes.

6. If 5D is selected:

ok wbh =

KUKA
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Align +Xgasg parallel to -Zp) anGE-

(i.e. align the mounting flange perpendicular to the tool direction of the
fixed tool.)

If 6D is selected:

Align the mounting flange so that its axes are parallel to the axes of the
fixed tool:

+Xpask parallel to -Zg angE
(i.e. align the mounting flange perpendicular to the tool direction.)
+Ypask parallel to +Yg anGE

+Zppsg parallel to +Xp anGE
7. Press Calibrate. Answer the request for confirmation with Yes.

8. If required, coordinates and orientation of the calibrated points can be dis-
played in increments and degrees (relative to the FLANGE coordinate sys-
tem). For this, press Meas. points. Then return to the previous view by
pressing Back.

9. Press Save.

5.7.3.2 Entering the external TCP numerically

Precondition ®m  The following numerical values are known, e.g. from CAD data:

Distance between the TCP of the fixed tool and the origin of the
WORLD coordinate system (X, Y, Z)

Rotation of the axes of the fixed tool relative to the WORLD coordinate
system (A, B, C)

m  Operating mode T1

Procedure 1. Inthe main menu, select Start-up > Calibrate > Fixed tool > Numeric in-
put.

2. Assign a number and a name for the fixed tool. Confirm with Next.
Enter data. Confirm with Next.
4. Press Save.

w

5.7.3.3 Workpiece calibration: direct method

Description The origin and 2 further points of the workpiece are communicated to the robot
controller. These 3 points uniquely define the workpiece.

Fig. 5-29
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Fig. 5-30: Workpiece calibration: direct method

Precondition The workpiece is mounted on the mounting flange.
= A previously calibrated fixed tool is mounted.

m  Operating mode T1

Procedure 1. In the main menu, select Start-up > Calibrate > Fixed tool > Workpiece
> Direct calibration.

2. Assign a number and a name for the workpiece. Confirm with Next.
3. Enter the number of the fixed tool. Confirm with Next.

4. Move the origin of the workpiece coordinate system to the TCP of the fixed
tool. Press Calibrate. Answer the request for confirmation with Yes.

5. Move a point on the positive X axis of the workpiece coordinate system to
the TCP of the fixed tool. Press Calibrate. Answer the request for confir-
mation with Yes.

6. Move a point with a positive Y value in the XY plane of the workpiece co-
ordinate system to the TCP of the fixed tool. Press Calibrate. Answer the
request for confirmation with Yes.

7. Enter the load data of the workpiece. (This step can be skipped if the load
data are entered separately instead.)

(>>> 5.8.3 "Entering payload data" Page 124)
8. Confirm with Next.

9. If required, coordinates and orientation of the calibrated points can be dis-
played in increments and degrees (relative to the FLANGE coordinate sys-
tem). For this, press Meas. points. Then return to the previous view by
pressing Back.

10. Press Save.

5.7.3.4 Workpiece calibration: indirect method

Description The robot controller calculates the workpiece on the basis of 4 points whose
coordinates must be known. The robot does not move to the origin of the work-
piece.
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@

Fig. 5-31: Workpiece calibration: indirect method
Precondition = A previously calibrated fixed tool is mounted.

The workpiece to be calibrated is mounted on the mounting flange.

The coordinates of 4 points of the new workpiece are known, e.g. from
CAD data. The 4 points are accessible to the TCP.

m  Operating mode T1

—_

Procedure In the main menu, select Start-up > Calibrate > Fixed tool > Workpiece

> Indirect calibration.

2. Assign a number and a name for the workpiece. Confirm with Next.

3. Enter the number of the fixed tool. Confirm with Next.

4. Enter the coordinates of a known point on the workpiece and move this
point to the TCP of the fixed tool. Press Calibrate. Answer the request for
confirmation with Yes.

5. Repeat step 4 three times.

6. Enter the load data of the workpiece. (This step can be skipped if the load
data are entered separately instead.)

(>>> 5.8.3 "Entering payload data" Page 124)

7. Confirm with Next.

8. If required, coordinates and orientation of the calibrated points can be dis-
played in increments and degrees (relative to the FLANGE coordinate sys-
tem). For this, press Meas. points. Then return to the previous view by
pressing Back.

9. Press Save.

5.7.4 Renaming the tool/base

Precondition m  Operating mode T1
Procedure 1. In the main menu, select Start-up > Calibrate > Tool or Base > Change
name.

2. Select the tool or base and press Name.
3. Enter the new name and confirm with Save.
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5.7.5 Linear unit

The KUKA linear unit is a self-contained, one-axis linear unit mounted on the
floor or ceiling. It is used for linear traversing of the robot and is controlled by
the robot controller as an external axis.

The linear unit is a ROBROOT kinematic system. When the linear unit is
moved, the position of the robot in the WORLD coordinate system changes.
The current position of the robot in the WORLD coordinate system is defined
by the vector SROBROOT_C.

$ROBROOT_C consists of:

m  $ERSYSROOQOT (static component)

Root point of the linear unit relative to $WORLD. The root point is situated
by default at the zero position of the linear unit and is not dependent on
$MAMES.

m  #ERSYS (dynamic component)

Current position of the robot on the linear unit relative to the $ERSYS-
ROOT

S
~
S

$ERSYSROOT "™ ==meemeeccmmmmnm==="
$WORLD

Fig. 5-32: ROBROOT kinematic system — linear unit

5.7.5.1 Checking whether the linear unit needs to be calibrated

Description

Precondition

Procedure

The robot is standing on the flange of the linear unit. Ideally, the ROBROOT
coordinate system of the robot should be identical to the FLANGE coordinate
system of the linear unit. In reality, there are often slight discrepancies which
mean that positions cannot be moved to correctly. Calibration allows mathe-
matical correction of these discrepancies. (Rotations about the direction of
motion of the linear unit cannot be corrected. They do not, however, cause er-
rors when moving to positions.)

If there are no discrepancies, the linear unit does not need to be calibrated.
The following procedure can be used to determine whether calibration is re-
quired.

®m  The machine data of the linear unit have been configured and loaded into
the robot controller.

®m A previously calibrated tool is mounted on the mounting flange.
= No program is open or selected.
m  Operating mode T1

1. Align the TCP against a freely selected point and observe it.
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2. Execute a Cartesian (not axis-specific!) motion with the linear unit.
If the TCP stops: the linear unit does not require calibration.
If the TCP moves: the linear unit does require calibration.
(>>> 5.7.5.2 "Calibrating the linear unit" Page 116)

If the calibration data are already known (e.g. from CAD), they can be entered
directly. (>>> 5.7.5.3 "Entering the linear unit numerically" Page 117)

5.7.5.2 Calibrating the linear unit

Description During calibration, the TCP of a tool that has already been calibrated is moved
to a reference point 3 times.
®m The reference point can be freely selected.

= The position of the robot on the linear unit from which the reference point
is approached must be different all 3 times. The 3 positions must be far
enough apart.

The correction values determined by the calibration are factored into the sys-
tem variable $ETx_TFLA3.

Precondition = The machine data of the linear unit have been configured and loaded into
the robot controller.

m A previously calibrated tool is mounted on the mounting flange.
= No program is open or selected.
m  Operating mode T1

Procedure 1. Inthe main menu, select Start-up > Calibrate > External kinematic sys-
tem > Linear unit.

The robot controller detects the linear unit automatically and displays the
following data:

Ext. kinematic system no.: number of the external kinematic system
(1...6) (3EX_KIN)

Axis: number of the external axis (1 ... 6) (SETx_AX)
Name of the external kinematic system ($ETx_NAME)

(If the robot controller is unable to determine these values, e.g. because
the linear unit has not yet been configured, calibration cannot be contin-
ued.)

2. Move the linear unit with the jog key “+”.

3. Specify whether the linear unit is moving to “+” or “-”. Confirm with Next.

4. Move the TCP to the reference point.

5. Press Calibrate.

6. Repeat steps 4 and 5 twice, but move the linear unit first each time in order
to address the reference point from different positions.

7. Press Save. The calibration data are saved.

8. The system asks whether the positions that have already been taught are

to be corrected.

If no positions have been taught prior to the calibration, it makes no dif-
ference whether the question is answered with Yes or No.

If positions have been taught prior to the calibration:

Answering Yes will cause positions with base 0 to be corrected auto-
matically. Other positions will not be corrected!

Answering No will cause no positions to be corrected.
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NOTICE After calibration of a linear unit, the following safety mea-

sures must be carried out:

1. Check the software limit switches of the linear unit and adapt them if re-
quired.

2. Test programsin T1.
Damage to property may otherwise result.

5.7.5.3 Entering the linear unit numerically

Precondition = The machine data of the linear unit have been configured and loaded into
the robot controller.

= No program is open or selected.
m  The following numerical values are known, e.g. from CAD data:
Distance between the robot base flange and the origin of the ERSYS-
ROOT coordinate system (X, Y, Z)
Orientation of the robot base flange relative to the ERSYSROOT coor-
dinate system (A, B, C)
m  Operating mode T1
Procedure 1. In the main menu, select Start-up > Calibrate > External kinematic sys-
tem > Linear unit (numeric).
The robot controller detects the linear unit automatically and displays the
following data:
Ext. kinematic system no.: number of the external kinematic system
(1...6)
Axis: number of the external axis (1 ... 6)
Name of the kinematic system
(If the robot controller is unable to determine these values, e.g. because
the linear unit has not yet been configured, calibration cannot be contin-
ued.)
2. Move the linear unit with the jog key “+”.
3. Specify whether the linear unit is moving to “+” or “-”. Confirm with Next.
4. Enter data. Confirm with Next.
5. Press Save. The calibration data are saved.
6. The system asks whether the positions that have already been taught are

to be corrected.

If no positions have been taught prior to the calibration, it makes no dif-
ference whether the question is answered with Yes or No.

If positions have been taught prior to the calibration:

Answering Yes will cause positions with base 0 to be corrected auto-
matically. Other positions will not be corrected!

Answering No will cause no positions to be corrected.

NOTICE After calibration of a linear unit, the following safety mea-

sures must be carried out:

1. Check the software limit switches of the linear unit and adapt them if re-
quired.

2. Test programsin T1.

Damage to property may otherwise result.
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5.7.6 Calibrating an external kinematic system

Description

Overview

Calibration of the external kinematic system is necessary to enable the motion
of the axes of the kinematic system to be synchronized and mathematically
coupled with the robot axes. An external kinematic system can be a turn-tilt ta-
ble or positioner, for example.

@ | Forlinear units, the type of calibration described here must not be
1 used. A separate type of calibration must be used for linear units.
(>>> 5.7.5 "Linear unit" Page 115)

Calibration of an external kinematic system consists of 2 steps:

Step Description
1 Calibrate the root point of the external kinematic system.

(>>> 5.7.6.1 "Calibrating the root point" Page 118)

If the calibration data are already known, they can be entered
directly.
(>>> 5.7.6.2 "Entering the root point numerically" Page 119)

2 If there is a workpiece on the external kinematic system: cali-
brate the base of the workpiece.

(>>> 5.7.6.3 "Workpiece base calibration" Page 120)

If the calibration data are already known, they can be entered
directly.

(>>> 5.7.6.4 "Entering the workpiece base numerically"
Page 122)

If there is a tool mounted on the external kinematic system:
calibrate the external tool.

(>>> 5.7.6.5 "Calibrating an external tool" Page 122)

If the calibration data are already known, they can be entered
directly.

(>>> 5.7.6.6 "Entering the external tool numerically"
Page 123)

5.7.6.1 Calibrating the root point

Description

In order to be able to move the robot with a mathematical coupling to a kine-
matic system, the robot must know the precise location of the kinematic sys-
tem. This location is determined by means of root point calibration.

The TCP of a tool that has already been calibrated is moved to a reference
point on the kinematic system 4 times. The position of the reference point must
be different each time. This is achieved by moving the axes of the kinematic
system. The robot controller uses the different positions of the reference point
to calculate the root point of the kinematic system.

In the case of external kinematic systems from KUKA, the reference point is
configured in the system variable $ETx_TPINFL in the machine data. This
contains the position of the reference point relative to the FLANGE coordinate
system of the kinematic system. (x = number of the kinematic system.) The ref-
erence point is also marked on the kinematic system. During calibration, this
reference point must be addressed.

In the case of non-KUKA external kinematic systems, the reference point must
be configured in the machine data.
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The robot controller saves the coordinates of the root point as the BASE coor-
dinate system.

&l o
«f od

Fig. 5-33: Root point calibration principle

Precondition The machine data of the kinematic system have been configured and load-

ed into the robot controller.

m  The number of the external kinematic system is known.
m A previously calibrated tool is mounted on the mounting flange.
m If SETx_TPINFL is to be modified: user group “Expert”
m  Operating mode T1
Procedure 1. In the main menu, select Start-up > Calibrate > External kinematic sys-

tem > Root point.

2. Select the number of the BASE coordinate system the root point is to be
saved as. Confirm with Next.

Enter the number of the external kinematic system.
Assign a name for the external kinematic system. Confirm with Next.
Enter the number of the reference tool. Confirm with Next.
The value of $ETx_TPINFL is displayed.
If the value is not correct: the value can be modified here in the user
group “Expert”.
If the value is correct: confirm with Next.
7. Move the TCP to the reference point.
8. Press Calibrate. Confirm with Next.

9. Repeat steps 7 and 8 three times. Each time, move the kinematic system
first so that the reference point is approached from different positions.

10. Press Save.

o0 s w»

5.7.6.2 Entering the root point numerically

Precondition m  The following numerical values are known, e.g. from CAD data:

Distance between the origin of the ROOT coordinate system and the
origin of the WORLD coordinate system (X, Y, Z)
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Orientation of the ROOT coordinate system relative to the WORLD co-
ordinate system (A, B, C)

= The number of the external kinematic system is known.
m  Operating mode T1

Procedure 1. In the main menu, select Start-up > Calibrate > External kinematic sys-
tem > Root point (numeric).

2. Select the number of the BASE coordinate system the root point is to be
saved as. Confirm with Next.

3. Enter the number of the external kinematic system.
4. Assign a name for the external kinematic system. Confirm with Next.

(The name is automatically also assigned to the BASE coordinate sys-
tem.)

5. Enter the data of the ROOT coordinate system. Confirm with Next.
6. Press Save.

5.7.6.3 Workpiece base calibration

Description During this calibration, the user assigns a BASE coordinate system to a work-
piece located on the kinematic system. This BASE coordinate system is rela-
tive to the FLANGE coordinate system of the kinematic system. The base is
thus a moving base that moves in the same way as the kinematic system.

It is not strictly necessary to calibrate a base. If none is calibrated, the
FLANGE coordinate system of the kinematic system is taken as the base.

During calibration, the TCP of a calibrated tool is moved to the origin and 2 oth-
er points of the desired base. These 3 points define the base. Only one base
can be calibrated per kinematic system.
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Fig. 5-34: Base calibration principle

Precondition The machine data of the kinematic system have been configured and load-

ed into the robot controller.

= A previously calibrated tool is mounted on the mounting flange.
= The root point of the external kinematic system has been calibrated.
m  The number of the external kinematic system is known.
m  Operating mode T1
Procedure 1. In the main menu, select Start-up > Calibrate > External kinematic sys-

tem > Offset.

2. Enter the number of the BASE coordinate system the root point was saved
as. The name of the BASE coordinate system is displayed.

Confirm with Next.

3. Enter the number of the external kinematic system. The name of the ex-
ternal kinematic system is displayed.

Confirm with Next.

KUKA
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4. Enter the number of the reference tool. Confirm with Next.

5. Move the TCP to the origin of the workpiece base. Press Calibrate and
confirm with Next.

6. Move the TCP to a point on the positive X axis of the workpiece base.
Press Calibrate and confirm with Next.

7. Move the TCP to a point in the XY plane with a positive Y value. Press Cal-
ibrate and confirm with Next.

8. Press Save.

5.7.6.4 Entering the workpiece base numerically

Precondition m  The following numerical values are known, e.g. from CAD data:

Distance between the origin of the workpiece base and the origin of the
FLANGE coordinate system of the kinematic system (X, Y, Z)

Rotation of the axes of the workpiece base relative to the FLANGE co-
ordinate system of the kinematic system (A, B, C)

®m  The root point of the external kinematic system has been calibrated.
= The number of the external kinematic system is known.
m  Operating mode T1

Procedure 1. Inthe main menu, select Start-up > Calibrate > External kinematic sys-
tem > Offset (numeric).

2. Enter the number of the BASE coordinate system the root point was saved
as. The name of the BASE coordinate system is displayed.

Confirm with Next.

3. Enter the number of the external kinematic system. The name of the ex-
ternal kinematic system is displayed.

Confirm with Next.
4. Enter data. Confirm with Next.
5. Press Save.

5.7.6.5 Calibrating an external tool

Description During calibration of the external tool, the user assigns a coordinate system to
the tool mounted on the kinematic system. This coordinate system has its or-
igin in the TCP of the external tool and is relative to the FLANGE coordinate
system of the kinematic system.

First of all, the user communicates to the robot controller the TCP of the tool
mounted on the kinematic system. This is done by moving a calibrated tool to
the TCP.

Then, the orientation of the coordinate system of the tool is communicated to
the robot controller. For this purpose, the user aligns the coordinate system of
the calibrated tool parallel to the new coordinate system. There are 2 variants:

m  5D: The user communicates the tool direction to the robot controller. By
default, the tool direction is the X axis. The orientation of the other axes is
defined by the system and cannot be influenced by the user.

The system always defines the orientation of the other axes in the same
way. If the tool subsequently has to be calibrated again, e.g. after a crash,
it is therefore sufficient to define the tool direction again. Rotation about

the tool direction need not be taken into consideration.

m  6D: The user communicates the direction of all 3 axes to the robot control-
ler.
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e | |f6Dis selected: itis advisable to document the alignment of all axes.
1 If the tool subsequently has to be calibrated again, e.g. after a crash,
the axes must be aligned the same way as the first time in order to be
able to continue moving to existing points correctly.

The robot controller saves the coordinates of the external tool as the BASE co-
ordinate system.

Precondition m  The machine data of the kinematic system have been configured and load-
ed into the robot controller.

A previously calibrated tool is mounted on the mounting flange.

The root point of the external kinematic system has been calibrated.
The number of the external kinematic system is known.

Operating mode T1

@ | The following procedure applies if the tool direction is the default tool
1 direction (= X axis). If the tool direction has been changed to Y or Z,
the procedure must also be changed accordingly.

Procedure 1. In the main menu, select Start-up > Calibrate > Fixed tool > External ki-
nematic offset.

2. Enter the number of the BASE coordinate system the root point was saved
as. The name of the BASE coordinate system is displayed.

Confirm with Next.

3. Enter the number of the external kinematic system. The name of the ex-
ternal kinematic system is displayed.

Confirm with Next.
4. Enter the number of the reference tool. Confirm with Next.
5. Select a variant in the box 5D/6D. Confirm with Next.

6. Move the TCP of the calibrated tool to the TCP of the external tool. Press
Calibrate and confirm with Next.

7. If 5D is selected:
Allgn +XBASE paraIIeI to 'ZFLANGE'

(i.e. align the mounting flange perpendicular to the tool direction of the ex-
ternal tool.)

If 6D is selected:

Align the mounting flange so that its axes are parallel to the axes of the
external tool:

+XBASE parallel to -ZFLANGE

(i.e. align the mounting flange perpendicular to the tool direction of the
external tool.)

+Ypase Parallel to +Yg anGE
+Zppsg parallel to +Xg anGE
8. Press Calibrate and confirm with Next.
9. Press Save.

5.7.6.6 Entering the external tool numerically

Precondition m  The following numerical values are known, e.g. from CAD data:

Distance between the TCP of the external tool and the origin of the
FLANGE coordinate system of the kinematic system (X, Y, Z)

Rotation of the axes of the external tool relative to the FLANGE coor-
dinate system of the kinematic system (A, B, C)
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m  Operating mode T1

Procedure 1. Inthe main menu, select Start-up > Calibrate > Fixed tool > Numeric in-
put.

2. Assign a number and a name for the external tool. Confirm with Next.
3. Enter data. Confirm with Next.
4. Press Save.

5.8 Load data

The load data are factored into the calculation of the paths and accelerations
and help to optimize the cycle times. The load data must be entered in the ro-
bot controller.

Sources Load data can be obtained from the following sources:
m  Software option KUKA.LoadDataDetermination (only for payloads on the
flange)
= Manufacturer information
= Manual calculation
m CAD programs

5.8.1 Checking loads with KUKA.Load

All load data (payload and supplementary loads) must be checked with the
KUKA.Load software. Exception: If the payload is checked with KUKA.Load-
DataDetermination, it is not necessary to check it with KUKA.Load.

A sign-off sheet can be generated for the loads with KUKA.Load. KUKA.Load
can be downloaded free of charge, complete with the documentation, from the
KUKA website www.kuka.com.

e | More information is contained in the KUKA.Load documentation.

1

5.8.2 Calculating payloads with KUKA.LoadDataDetermination

Description KUKA.LoadDataDetermination can be used to calculate payloads exactly and
transfer them to the robot controller.

Precondition m T1 or T2 operating mode
= No program is selected.

Procedure = Inthe main menu, select Start-up > Service > Load data determination.

@ | More information is contained in the KUKA.LoadDataDetermination
1 documentation.

5.8.3 Entering payload data

Description The payload data must be entered in the robot controller and assigned to the
correct tool.

Exception: If the payload data have already been transferred to the robot con-
troller by KUKA.LoadDataDetermination, no manual entry is required.
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The payload data have been checked with KUKA.Load or KUKA.Load-
DataDetermination and the robot is suitable for these payloads.

Precondition

Procedure 1. In the main menu, select Start-up > Calibrate > Tool > Payload data.
2. Enter the number of the tool in the box Tool no.. Confirm with Next.
3. Enter the payload data:
Box M: Mass
Boxes X, Y, Z: Position of the center of gravity relative to the flange

Boxes A, B, C: Orientation of the principal inertia axes relative to the
flange

Boxes JX, JY, JZ: Mass moments of inertia

(JX is the inertia about the X axis of the coordinate system that is ro-
tated relative to the flange by A, B and C. JY and JZ are the analogous
inertia about the Y and Z axes.)

Or, if the default values for this robot type are to be used: press Default.

4. Ifonline load data verification is available (this depends on the robot type):
configure as required.

(>>> 5.8.5 "Online load data check" Page 125)
5. Confirm with Next.
6. Press Save.

5.84 Entering supplementary load data

Description The supplementary load data must be entered in the robot controller.

Reference systems of the X, Y and Z values for each supplementary load:

Load Reference system
Supplementary load ROBROOT coordinate system
Al A1=0°
Supplementary load ROBROOT coordinate system
A2 A2 =-90°
Supplementary load FLANGE coordinate system
A3 A4=0°A5=0° A6=0°
Precondition m  The supplementary loads have been verified with KUKA.Load and are

suitable for this robot type.

Procedure 1. In the main menu, select Setup > Measure > Supplementary load data.

2. Enter the number of the axis on which the supplementary load is to be
mounted. Confirm with Continue.

3. Enter the load data. Confirm with Continue.
4. Press Save.

5.8.5 Online load data check

Configuration OLDC can be configured as follows:

m  During manual entry of the tool data
(>>> 5.7.1.5 "Numeric input" Page 106)

m During separate entry of the payload data
(>>> 5.8.3 "Entering payload data" Page 124)
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The following boxes are displayed in the same window in which the payload
data are also entered:

Configuration of the online load data verification
| | o Load data

®_ M\werii'"lcatiu:nn ‘

@7 Overload reaction Stop the robot. w

@—— Underload reaction Warning w

Fig. 5-35: Online load data check

ltem | Description

1 TRUE: OLDC is activated for the tool displayed in the same win-
dow. The defined reactions are carried out in the case of an over-
load or underload.

FALSE: OLDC is deactivated for the tool displayed in the same
window. There is no reaction in the case of an overload or under-
load.

2 The overload reaction can be defined here.

= None: No reaction.

= Warning: The robot controller generates the following status
message: Check of robot load (Tool {No.}) calculated overload.

= Stop robot: The robot controller generates an acknowledge-
ment message with the same content as that generated under
Warning. The robot stops with a STOP 2.

3 The underload reaction can be defined here. The possible reac-
tions are analogous to those for an overload.

The reactions can be modified in the KRL program using the system variable
$LDC_CONFIG.

5.9 Maintenance handbook

The Maintenance handbook functionality is available in the KUKA System
Software. The maintenance handbook enables logging of the maintenance
work. The logged maintenance work can be displayed in an overview.

The robot controller uses messages to indicate when maintenance is due:

® A message is generated one month before the maintenance work is due.
This message can be acknowledged.

m Atthe end of the month, the robot controller generates a message indicat-
ing that the maintenance is now due. This message cannot be acknowl-
edged. Additionally, LED4 on the Controller System Panel flashes (= first
LED from the left in the bottom row).

Only when the corresponding maintenance work has been logged does
the robot controller reset the message and the LED stops flashing.

@ | The controller variant “KR C4 compact” has no Controller System
l Panel and no flashing lights to indicate when maintenance work is
due.
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The due dates are determined by the maintenance intervals specified in the
KUKA maintenance agreements. The intervals are counted from the initial
start-up of the robot controller. The operating hours of the robot are counted.

5.9.1 Logging maintenance

Description Itis not possible to log multiple maintenance activities of the same kind on one
day.

@ | Once saved, changes can no longer be made.

Precondition m
Procedure 1.
2.
3.
4,

“Expert” user group

In the main menu, select Start-up > Service > Maintenance handbook.
The Maintenance handbook window is opened.

Select the Maintenance input tab and enter the maintenance details. En-
tries must be made in all boxes.

Press Save. A request for confirmation is displayed.
If all entries are correct, answer the request for confirmation with Yes.

The entries are now saved. Switching to the Maintenance overview tab
causes the maintenance to be displayed there.

I

P

_Maintenance handbook |

Maintenance type

Basic inspection =

Person/Company

— | KUKA

Order numbser

— | 123456

Comment

| | my test description

N

Maintenance input I Maintenance overview

Fig. 5-36: Maintenance input

Item | Description

1 Select which type of maintenance has been carried out.

2 Enter who performed the maintenance.

KUKA
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ltem | Description

3 For maintenance carried out and logged by KUKA employees: en-
ter the order number.

For other maintenance: enter any number.
4 Enter a comment.

Maintenance By default, the following maintenance types can be selected:

types Basic inspection

In-line wrist maintenance

Main axis maintenance

Gear backlash measurement
Minor electrical maintenance
Major electrical maintenance

Data backup with spare hard drive
Repair

These maintenance types correspond to those in the KUKA maintenance
agreements. Depending on the options used (e.g. linear axis or technology
packages), other maintenance types may be available for selection.

5.9.2 Displaying a maintenance log

Description The logged maintenance work can be displayed in an overview.

If the KUKA System Software is updated (e.g. from KSS 8.2.3 to KSS 8.2.4),
this overview is retained.

When archiving is carried out, the maintenance logs are also archived. If,
when the data are restored, other maintenance work has been logged on the
robot controller in the meantime, these logs are not overwritten; instead, the
restored logs are added to the overview.

Procedure 1. In the main menu, select Start-up > Service > Maintenance handbook.
The Maintenance handbook window is opened.

2. Select the Maintenance overview tab.

128 / 221 Issued: 20.07.2012 Version: KSS 8.2 END V2 en (PDF



KUKA

s
Basic inspection
Date | Person/Company | Operating hou Orderno. | Comment
10/7/2011 KLIKA a 123456 ggsctﬁsptuon
Part xyz
3f7/2011 | KUKA Germany 0 1122778 cgm':s"f:dofb:
defect

Minor electrical maintenance

Date | Person/Company |0pe|aﬁnghm| Orderno.l Comment
3/7/2011 ‘ KUKA Robotics |'[J ‘ 11223344 ‘mﬁ

Fig. 5-37: Maintenance overview
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6 Program management
6.1 Navigator file manager
Overview

Navigator
Filter: Detail

Comment | Attributes |

—
ﬁ OPS_DOKU1 (KRC:\)
Mastering R... -a2— RV...

{' masref_... src Mastering R... -a-— RV...
‘g testl dat a— V..

¥ et src el
‘ ;} test2 dat -a— RV...
c?g' test2 src a—RV...
|gtm_use." dat -3 R—-...

lg® KUKA_DISK (C:\)

{itm_use src g

g KUKA_DATA (D:\)

_,‘j (ARCHIVE:\)

8 Object(s) _®
Fig. 6-1: Navigator

1 Header 3 Filelist
2 Directory structure 4 Status bar
Description In the Navigator, the user manages programs and system-specific files.
Header

m Left-hand area: the selected filter is displayed.
(>>> 6.1.1 "Selecting filters" Page 132)

m  Right-hand area: the directory or drive selected in the directory structure
is displayed.

Directory structure

Overview of directories and drives. Exactly which directories and drives are
displayed depends on the user group and configuration.

File list

The contents of the directory or drive selected in the directory structure are dis-
played. The manner in which programs are displayed depends on the selected
filter.

The file list has the following columns:
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Column Description
Name Directory or file name
Extension File extension

This column is not displayed in the user group “User”.
Comment Comment

Attributes Attributes of the operating system and kernel system

This column is not displayed in the user group “User”.
Size File size in kilobytes

This column is not displayed in the user group “User”.

# Number of changes made to the file
Changed Date and time of the last change
Created Date and time of file creation

This column is not displayed in the user group “User”.

Status bar
The status bar can display the following information:

Selected objects

Action in progress

User dialogs

User entry prompts
Requests for confirmation

6.1.1 Selecting filters

Description This function is not available in the user group “User”.

The filter defines how programs are displayed in the file list. The following fil-
ters are available:

=  Detail
Programs are displayed as SRC and DAT files. (Default setting)
= Modules

Programs are displayed as modules.
Precondition = “Expert” user group

Procedure 1. Select the menu sequence Edit > Filter.
2. Select the desired filter in the left-hand section of the Navigator.
3. Confirm with OK.

6.1.2 Creating a new folder

Precondition m  The Navigator is displayed.

Procedure 1. Inthe directory structure, select the folder in which the new folder is to be
created, e.g. the folder R1.

Not all folders allow the creation of new folders within them. In the user
groups “Operator” and “User”, new folders can only be created in the folder
R1.

2. Press New.
3. Enter a name for the folder and confirm it with OK.
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6.1.3 Creating a new program

Precondition m  The Navigator is displayed.

Procedure 1. In the directory structure, select the folder in which the program is to be
created, e.g. the folder Program. (Not all folders allow the creation of pro-
grams within them.)

2. Press New.
3. Only in the user group “Expert”:

The Template selection window is opened. Select the desired template
and confirm with OK.

4. Enter a name for the program and confirm it with OK.

@ | Itis not possible to select a template in the user group “User”. By de-
1 fault, a program of type “Module” is created.

6.1.4 Renaming a file

Precondition

The Navigator is displayed.

Procedure 1. In the directory structure, select the folder in which the file is located.
2. Select the file in the file list.
3. Select Edit > Rename.
4. Overwrite the file name with the new name and confirm with OK.
6.2 Selecting or opening a program
Overview A program can be selected or opened. Instead of the Navigator, an editor is
then displayed with the program.
(>>> 6.2.1 "Selecting and deselecting a program" Page 134)
(>>> 6.2.2 "Opening a program" Page 135)
It is possible to toggle backwards and forwards between the program display
and the Navigator.
(>>> 6.2.3 "Toggling between the Navigator and the program" Page 135)
Differences Program is selected:

m The block pointer is displayed.
m  The program can be started.
= The program can be edited to a certain extent.

Selected programs are particularly suitable for editing in the user group
“User”.

Example: KRL instructions covering several lines (e.g. LOOP ... END-
LOOP) are not permissible.

= When the program is deselected, modifications are accepted without a re-
quest for confirmation. If impermissible modifications are programmed, an
error message is displayed.

Program is opened:
m  The program cannot be started.

m The program can be edited.

Opened programs are particularly suitable for editing in the user group
“Expert”.
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®m  Arequest for confirmation is generated when the program is closed. Mod-
ifications can be accepted or rejected.

6.2.1 Selecting and deselecting a program

o | |f aselected program is edited in the user group “Expert”, the cursor
1 must then be removed from the edited line and positioned in any other
line!

Only in this way is it certain that the editing will be applied when the program
is deselected again.

Precondition m T1, T2 or AUT mode

Procedure 1. Select the program in the Navigator and press Select.

The program is displayed in the editor. It is irrelevant whether a module,
an SRC file or a DAT file is selected. It is always the SRC file that is dis-
played in the editor.

2. Start or edit the program.
3. Deselect the program again:
Select Edit > Cancel program.

Or: In the status bar, touch the Robot interpreter status indicator. A win-
dow opens. Select Cancel program.

@ | When the program is deselected, modifications are accepted without
1 a request for confirmation!

If the program is running, it must be stopped before it can be deselected.

Description If a program is selected, this is indicated by the Robot interpreter status indi-
cator.

(>>> 6.5.6 "Robot interpreter status indicator" Page 140)

OO,
2

8 ]

3 FTP HOME | Vel= 100 ¥ DEFAULI

4 :::;f
S PTP Pl Vel=100 % PDATI Tool[1] Base[0]
6§ FPIP B2 Vel=100 % PDATZ Tool[1] Base[0]
7 ndloo
KRC:\R1\PROGRAMMINILOOP.SRC Ln4, Col 4 -

|
® &  ©

Fig. 6-2: Program is selected
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a b WON -

Block pointer

Cursor

Program path and file name

Position of the cursor in the program

The icon indicates that the program is selected.

6.2.2 Opening a program

Precondition (]

T1, T2 or AUT mode

A program can be opened in AUT EXT mode, but not edited.

Procedure 1.
2.
3.
4.

Description

Select the program in the Navigator and press Open. The program is dis-
played in the editor.

If a module has been selected, the SRC file is displayed in the editor. If an
SRC file or DAT file has been selected, the corresponding file is displayed
in the editor.

Edit the program.
Close the program.
To accept the changes, answer the request for confirmation with Yes.

1 1INI

%]

3 FTP HOME | Vel= 100 % DEFAULT

4 1|:c:p| /

FTF P1 Vel=100 % FDAT] Tool[l] Base[0]

o

FIF P2 Vel=100 % FDATZ Tool[l] Base[0]

o

endloop

KRC:\R 1\PROGRAM\MINILOOP.SRC ILn 4, Col 4

® ®

Fig. 6-3: Program is open

1
2
3

Cursor
Program path and file name
Position of the cursor in the program

6.2.3 Toggling between the Navigator and the program

Description If a program is selected or open, it is possible to display the Navigator again
without having to deselect or close the program. The user can then return to
the program.

Procedure Program is selected:
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m Toggling from the program to the Navigator: select the menu sequence
Edit > Navigator.

m  Toggling from the Navigator to the program: press PROGRAM.
Program is open:

®m  Toggling from the program to the Navigator: select the menu sequence
Edit > Navigator.

= Toggling from the Navigator to the program: press EDITOR.

@ | Programs that are running or have been interrupted must first be
1 stopped before the menu sequences and buttons referred to above
are available.

6.3 Structure of a KRL program

1 DEF my program( )

2 INI

3

4 PTP HOME Vel= 100 % DEFAULT

8 LIN point 5 CONT Vel= 2 m/s CPDAT1 Tool[3] Base[4]

14 PTP point 1 CONT Vel= 100 % PDAT1 Tool[3] Base[4]

20 PTP HOME Vel= 100 $ DEFAULT

21

22 END

Line Description

1 The DEF line indicates the name of the program. If the pro-
gram is a function, the DEF line begins with “DEFFCT” and
contains additional information. The DEF line can be dis-
played or hidden.
(>>> 6.4.1 "Displaying/hiding the DEF line" Page 137)

2 The INI line contains initializations for internal variables and
parameters.

4 HOME position
(>>> 6.3.1 "HOME position" Page 137)

8 LIN motion
(>>> 8.2.3 "Programming a LIN motion" Page 172)

14 PTP motion
(>>> 8.2.1 "Programming a PTP motion" Page 171)

20 HOME position

22 The END line is the last line in any program. If the program is
a function, the wording of the END line is “ENDFCT”. The
END line must not be deleted!

The first motion instruction in a KRL program must define an unambiguous
starting position. The HOME position, which is stored by default in the robot
controller, ensures that this is the case.

If the first motion instruction is not the default HOME position, or if this position
has been changed, one of the following statements must be used:

m  Complete PTP instruction of type POS or EGPOS
m  Complete PTP instruction of type AXIS or E6AXIS

“Complete” means that all components of the end point must be specified.
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If the HOME position is modified, this affects all pro-
| /\ WARNING | grams in which it is used. Injuries or damage to property

may result.

In programs that are used exclusively as subprograms, different statements
can be used as the first motion instruction.

6.3.1 HOME position

The HOME position is not program-specific. It is generally used as the first and
last position in the program as it is uniquely defined and uncritical.

The HOME position is stored by default with the following values in the robot
controller:

Axis A1 A2 A3 A4 A5 A6
Position 0° -90° +90° 0° 0° 0°

Additional HOME positions can be taught. A HOME position must meet the fol-
lowing conditions:
m  Good starting position for program execution

= Good standstill position. For example, the stationary robot must not be an
obstacle.

If the HOME position is modified, this affects all pro-
| /\ WARNING | grams in which it is used. Injuries or damage to property

may result.

6.4 Displaying/hiding program sections

6.4.1 Displaying/hiding the DEF line

Description

Precondition

Procedure

By default, the DEF line is hidden. Declarations can only be made in a program
if the DEF line is visible.

The DEF line is displayed and hidden separately for opened and selected pro-
grams. If detail view (ASCII mode) is activated, the DEF line is visible and does
not need to be activated separately.

User group “Expert”
m  Program is selected or open.

m  Select the menu sequence Edit > View > DEF line.
Check mark activated in menu: DEF line is displayed.
Check mark not activated in menu: DEF line is hidden.

6.4.2 Activating detail view

Description

Precondition

Detail view (ASCIl mode) is deactivated by default to keep the program trans-
parent. If detail view is activated, hidden program lines, such as the FOLD and
ENDFOLD lines and the DEF line, are displayed.

Detail view is activated and deactivated separately for opened and selected
programs.

= “Expert” user group
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Procedure m  Select the menu sequence Edit > View > Detail view (ASCII).
Check box activated: Detail view is activated.
Check box deactivated: Detail view is deactivated.

6.4.3 Activating/deactivating the line break function

Description If a line is wider than the program window, the line is broken by default. The
part of the line after the break has no line number and is marked with a black,
L-shaped arrow. The line break function can be deactivated.

8 EXT IBGN (IBGN_COMMAND :IN,BOOL :IN,REAL :IN,REAL
b :IN,BOOL :IN,E6POS :0UT )

Fig. 6-4: Line break

The line break function is activated and deactivated separately for opened and
selected programs.

Precondition m  User group “Expert”
m  Program is selected or open.

Procedure m  Select the menu sequence Edit > View > Line break.
Check mark activated in menu: line break function is activated.
Check mark not activated in menu: line break function is deactivated.

6.5 Starting a program

6.5.1 Selecting the program run mode

Procedure 1. Touch the Program run mode status indicator. The Program run mode
window is opened.

2. Select the desired program run mode.
(>>> 6.5.2 "Program run modes" Page 138)
The window closes and the selected program run mode is applied.

6.5.2 Program run modes

Program run mode Description
Go The program is executed through to the
4#GO end without stopping.
Motion The program is executed with a stop after
4#MSTEP each motion block. The Start key must be

pressed again for each motion block.

Single Step The program is executed with a stop after
each program line. Program lines that can-

#ISTEP ;

not be seen and blank lines are also taken

into consideration. The Start key must be

pressed again for each line.

Single Step is only available to the user
group “Expert”.

Backward This program run mode is automatically
4BSTEP selected if the Start backwards key is
pressed.
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e | In Motion Step and Single Step modes, the program is executed
1 without an advance run.

6.5.3 Advance run

The advance run is the maximum number of motion blocks that the robot con-
troller calculates and plans in advance during program execution. The actual
number is dependent on the capacity of the computer. The default value is 3.
The advance run refers to the current position of the block pointer. The ad-
vance run is required, for example, in order to be able to calculate approximate
positioning motions.

Certain statements trigger an advance run stop. These include statements
that influence the periphery, e.g. OUT statements.

6.5.4 Setting the program override (POV)

Description Program override is the velocity of the robot during program execution. The
program override is specified as a percentage of the programmed velocity.

@ | In T1 mode, the maximum velocity is 250 mm/s, irrespective of the
1 value that is set.

Procedure 1. Touch the POV/HOV status indicator. The Overrides window is opened.

2. Setthe desired program override. It can be set using either the plus/minus
keys or by means of the slide controller.

Plus/minus keys: The value can be set to 100%, 75%, 50%, 30%,
10%, 3%, 1%

Slide controller: The override can be adjusted in 1% steps.

3. Touch the POV/HOV status indicator again. (Or touch the area outside the
window.)

The window closes and the selected override value is applied.

@ | The Jog options window can be opened via Options in the Over-
l rides window.

Alternative Alternatively, the override can be set using the plus/minus key on the right-
procedure hand side of the KCP.

The value can be set to 100%, 75%, 50%, 30%, 10%, 3%, 1%.

6.5.5 Switching drives on/off

The status of the drives is indicated in the status bar. The drives can also be
switched on or off here.

Icon Color Description
Green Drives ready.

|
. Red Drives not ready.
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6.5.6 Robot interpreter status indicator

Icon Color Description
[e— Gray No program is selected.
| ®
PR Yellow The block pointer is situated on the first line
| R | of the selected program.

Green The program is selected and is being exe-

R cuted.

Red The selected and started program has been
. stopped.

Black The block pointer is situated at the end of
n the selected program.

6.5.7 Starting a program forwards (manual)

Precondition A program is selected.

m  Operating mode T1 or T2

Procedure 1. Select the program run mode.

2. Hold the enabling switch down and wait until the status bar indicates
“Drives ready”:

—

Fig. 6-5

3. Carry out a BCO run: Press Start key and hold it down until the message
“Programmed path reached (BCO)” is displayed in the message window. The
robot stops.

A BCO run is always executed as a PTP motion from the
| /\ WARNING | actual position to the target position. Observe the motion
to avoid collisions. The velocity is automatically reduced during the BCO run.

4. Press Start key and hold it down.

The program is executed with or without stops, depending on the program
run mode.

To stop a program that has been started manually, release the Start key.

6.5.8 Starting a program forwards (automatic)

Precondition A program is selected.

m  Operating mode Automatic (not Automatic External)

Procedure 1. Select the program run mode Go.
2. Switch on the drives.
3. Carry outa BCO run:
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Press Start key and hold it down until the message “Programmed path
reached (BCO)” is displayed in the message window. The robot stops.

A BCO run is always executed as a PTP motion from the
| /\ WARNING | actual position to the target position. Observe the motion
to avoid collisions. The velocity is automatically reduced during the BCO run.

4. Press the Start key. The program is executed.

To stop a program that has been started in Automatic mode, press the STOP
key.

6.5.9 Carrying out a block selection

Description A program can be started at any point by means of a block selection.

Precondition

A program is selected.
Operating mode T1 or T2

Procedure Select the program run mode.

Select the motion block at which the program is to be started.

Press Block selection. The block pointer indicates the motion block.
Hold the enabling switch down and wait until the status bar indicates
“Drives ready”:

|
L
5. Carry out a BCO run: Press Start key and hold it down until the message

“Programmed path reached (BCO)” is displayed in the message window. The
robot stops.

PoON~

A BCO run is always executed as a PTP motion from the
| /\ WARNING | actual position to the target position. Observe the motion
to avoid collisions. The velocity is automatically reduced during the BCO run.

6. The program can now be started manually or automatically. It is not nec-
essary to carry out a BCO run again.

6.5.10 Starting a program backwards

Description In the case of backward motion, the robot stops at every point. Approximate
positioning is not possible.

Precondition

A program is selected.
m  Operating mode T1 or T2

Procedure 1. Hold the enabling switch down and wait until the status bar indicates
“Drives ready”:

|
L
2. Carry out a BCO run: Press Start key and hold it down until the message

“Programmed path reached (BCO)” is displayed in the message window. The
robot stops.

A BCO run is always executed as a PTP motion from the
| /\ WARNING | actual position to the target position. Observe the motion
to avoid collisions. The velocity is automatically reduced during the BCO run.
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3. Press Start backwards key.
4. Press Start backwards key again for each motion block.

6.5.11 Resetting a program

Description

Precondition
Procedure

Alternative
procedure

In order to restart an interrupted program from the beginning, it must be reset.
This returns the program to the initial state.

m  Program is selected.
m  Select the menu sequence Edit > Reset program.

m In the status bar, touch the Robot interpreter status indicator. A window
opens.

Select Reset program.

6.5.12 Starting Automatic External mode

Precondition

Procedure

There is no BCO run in Automatic External mode. This
| /\ WARNING means that the robot moves to the first programmed po-
sition after the start at the programmed (not reduced) velocity and does not

stop there.

Operating mode T1 or T2
= Inputs/outputs for Automatic External are configured.
m  The program CELL.SRC is configured.

1. Select the program CELL.SRC in the Navigator. (This program is located
in the folder “R1”.)

2. Set program override to 100%. (This is the recommended setting. A differ-
ent value can be set if required.)

3. Carry out a BCO run:

Hold down the enabling switch. Then press the Start key and hold it down
until the message “Programmed path reached (BCO)” is displayed in the
message window.

A BCO run is always executed as a PTP motion from the
| /\ WARNING | actual position to the target position. Observe the motion
to avoid collisions. The velocity is automatically reduced during the BCO run.

4. Select “Automatic External” mode.
5. Start the program from a higher-level controller (PLC).

To stop a program that has been started in Automatic mode, press the STOP
key.

6.6 Editing a program

Overview

= A running program cannot be edited.
m  Programs cannot be edited in AUT EXT mode.

e | |faselected program is edited in the user group “Expert”, the cursor
1 must then be removed from the edited line and positioned in any other
line!

Only in this way is it certain that the editing will be applied when the program
is deselected again.
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Action Possible in user group ...?
Insert comment or
stamp User: Yes
Expert: Yes
Delete lines
User: Yes
Expert: Yes
Create folds
User: No
Expert: Yes
Copy
User: No
Expert: Yes
Paste
User: No
Expert: Yes
Insert blank lines
(press the Enter key) User: No
Expert: Yes
Cut
User: No
Expert: Yes
Find
User: Yes
Expert: Yes
Possible for all user groups in an open program,
even in AUT EXT mode.
Replace

User: No

Expert: Yes (program is open, not

selected)
Programming with
inline forms User: Yes
Expert: Yes

KRL programming
User: Possible to a certain extent. KRL

instructions covering several lines (e.g.

LOOP ... ENDLOORP) are not permissible.

Expert: Yes
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6.6.1 Inserting a comment or stamp

Precondition

Procedure

Description
Comment

Description
Stamp

Program is selected or open.
m  Operating mode T1

1. Select the line after which the comment or stamp is to be inserted.
2. Select the menu sequence Commands > Comment > Normal or Stamp.

3. Enter the desired data. If a comment or stamp has already been entered
previously, the inline form still contains the same entries.

In the case of a comment, the box can be cleared using New text
ready for entry of a new text.

In the case of a stamp, the system time can also be updated using
New time and the NAME box can be cleared using New name.

4. Save with Cmd Ok.

; ‘ vacuum off |

Fig. 6-6: Inline form “Comment”

ltem | Description
1 Any text

A stamp is a comment that is extended to include the system date and time
and the user ID.

: 12.8.09 10:26 NAME: | user ,aiMEEs:|new basd

Fig. 6-7: Inline form “Stamp”

ltem | Description
1 System date (cannot be edited)

2 System time
3 Name or ID of the user
4 Any text

6.6.2 Deleting program lines

Precondition

Procedure

m  Program is selected or open.
m  Operating mode T1

1. Select the line to be deleted. (The line need not have a colored back-
ground. It is sufficient for the cursor to be in the line.)

If several consecutive lines are to be deleted: drag a finger or stylus across
the desired area. (The area must now have a colored background.)

2. Select the menu sequence Edit > Delete.
3. Confirm the request for confirmation with Yes.

@ | Lines cannot be restored once they have been deleted!
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e | /faprogram line containing a motion instruction is deleted, the point
1 name and coordinates remain saved in the DAT file. The point can be
used in other motion instructions and does not need to be taught

again.

6.6.3 Additional editing functions

The following additional program editing functions can be called using Edit:
Copy
Precondition:

m  Program is selected or open.
= “Expert” user group
m  Operating mode T1

Paste
Precondition:

m  Program is selected or open.
m  “Expert” user group
m  Operating mode T1

Cut
Precondition:

= Program is selected or open.
m  “Expert” user group
m  Operating mode T1

Find

Precondition:

m  Program is selected or open.
Replace

Precondition:

m  Program has been opened.
m  “Expert” user group
m  Operating mode T1

6.7 Printing a program

Procedure 1. Select the program in the Navigator. Multiple program selection is also
possible.

2. Select the menu sequence Edit > Print.
6.8 Archiving and restoring data

6.8.1 Archiving overview

Target locations Archiving can be performed to the following target destinations:
m  USB stick in KCP or robot controller
= Network

Menu items The following menu items are available:

KUKA
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("*.*" means all files and subdirectories.)

Menu item Archives the directories/files

All KRC:\*.*

C:\KRC\Roboter\Config\User\*.*
C:\KRC\Roboter\Config\System\Common\Mada\*.*
C:\KRC\Roboter\Init\*.*
C:\KRC\Roboter\Ir_Spec\*.*
C:\KRC\Roboter\Template\*.*
C:\KRC\Roboter\Rdc\*.*

C:\KRC\User\*.*

C:\KRC\Roboter\log\Mastery.log

Some additional log data

KRC:\R1\Program\*.*

KRC:\R1\System\*.*

KRC:\R1\cell*.*

KRC:\Steu\$config*.*

KRC:\R1\Mada\*.*

KRC:\R1\System\*.*

KRCARI\TP\*.*

KRC:\Steu\Mada\*.*
C:\KRC\Roboter\Config\User\*.*
C:\KRC\Roboter\Config\System\Common\Mada\*.*
C:\KRC\Roboten\Init\*.*
C:\KRC\Roboter\Ir_Spec\*.*
C:\KRC\Roboter\Template\*.*
C:\KRC\Roboter\Rdc\*.*

C:\KRC\User\*.*

C:\KRC\Roboter\log\*.*

Except: Poslog.xsl and files with the extension DMP
= Some additional log data

KrcDiag If it is necessary for an error to be analyzed by KUKA
Roboter GmbH, this menu item can be used to com-
press the data for sending to KUKA.

Applications

System data

Log data

In addition to the menu sequence File > Archive, there
are other methods available for compressing these
data.

(>>> 6.8.6 "Compressing data for error analysis at
KUKA" Page 148)

If archiving is carried out using the menu item All and there is an existing ar-
chive present, this will be overwritten.

If archiving is carried out using a menu item other than All or KrcDiag and an
archive is already available, the robot controller compares its robot name with
that in the archive. If the names are different, a request for confirmation is gen-
erated.

If archiving is carried out repeatedly via KrcDiag, a maximum of 10 archives
can be created. Further archives will overwrite the oldest existing archive.

The logbook can also be activated. (>>> 6.8.4 "Archiving the logbook"
Page 148)
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6.8.2 Archiving to a USB stick

Description

Procedure

This procedure generates a ZIP file on the stick. By default, this file has the
same name as the robot. A different name can be defined for the file, however,
under Robot data.

(>>> 4.15.11 "Displaying/editing robot data" Page 74)

The archive is displayed in the ARCHIVE:\ directory in the Navigator. Archiving
is also carried out automatically to D:\ as well as to the stick. The file IN-
TERN.ZIP is generated here.

Special case KrcDiag:

This menu item generates the folder KRCDiag on the stick. This contains a
ZIP file. The ZIP file is also automatically archived in C:\KUKA\KRCDiag.

A non-bootable USB stick must be used.
NOTICE Recommendation: Use a non-bootable KUKA stick. Data

may be lost if a stick from a different manufacturer is used.

1. Connect the USB stick (to KCP or cabinet).

2. In the main menu, select File > Archive > USB (KCP) or USB (cabinet)
and then the desired menu item.

3. Confirm the request for confirmation with Yes. The archive is created.
Once the archiving is completed, this is indicated in the message window.

Special case KrcDiag: If archiving is carried out using this menu item, a
separate window indicates when archiving has been completed. The win-
dow is then automatically hidden again.

4. The stick can now be removed.

6.8.3 Archiving on the network

Description

Precondition

Procedure

This procedure generates a ZIP file on the network path. By default, this file
has the same name as the robot. A different name can be defined for the file,
however, under Start-up > Robot data.

The network path to which archiving is to be carried out must be configured in
the Robot data window. If a user name and password are required for ar-
chiving to this path, these can also be entered here.

(>>> 4.15.11 "Displaying/editing robot data" Page 74)

The archive is displayed in the ARCHIVE:\ directory in the Navigator. Archiving
is also carried out automatically to D:\ as well as to the network path. The file
INTERN.ZIP is generated here.

Special case KrcDiag:

This menu item generates the folder KRCDiag on the network path. This con-
tains a ZIP file. The ZIP file is also automatically archived in C:\KUKA\KRCDi-
ag.

m  The network path to which the data are to be archived is configured.

1. In the main menu, select File > Archive > Network and then the desired
menu item.

2. Confirm the request for confirmation with Yes. The archive is created.

Once the archiving is completed, this is indicated in the message window.
Special case KreDiag: If archiving is carried out using this menu item, a
separate window indicates when archiving has been completed. The win-
dow is then automatically hidden again.
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6.8.4 Archiving the logbook

Description The file “Logbuch.txt” is generated as an archive in the directory C:\KRC\RO-
BOTER\LOG.
Procedure ® In the main menu, select File > Archive > Logbook.

The archive is created. Once the archiving is completed, this is indicated
in the message window.

6.8.5 Restoring data

Description

Only KSS 8.2 archives may be loaded into KSS 8.2. If
| /\ WARNING | other archives are loaded, the following may occur:

m  Error messages
= Robot controller is not operable.
m  Personal injury and damage to property.

The following menu items are available for restoring data:
= Al

= Applications

= System data

If the archived files are not the same version as the files present in the system,
an error message is generated during restoration.

Similarly, if the version of the archived technology packages does not match
the installed version, an error message is generated.

Precondition m |f data are to be restored from the USB stick: a USB stick with the archive
is connected.

The stick can be connected to the KCP or robot controller.

A non-bootable USB stick must be used.
NOTICE Recommendation: Use a non-bootable KUKA stick. Data

may be lost if a stick from a different manufacturer is used.

Procedure 1. In the main menu, select File > Restore and then the desired subitems.
2. Confirm the request for confirmation with Yes. Archived files are restored
to the robot controller. A message indicates completion of the restoration
process.

3. If data have been restored from a USB stick: the stick can now be re-
moved.

4. Reboot the robot controller.

6.8.6 Compressing data for error analysis at KUKA

Description If it is necessary for an error to be analyzed by KUKA Roboter GmbH, this pro-
cedure can be used to compress the data for sending to KUKA. The procedure
generates a ZIP file in the directory C:\KUKA\KRCDiag. This contains the data
required by KUKA Roboter GmbH to analyze an error (including information
about system resources, screenshots, and much more.)

Procedure via ® In the main menu, select Diagnosis > KrcDiag.

“Diagnosis” The data are compressed. Progress is displayed in a window. Once the
operation has been completed, this is also indicated in the window. The
window is then automatically hidden again.
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Procedure via This procedure uses keys on the smartPAD instead of menu items. It can thus
smartPAD also be used if the smartHMI is not available, due to Windows problems for ex-
ample.

Precondition:

m  The smartPAD is connected to the robot controller.
m  The robot controller is switched on.

@ | 'hekeys must be pressed within 2 seconds. Whether or not the main
1 menu and keypad are displayed in the smartHMI is irrelevant.

1. Press the “Main menu” key and hold it down.
2. Press the keypad key twice.
3. Release the “Main menu” key.

The data are compressed. Progress is displayed in a window. Once the
operation has been completed, this is also indicated in the window. The
window is then automatically hidden again.

Procedure via Alternatively, the data can also be compressed via File > Archive > [...]. In this
“Archive” way, the data can be stored on a USB stick or network path.

(>>> 6.8 "Archiving and restoring data" Page 145)
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principles of motion programming

7 Basic principles of motion programming

71 Overview of motion types

The following motion types can be programmed:
m  Point-to-point motions (PTP)
(>>> 7.2 "Motion type PTP" Page 151)
m  Linear motions (LIN)
(>>> 7.3 "Motion type LIN" Page 151)
m  Circular motions (CIRC)
(>>> 7.4 "Motion type CIRC" Page 152)
m  Spline motion
(>>> 7.7 "Motion type “Spline™ Page 155)

LIN, CIRC and spline motions are also known as CP (“Continuous Path”) mo-
tions.

The start point of a motion is always the end point of the previous motion.

7.2 Motion type PTP

The robot guides the TCP along the fastest path to the end point. The fastest
path is generally not the shortest path and is thus not a straight line. As the
motions of the robot axes are rotational, curved paths can be executed faster
than straight paths.

The exact path of the motion cannot be predicted.

Fig. 7-1: PTP motion

7.3 Motion type LIN

The robot guides the TCP at a defined velocity along a straight path to the end
point.

KUKA
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Fig. 7-2: LIN motion

7.4 Motion type CIRC

The robot guides the TCP at a defined velocity along a circular path to the end
point. The circular path is defined by a start point, auxiliary point and end point.

Fig. 7-3: CIRC motion

7.5 Approximate positioning

Approximate positioning means that the motion does not stop exactly at the
programmed point. Approximate positioning is an option that can be selected
during motion programming.
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@ | Approximate positioning is not possible if the motion instruction is fol-
1 lowed by an instruction that triggers an advance run stop.

PTP motion

The TCP leaves the path that would lead directly to the end point and moves
along a faster path. During programming of the motion, the maximum distance
from the end point at which the TCP may deviate from its original path is de-
fined.

The path of an approximated PTP motion cannot be predicted. It is also not
possible to predict which side of the approximated point the path will run.

P3
P1

Fig. 7-4: PTP motion, P2 is approximated

LIN motion

The TCP leaves the path that would lead directly to the end point and moves
along a shorter path. During programming of the motion, the maximum dis-
tance from the end point at which the TCP may deviate from its original path
is defined.

The path in the approximate positioning range is not an arc.

P3
P1

Fig. 7-5: LIN motion, P2 is approximated
CIRC motion

The TCP leaves the path that would lead directly to the end point and moves
along a shorter path. During programming of the motion, the maximum dis-
tance from the end point at which the TCP may deviate from its original path
is defined.

The motion always stops exactly at the auxiliary point.

The path in the approximate positioning range is not an arc.
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PSTART

Fig. 7-6: CIRC motion, Pgyp is approximated

7.6 Orientation control LIN, CIRC

Description The orientation of the TCP can be different at the start point and end point of
a motion. There are several different types of transition from the start orienta-
tion to the end orientation. A type must be selected when a CP motion is pro-
grammed.

The orientation control for LIN and CIRC motions is defined as follows:

® In the option window Motion parameter
(>>> 8.2.9 "Option window: Motion parameters (LIN, CIRC)" Page 176)

LIN motion Orientation control Description

Constant orientation The orientation of the TCP remains con-
stant during the motion.

The programmed orientation is disregarded
for the end point and that of the start point
is retained.

Standard The orientation of the TCP changes contin-
uously during the motion.

Note: If, with Standard, the robot passes
through a wrist axis singularity, use Wrist
PTP instead.

Wrist PTP The orientation of the TCP changes contin-
uously during the motion. This is done by
linear transformation (axis-specific motion)
of the wrist axis angles.

Note: Use Wrist PTP if, with Standard, the
robot passes through a wrist axis singular-
ity.

The orientation of the TCP changes contin-
uously during the motion, but not uniformly.
Wrist PTP is thus not suitable if a specific
orientation must be maintained exactly, e.g.
in the case of laser welding.

e | |fawrist axis singularity occurs with Standard and the desired orien-
1 tation cannot be maintained exactly enough with Wrist PTP, the fol-
lowing remedy is recommended:

Re-teach start and/or end point. Select orientations that prevent a wrist axis
singularity from occurring and allow the path to be executed with Standard.

154 / 221 Issued: 20.07.2012 Version: KSS 8.2 END V2 en (PDF



KUKA

Fig. 7-7: Orientation control - Constant

Fig. 7-8: Standard or Wrist PTP

CIRC motion The same orientation control options are available for selection for CIRC mo-
tions as for LIN motions.

During CIRC motions, the robot controller only takes the programmed orienta-
tion of the end point into consideration. The programmed orientation of the
auxiliary point is disregarded.

7.7 Motion type “Spline”

“Spline” is a Cartesian motion type that is suitable for particularly complex,
curved paths. Such paths can generally also be generated using approximat-
ed LIN and CIRC motions, but Spline nonetheless has advantages.

Disadvantages of approximated LIN and CIRC motions:

= The path is defined by means of approximated points that are not located
on the path. The approximate positioning ranges are difficult to predict.
Generating the desired path is complicated and time-consuming.

= In many cases, the velocity may be reduced in a manner that is difficult to
predict, e.g. in the approximate positioning ranges and near points that are
situated close together.

= The path changes if approximate positioning is not possible, e.g. for time
reasons.

= The path changes in accordance with the override setting, velocity or ac-
celeration.
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PO

P&

Fig. 7-9: Curved path with LIN

Advantages of Spline:
m The path is defined by means of points that are located on the path. The
desired path can be generated easily.

®m  The programmed velocity is maintained. There are few cases in which the
velocity is reduced.

(>>> 7.7.1 "Velocity profile for spline motions" Page 157)

®m The path always remains the same, irrespective of the override setting, ve-
locity or acceleration.

= Circles and tight radii are executed with great precision.

PO

Fig. 7-10: Curved path with spline block

A spline motion can consist of several individual motions: spline segments.
These are taught separately. The segments are grouped together to form the
overall motion in a so-called spline block. A spline block is planned and exe-
cuted by the robot controller as a single motion block.

Furthermore, individual SLIN and SCIRC motions are possible (without spline
block).
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Further characteristics of all spline motions:

m If all points are situated on a plane, then the path is also situated in this
plane.

= If all points are situated on a straight line, then the path is also a straight
line.

7.71 Velocity profile for spline motions

The path always remains the same, irrespective of the override setting, veloc-
ity or acceleration. Only dynamic effects can cause deviations at different ve-
locities.

The programmed acceleration is valid not only for the direction along the path,
but also perpendicular to the path. The same applies to the jerk limitation. Ef-
fects include the following:

m In the case of circles, the centrifugal acceleration is taken into consider-
ation. The velocity that can be achieved thus also depends on the pro-
grammed acceleration and the radius of the circle.

®m In the case of curves, the maximum permissible velocity is derived from
the radius of the curve, the acceleration and the jerk limitation.
Reduction of the velocity

In the case of spline motions, the velocity may, under certain circumstances,
fall below the programmed velocity. This occurs particularly in the case of:

m Tight corners

= Major reorientation

m Large motions of the external axes

e | /fthe points are close together, the velocity is not reduced.

1

Reduction of the velocity to 0

This is the case for:

m  Successive points with the same Cartesian coordinates.

m  Successive SLIN and/or SCIRC segments. Cause: inconstant velocity di-
rection.

In the case of SLIN-SCIRC transitions, the velocity is also reduced to 0 if
the straight line is a tangent of the circle, as the circle, unlike the straight
line, is curved.

P1 P2

P3

Fig. 7-11: Exact positioning at P2
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-P1 P..?_ P3

Fig. 7-12: Exact positioning at P2
Exceptions:

®m In the case of successive SLIN segments that result in a straight line and
in which the orientations change uniformly, the velocity is not reduced.

P1 P2 P3

Fig. 7-13: P2 is executed without exact positioning.

®m Inthe case of a SCIRC-SCIRC transition, the velocity is not reduced if both
circles have the same center point and the same radius and if the orienta-
tions change uniformly. (This is difficult to teach, so calculate and program
points.)

o | Circles with the same center point and the same radius are some-
1 times programmed to obtain circles = 360°. A simpler method is to
program a circular angle.

7.7.2 Block selection with spline motions

Spline block A spline block is planned and executed by the robot controller as a single mo-
tion block. Block selection to the spline segments is nonetheless possible. The
BCO run is executed as a LIN motion. This is indicated by means of a mes-
sage that must be acknowledged.

If the second segment in the spline block is an SPL segment, a modified path
is executed in the following cases:

= Block selection to the first segment in the spline block

m  Block selection to the spline block

m  Block selection to a line before the spline block if this does not contain a
motion instruction and if there is no motion instruction before the spline
block

If the Start key is pressed after the BCO run, the modified path is indicated by
means of a message that must be acknowledged.

Example:

1 PTP PO

2 SPLINE

3 SPL P1

4 SPL P2

5 SPL P3

6 SPL P4

7 SCIRC P5, P6
8 SPL P7

9 SLIN P8

10 ENDSPLINE

Line Description
2 Start of the spline block
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Line Description

3...9 | Spline segments

10 End of the spline block

¢+ Px

P3

Fig. 7-14: Example: modified path in the case of block selection to P1

SCIRC In the case of block selection to a SCIRC instruction for which a circular angle
has been programmed, the motion is executed to the end point including the
circular angle, provided that the robot controller knows the start point. If this is
not possible, the motion is executed to the programmed end point. In this case,
a message is generated, indicating that the circular angle is not being taken

into consideration.

Position/type of SCIRC instruction

End point for block selection

SCIRC segment is 1st segment in
the spline block

Circular angle is not taken into con-
sideration

Other SCIRC segments in the
spline block

Circular angle is taken into consid-
eration

Individual SCIRC motions

Circular angle is not taken into con-
sideration

7.7.3 Modifications to spline blocks

Description = Modification of the position of the point:

If a point within a spline block is offset, the path is modified, at most, in the

2 segments before this point and the 2 segments after it.
Small point offsets generally result in small modifications to the path. If,

however, very long segments are followed by very short segments or vice

versa, small modifications can have a very great effect, as the tangents
and curves can change very greatly in such cases.

m Modification of the segment type:

If an SPL segment is changed into an SLIN segment or vice versa, the
path changes in the previous segment and the next segment.

KUKA
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Example 1

PTP PO
SPLINE
SPL P1
SPL P2
SPL P3
SPL P4
SCIRC P5, P6
SPL P7
SLIN P8
ENDSPLINE

P3

Fig. 7-15: Original path

P3 is offset. This causes the path to change in segments P1 - P2, P2 - P3 and
P3 - P4. Segment P4 - P5 is not changed in this case, as it belongs to an
SCIRC and a circular path is thus defined.

P5

PO

P7 P8

Fig. 7-16: Point has been offset

In the original path, the segment type of P2 - P3 is changed from SPL to SLIN.
The path changes in segments P1 - P2, P2 - P3 and P3 - P4.

PTP PO
SPLINE
SPL P1
SPL P2
SLIN P3
SPL P4
SCIRC P5, P6
SPL P7
SLIN P8
ENDSPLINE
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Fig. 7-17: Segment type has been changed

Example 2 .
SPLINE
SPL {X 100,
SPL {X 102,
SPL {X 104,
SPL {X 204,
ENDSPLINE

O, cool
0}
0}
0}

]

P1 P2 P3 P4 P5

. i
v v

L ]

Fig. 7-18: Original path

P3 is offset. This causes the path to change in all the segments illustrated.
Since P2 - P3 and P3 - P4 are very short segments and P1 - P2 and P4 - P5
are long segments, the slight offset causes the path to change greatly.

SPLINE
SPL {X 100,
SPL {X 102,
SPL {X 104,
SPL {X 204,
ENDSPLINE

O, cool
1}
0}
0}

KoK KK

P1 P2 > P4 P5

Fig. 7-19: Point has been offset

Remedy:

m Distribute the points more evenly
®m  Program straight lines (except very short ones) as SLIN segments

7.74 Approximate positioning of spline motions

Approximate positioning between spline motions (individual SLIN and SCIRC
motions and spline blocks) is possible.
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Approximate positioning between spline motions and LIN, CIRC or PTP is not
possible.

Approximation not possible due to time or advance run stop:

If approximation is not possible for reasons of time or due to an advance run
stop, the robot waits at the start of the approximate positioning arc.

®m Inthe case of time reasons: the robot moves again as soon as it has been
possible to plan the next block.

m Inthe case of an advance run stop: the end of the current block is reached
at the start of the approximate positioning arc. This means that the ad-
vance run stop is canceled and the robot controller can plan the next block.
Robot motion is resumed.

In both cases, the robot now moves along the approximate positioning arc. Ap-
proximate positioning is thus technically possible; it is merely delayed.

This response differs from that for LIN, CIRC or PTP motions. If approximate
positioning is not possible for the reasons specified, the motion is executed to
the end point with exact positioning.

No approximate positioning in MSTEP and ISTEP:

In the program run modes MSTEP and ISTEP, the robot stops exactly at the
end point, even in the case of approximated motions.

In the case of approximate positioning from one spline block to another spline
block, the result of this exact positioning is that the path is different in the last
segment of the first block and in the first segment of the second block from the
path in program run mode GO.

In all other segments of both spline blocks, the path is identical in MSTEP,
ISTEP and GO.

7.7.5 Replacing an approximated motion with a spline block

Description

In order to replace conventional approximated motions with spline blocks, the
program must be modified as follows:
m  Replace LIN - LIN with SLIN - SPL - SLIN.
= Replace LIN - CIRC with SLIN - SPL - SCIRC.
Recommendation: Allow the SPL to project a certain way into the original
circle. The SCIRC thus starts later than the original CIRC.

In approximated motions, the corner point is programmed. In the spline block,
the points at the start and end of the approximation are programmed instead.

@ | The approximate positioning arc of the approximated motions varies
1 according to the override. For this reason, when reproducing an ap-
proximated motion, it must be ensured that it is executed with the de-
sired override.

The following approximated motion is to be reproduced:

LIN P1 C_DIS
LIN P2

Spline motion:

SPLINE
SLIN P1A
SPL P1B
SLIN P2

ENDSPLINE

P1A = start of approximation, P1B = end of approximation
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1 PO
tP1A

+ ¢
P1 P1B P2

Fig. 7-20: Approximated motion - spline motion

Ways of determining P1A and P1B:

m Execute the approximated path and save the positions at the desired point
by means of Trigger.

m Calculate the points in the program with KRL.

m The start of the approximation can be determined from the approximate
positioning criterion. Example: If C_DIS is specified as the approximate
positioning criterion, the distance from the start of the approximation to the
corner point corresponds to the value of $APO.CDIS.

The end of the approximation is dependent on the programmed velocity.
The SPL path does not correspond exactly to the approximate positioning arc,
even if P1A and P1B are exactly at the start/end of the approximation. In order

to recreate the exact approximate positioning arc, additional points must be in-
serted into the spline. Generally, one point is sufficient.

The following approximated motion is to be reproduced:

S$APO.CDIS=20
S$VEL.CP=0.5

LIN {z 10} C_DIS
LIN {Y 60}

Spline motion:

SPLINE WITH SVEL.CP=0.5
SLIN {Z 30}

SPL {Y 30, Z 10}

SLIN (Y 60}

ENDSPLINE

The start of the approximate positioning arc has been calculated from the ap-
proximate positioning criterion.

KUKA
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Fig. 7-21: Example: Approximated motion - spline motion 1

The SPL path does not yet correspond exactly to the approximate positioning
arc. For this reason, an additional SPL segment is inserted into the spline.

SPLINE WITH $VEL.CP=0.5
SLIN {Z 30}
SPL {Y 15, Z 15}
SPL {Y 30, z 10}
SLIN {Y 60}
ENDSPLINE

70

60

50

40

30

N

10 + - »

0 10 20 30 40 50 60 70
Fig. 7-22: Example: Approximated motion - spline motion 2

With the additional point, the path now corresponds to the approximate posi-
tioning arc.
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7.7.5.1 SLIN-SPL-SLIN transition

In the case of a SLIN-SPL-SLIN segment sequence, it is usually desirable for
the SPL segment to be located within the smaller angle between the two
straight lines. Depending on the start and end point of the SPL segment, the
path may also move outside this area.

r
(
v

Fig. 7-23: SLIN-SPL-SLIN

The path remains inside if the following conditions are met:

m  The extensions of the two SLIN segments intersect.
m 2/3<alb<3/2

a = distance from start point of the SPL segment to intersection of the SLIN
segments

b = distance from intersection of the SLIN segments to end point of the
SPL segment

7.8 Orientation control SPLINE

Description

The orientation of the TCP can be different at the start point and end point of
a motion. When a CP motion is programmed, it is necessary to select how to
deal with the different orientations.

The orientation control for SLIN and SCIRC motions is defined as follows:
® In the option window Motion parameter
>>> 8.3.2.2 "Option window “Motion parameters” (SLIN)" Page 179)
>>> 8.3.3.2 "Option window “Motion parameters” (SCIRC)" Page 181)

>>> 8.3.4.8 "Option window “Motion parameters” (spline segment)"

(
(
(>>> 8.3.4.3 "Option window “Motion parameters” (spline block)" Page 184)
(
Page 187)
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Orientation control Description

Constant orientation The orientation of the TCP remains con-
stant during the motion.

The orientation of the start point is retained.
The programmed orientation of the end
point is not taken into consideration.

Standard The orientation of the TCP changes contin-
uously during the motion. At the end point,
the TCP has the programmed orientation.

Ignore orientation This option is only available for spline seg-

ments (not for the spline block or for individ-
ual spline motions).

It is used if no specific orientation is
required at a point.

(>>> "Ignore Orientation" Page 166)

Fig. 7-24: Orientation control - Constant

Fig. 7-25: Standard

Ignore Orien- The option Ignore Orientation is used if no specific orientation is required at

tation a point. If this option is selected, the taught or programmed orientation of the
point is ignored. Instead, the robot controller calculates the optimal orientation
for this point on the basis of the orientations of the surrounding points.

Characteristics of Ignore Orientation:

= Inthe program run modes MSTEP and ISTEP, the robot stops with the ori-
entations calculated by the robot controller.

= In the case of a block selection to a point with Ignore Orientation, the ro-
bot adopts the orientation calculated by the robot controller.
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Ignore Orientation is not allowed for the following segments:

The first segment in a spline block
The last segment in a spline block
SCIRC segments with Circle orientation control = path-related

Segments followed by a SCIRC segment with Circle orientation control

= path-related

m  Segments followed by a segment with Orientation control = Constant
orientation

m Inthe case of successive segments with identical Cartesian end points, Ig-

nore Orientation is not allowed for the first and last segments.

The same orientation control options are available for selection for SCIRC mo-
tions as for SLIN motions. It is also possible to define for SCIRC motions
whether the orientation control is to be space-related or path-related.

Orientation control Description

base-related Base-related orientation control during the
circular motion

path-oriented Path-related orientation control during the
circular motion

(>>> 7.8.1 "Combinations of “Orientation control” and “Circle orientation con-
trol™ Page 167)

The option Path-related is not allowed for the following motions:

m  SCIRC segments with the orientation control type Ignore Orientation

m  SCIRC motions preceded by a spline segment with the orientation control
type Ignore Orientation

Orientation of the auxiliary point:

During SCIRC motions with the orientation control type Standard, the robot
controller takes the programmed orientation of the auxiliary point into consid-
eration, but only to a certain extent.

The transition from the start orientation to the end orientation passes through
the programmed orientation of the auxiliary point, i.e. the orientation of the
auxiliary point is accepted at some point during the transition, but not neces-
sarily at the auxiliary point.

Combinations of “Orientation control” and “Circle orientation control”

Fig. 7-26: Constant orientation control + path-related
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Fig. 7-27: Standard + path-related

Fig. 7-28: Constant orientation control + base-related

Fig. 7-29: Standard + base-related
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7.9 Singularities

Overhead

Extended
position

Wrist axes

KUKA robots with 6 degrees of freedom have 3 different singularity positions.

m  Overhead singularity
= Extended position singularity
m  Wrist axis singularity

A singularity position is characterized by the fact that unambiguous reverse
transformation (conversion of Cartesian coordinates to axis-specific values) is
not possible, even though Status and Turn are specified. In this case, or if very
slight Cartesian changes cause very large changes to the axis angles, one
speaks of singularity positions.

In the overhead singularity, the wrist root point (intersection of axes A4, A5 and
AB) is located vertically above axis 1.

The position of axis A1 cannot be determined unambiguously by means of re-
verse transformation and can thus take any value.

If the end point of a PTP motion is situated in this overhead singularity position,
the robot controller may react as follows by means of the system variable
$SINGUL_POS[1]:

m 0: The angle for axis A1 is defined as 0 degrees (default setting).

®m 1: The angle for axis A1 remains the same from the start point to the end
point.

In the extended position singularity, the wrist root point (intersection of axes
A4, A5 and A6) is located in the extension of axes A2 and A3 of the robot.

The robot is at the limit of its work envelope.

Although reverse transformation does provide unambiguous axis angles, low
Cartesian velocities result in high axis velocities for axes A2 and A3.

If the end point of a PTP motion is situated in this extended position singularity,
the robot controller may react as follows by means of the system variable
$SINGUL_POS[2]:

m 0: The angle for axis A2 is defined as 0 degrees (default setting).

®m 1: The angle for axis A2 remains the same from the start point to the end
point.

In the wrist axis singularity position, the axes A4 and A6 are parallel to one an-
other and axis A5 is within the range +0.01812°.

The position of the two axes cannot be determined unambiguously by reverse
transformation. There is an infinite number of possible axis positions for axes
A4 and A6 with identical axis angle sums.

If the end point of a PTP motion is situated in this wrist axis singularity, the ro-
bot controller may react as follows by means of the system variable
$SINGUL_POSI[3]:

|
0: The angle for axis A4 is defined as 0 degrees (default setting).

1: The angle for axis A4 remains the same from the start point to the
end point.

@ | Inthe case of SCARA robots, only the extended position singularity
1 can arise. In this case, the robot starts to move extremely fast.
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8 Programming for user group “User” (inline forms

8 Programming for user group “User” (inline forms)

Inline forms are available in the KSS for frequently used instructions. They
simplify programming.

@ | Instructions can also be programmed without inline forms. The KRL
1 programming language (KUKA Robot Language) is used for this. In-
formation is contained in the Operating and Programming Instruc-
tions for System Integrators.

NOTICE In the case of programs with the following axis motions

or positions, the film of lubricant on the gear units of the
axes may break down:

= Motions <3°
m  Oscillating motions
m Areas of gear units permanently facing upwards

It must be ensured that the gear units have a sufficient supply of oil. For this,
in the case of oscillating motions or short motions (<3°), programming must
be carried out in such a way that the affected axes regularly move more than
40° (e.g. once per cycle).

In the case of areas of gear units permanently facing upwards, sufficient oil
supply must be achieved by programming re-orientations of the in-line wrist.
In this way, the oil can reach all areas of the gear units by means of gravity.
Required frequency of re-orientations:

= With low loads (gear unit temperature <+35 °C): daily

= With medium loads (gear unit temperature +35 °C to 55 °C): hourly

= With heavy loads (gear unit temperature >+55 °C): every 10 minutes
Failure to observe this precaution may result in damage to the gear units.

8.1 Names in inline forms

Names for data sets can be entered in inline forms. These include, for exam-
ple, point names, names for motion data sets, etc.

The following restrictions apply to names:

= Maximum length 23 characters

= No special characters are permissible, with the exception of $.
m The first character must not be a number.

The restrictions do not apply to output names.

Other restrictions may apply in the case of inline forms in technology packag-
es.

8.2 Programming PTP, LIN and CIRC motions

8.21 Programming a PTP motion

Precondition

NOTICE When programming motions, it must be ensured that the

energy supply system is not wound up or damaged dur-

ing program execution.

m A program is selected.
m  Operating mode T1
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Procedure 1. Move the TCP to the position that is to be taught as the end point.
2. Position the cursor in the line after which the motion instruction is to be in-
serted.

3. Select the menu sequence Commands > Motion > PTP.
4. Set the parameters in the inline form.

(>>> 8.2.2 "Inline form “PTP™ Page 172)
5. Save instruction with Cmd Ok.

8.2.2 Inline form “PTP”

o @ @ 9P

| PP _‘m CONT | Vel= ‘ 100 % |PDAT1 | ]

Fig. 8-1: Inline form for PTP motions

Iltem | Description
1 Motion type PTP
2 Name of the end point

The system automatically generates a name. The name can be
overwritten.

(>>> 8.1 "Names in inline forms" Page 171)

Touch the arrow to edit the point data. The corresponding option
window is opened.

(>>> 8.2.7 "Option window “Frames™ Page 175)

3 m  CONT: end point is approximated.

= [Empty box]: the motion stops exactly at the end point.

4 Velocity
= 1...100%
5 Name for the motion data set

The system automatically generates a name. The name can be
overwritten.

Touch the arrow to edit the point data. The corresponding option
window is opened.

(>>> 8.2.8 "Option window: Motion parameters (PTP)" Page 175)

8.2.3 Programming a LIN motion

NOTICE When programming m(_)tlons, it must be ensured that the

energy supply system is not wound up or damaged dur-
ing program execution.

A program is selected.
m  Operating mode T1

Precondition

Procedure 1. Move the TCP to the position that is to be taught as the end point.
2. Position the cursor in the line after which the motion instruction is to be in-
serted.

3. Select the menu sequence Commands > Motion > LIN.
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4. Set the parameters in the inline form.
(>>> 8.2.4 "Inline form “LIN™" Page 173)
5. Save instruction with Cmd Ok.

8.2.4 Inline form “LIN”

S G S A ¢

T w -
‘LII\ 1 b:l‘ CONT Vel=‘2.00‘m!s cPDATL | P> ]

Fig. 8-2: Inline form for LIN motions

ltem | Description

1 Motion type LIN

2 Name of the end point

The system automatically generates a name. The name can be
overwritten.

(>>> 8.1 "Names in inline forms" Page 171)

Touch the arrow to edit the point data. The corresponding option
window is opened.

(>>> 8.2.7 "Option window “Frames™ Page 175)

3 m  CONT: end point is approximated.
= [Empty box]: the motion stops exactly at the end point.

4 Velocity
= 0.001...2m/s
5 Name for the motion data set

The system automatically generates a name. The name can be
overwritten.

Touch the arrow to edit the point data. The corresponding option
window is opened.

(>>> 8.2.9 "Option window: Motion parameters (LIN, CIRC)"
Page 176)

8.2.5 Programming a CIRC motion

NOTICE When programming motions, it must be ensured that the

energy supply system is not wound up or damaged dur-
ing program execution.

Precondition m A program is selected.
m  Operating mode T1

Procedure 1. Move the TCP to the position that is to be taught as the auxiliary point.

2. Position the cursor in the line after which the motion instruction is to be in-

serted.
3. Select the menu sequence Commands > Motion > CIRC.
4. Set the parameters in the inline form.

(>>> 8.2.6 "Inline form “CIRC™ Page 174)
5. Press Teach Aux.
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6. Move the TCP to the position that is to be taught as the end point.
7. Save instruction with Cmd Ok.

8.2.6 Inline form “CIRC”

@E?@C?@

J—\L E|| CONT Vei=‘ Z.GO‘m,-’s CPDAT1 b:ll

Fig. 8-3: Inline form for CIRC motions

Iltem | Description
1 Motion type CIRC
2 Name of the auxiliary point

The system automatically generates a name. The name can be
overwritten.

(>>> 8.1 "Names in inline forms" Page 171)
3 Name of the end point

The system automatically generates a name. The name can be
overwritten.

Touch the arrow to edit the point data. The corresponding option
window is opened.

(>>> 8.2.7 "Option window “Frames”™ Page 175)

4 m  CONT: end point is approximated.

= [Empty box]: the motion stops exactly at the end point.

5 Velocity
= 0.001...2m/s
6 Name for the motion data set

The system automatically generates a name. The name can be
overwritten.

Touch the arrow to edit the point data. The corresponding option
window is opened.

(>>> 8.2.9 "Option window: Motion parameters (LIN, CIRC)"
Page 176)
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8.2.7 Option window “Frames”

Tool Base

®_|[TOOL_DATA[1] ‘ - ‘

_J;)

BASE_DATA[1]

External TCP Collision detection

D - | e - —®

‘ Frames ‘

Fig. 8-4: Option window: Frames

Iltem | Description
1 Tool selection.

If True in the box External TCP: workpiece selection.

Range of values: [1] ... [16]
2 Base selection.

If True in the box External TCP: fixed tool selection.

Range of values: [1] ... [32]
3 Interpolation mode

m False: The tool is mounted on the mounting flange.
m  True: The tool is a fixed tool.

4 = True: For this motion, the robot controller calculates the axis
torques. These are required for collision detection.

m False: For this motion, the robot controller does not calculate
the axis torques. Collision detection is thus not possible for this
motion.

8.2.8 Option window: Motion parameters (PTP)

Acceleration [%] Approximation distance [mm]

®__i - ‘ hoo|| <= \ - H 100 <4 ‘l (:)

Motion parameter

Fig. 8-5: Option window: Motion parameters (PTP)
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ltem Description
1 Acceleration

Refers to the maximum value specified in the machine data. The
maximum value depends on the robot type and the selected oper-
ating mode.

= 1..100%

2 This box is only displayed if it is specified in the inline form that the
point is to be approximated.

Furthest distance before the end point at which approximate posi-
tioning can begin.

Maximum distance 100%: half the distance between the start
point and the end point relative to the contour of the PTP motion
without approximate positioning

= 1..100%

8.2.9 Option window: Motion parameters (LIN, CIRC)

’ Acceleration [9%] Approximation distance [mm]

OB e - ©

Orientation control

@__

Standard v ‘

‘ Motion parameter

Fig. 8-6: Option window: Motion parameters (LIN, CIRC)

Iltem | Description
1 Acceleration

Refers to the maximum value specified in the machine data. The
maximum value depends on the robot type and the selected oper-
ating mode.

2 This box is only displayed if it is specified in the inline form that the
point is to be approximated.

Furthest distance before the end point at which approximate posi-
tioning can begin

The maximum permissible value is half the distance between the
start point and the end point. If a higher value is entered, this is
ignored and the maximum value is used.

3 Orientation control selection.

Standard
Wrist PTP
Constant orientation control

>>> 7.6 "Orientation control LIN, CIRC" Page 154)

(
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8.3.1

8 Programming for user group “User” (inline forms

Spline motions

Programming tips for spline motions

A spline block should cover only 1 process (e.g. 1 adhesive seam). More
than one process in a spline block leads to a loss of structural clarity within
the program and makes changes more difficult.

Use SLIN and SCIRC segments in cases where the workpiece necessi-
tates straight lines and arcs. (Exception: use SPL segments for very short
straight lines.) Otherwise, use SPL segments, particularly if the points are
close together.

Procedure for defining the path:

a. Firstteach or calculate a few characteristic points. Example: points at
which the curve changes direction.

b. Test the path. At points where the accuracy is still insufficient, add
more SPL points.

Avoid successive SLIN and/or SCIRC segments, as this often reduces the

velocity to 0.

Program SPL segments between SLIN and SCIRC segments. The length
of the SPL segments must be at least > 0.5 mm. Depending on the actual
path, significantly larger SPL segments may be required.

Avoid successive points with identical Cartesian coordinates, as this re-
duces the velocity to 0.

The parameters (tool, base, velocity, etc.) assigned to the spline block
have the same effect as assignments before the spline block. The assign-
ment to the spline block has the advantage, however, that the correct pa-
rameters are read in the case of a block selection.

Use the option Ignore Orientation if no specific orientation is required at
a point. The robot controller calculates the optimal orientation for this point
on the basis of the orientations of the surrounding points. This way, even
large changes in orientation between two points are optimally distributed
over the points in between.

Jerk limitation can be programmed. The jerk is the change in acceleration.
Procedure:

a. Use the default values initially.
b. If vibrations occur at tight corners: reduce values.

If the velocity drops or the desired velocity cannot be reached: in-
crease values or increase acceleration.

If the robot executes points on a work surface, a collision with the work sur-
face is possible when the first point is addressed.

SPL SLIN

Fig. 8-7: Collision with work surface

In order to avoid a collision, observe the recommendations for the SLIN-
SPL-SLIN transition.

(>>> 7.7.5.1 "SLIN-SPL-SLIN transition" Page 165)
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(SLIN)
\__ SPL SLIN

ﬁ

Fig. 8-8: Avoiding a collision with the work surface

8.3.2 Programming a SLIN motion (individual motion)

NOTICE When programming motions, it must be ensured that the

energy supply system is not wound up or damaged dur-
ing program execution.

Precondition A program is selected.

m  Operating mode T1

Procedure 1. Move the TCP to the end point.
2. Position the cursor in the line after which the motion is to be inserted.

(But not within a spline block. This opens another inline form.)
(>>> 8.3.4.6 "Inline form for spline segment" Page 186)

3. Select Commands > Motion > SLIN.
4. Set the parameters in the inline form.

(>>> 8.3.2.1 "Inline form “SLIN™" Page 178)
5. Press Cmd OK.

8.3.2.1 Inline form “SLIN”

7
S W

Fig. 8-9: Inline form “SLIN” (individual motion)

Item Description
1 Motion type SLIN

2 Point name for end point. The system automatically generates a
name. The name can be overwritten.

(>>> 8.1 "Names in inline forms" Page 171)

Touch the arrow to edit the point data. The corresponding option
window is opened.

(>>> 8.2.7 "Option window “Frames™ Page 175)

3 = CONT: end point is approximated.

= [Empty box]: the motion stops exactly at the end point.
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ltem Description
4 Velocity
= 0.001...2m/s
5 Name for the motion data set. The system automatically gener-

ates a name. The name can be overwritten.

Touch the arrow to edit the point data. The corresponding option
window is opened.

(>>> 8.3.2.2 "Option window “Motion parameters” (SLIN)"
Page 179)

8.3.2.2 Option window “Motion parameters” (SLIN)

CP acceleration [9%] Jerk limitation [%%]

| |
O—l- S b @

Approximation distance [mm]  Axis velocity [%]
O el e O

Axis acceleration [%] Orientation control

| _—
®__ - 00| 4 Default __©

Motion parameters ‘

Fig. 8-10: Option window “Motion parameters” (SLIN)

Iltem

Description

1

Path acceleration. The value refers to the maximum value speci-
fied in the machine data.

= 1...100%

Jerk limitation. The jerk is the change in acceleration.

The value refers to the maximum value specified in the machine
data.

= 1...100%

This box is only displayed if CONT was selected in the inline form.
Furthest distance before the end point at which approximate posi-
tioning can begin.

The maximum permissible value is half the distance between the
start point and the end point. If a higher value is entered, this is
ignored and the maximum value is used.

Axis velocity. The value refers to the maximum value specified in
the machine data.

= 1...100%

Axis acceleration. The value refers to the maximum value speci-
fied in the machine data.

= 1...100%

Orientation control selection.
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8.3.3 Programming a SCIRC motion (individual motion)

NOTICE When programming mgtlons, it must be ensured that the

ing program execution.

energy supply system is not wound up or damaged dur-

Precondition

Procedure

A program is selected.
Operating mode T1

Move the TCP to the auxiliary point.
Position the cursor in the line after which the motion is to be inserted.

(But not within a spline block. This opens another inline form.)
(>>> 8.3.4.6 "Inline form for spline segment" Page 186)

Select the menu sequence Commands > Motion > SCIRC.
Set the parameters in the inline form.

(>>> 8.3.3.1 "Inline form “SCIRC"" Page 180)

Press Teach Aux.

Move the TCP to the end point.

Press Cmd OK.

8.3.3.1 Inline form “SCIRC”

(?2 SULIP L

SCIRCHPI P2 :I CONT | Vel=| 2.00|m/s | CPDAT2 >

5

Fig.

8-11: Inline form “SCIRC” (individual motion)

ltem Description

1

Motion type SCIRC

2

Point names for auxiliary and end point. The system automatically
assigns names. The names can be overwritten.

(>>> 8.1 "Names in inline forms" Page 171)

Touch the arrow to edit the point data. The corresponding option
window is opened.

(>>> 8.2.7 "Option window “Frames™ Page 175)

m  CONT: end point is approximated.
= [Empty box]: the motion stops exactly at the end point.

Velocity
= 0.001...2m/s
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Item

Description

Name for the motion data set. The system automatically gener-
ates a name. The name can be overwritten.

Touch the arrow to edit the point data. The corresponding option
window is opened.

(>>> 8.3.3.2 "Option window “Motion parameters” (SCIRC)"
Page 181)

Specifies the overall angle of the circular motion. This makes it
possible to extend the motion beyond the programmed end point
or to shorten it. The actual end point thus no longer corresponds
to the programmed end point.

m Positive circular angle: the circular path is executed in the di-
rection Start point » Auxiliary point > End point.

m Negative circular angle: the circular path is executed in the di-
rection Start point » End point » Auxiliary point.

= -9,999° ... +9,999°
If a circular angle less than -400° or greater than +400° is entered,

a request for confirmation is generated when the inline form is
saved asking whether entry is to be confirmed or rejected.

8.3.3.2 Option window “Motion parameters” (SCIRC)

CP acceleration [%] Jerk limitation [%]

- 100 - 50 |
O— + | |y =0

Approximation distance [mm]  Axis velocity [%]

®_
®_

_|| - mo‘ e ‘ 5 ‘ mo‘ +—)

Axis acceleration [%] Orientation control

— 100 _Default v|—©

Circle orientation control

@—{ base-related x ‘

Motion parameters I Circle configuration

Fig. 8-12: Option window “Motion parameters” (SCIRC)

Iltem

Description

1

Path acceleration. The value refers to the maximum value speci-
fied in the machine data.

= 1...100%

Jerk limitation. The jerk is the change in acceleration.

The value refers to the maximum value specified in the machine
data.

= 1...100%
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ltem Description

3 Furthest distance before the end point at which approximate posi-
tioning can begin.

The maximum permissible value is half the distance between the
start point and the end point. If a higher value is entered, this is
ignored and the maximum value is used.

This box is only displayed if CONT was selected in the inline form.

4 Axis velocity. The value refers to the maximum value specified in
the machine data.
= 1...100%

5 Axis acceleration. The value refers to the maximum value speci-
fied in the machine data.
B 1...100%

6 Orientation control selection

7 Orientation control reference system selection.

8 Circular parameters are displayed on this tab. The parameters

cannot be changed.

8.34 Programming a spline block

Description A spline block can be used to group together several SPL, SLIN and/or SCIRC
segments to an overall motion. A spline block that contains no segments is not
a motion statement.

A spline block may contain the following:

Spline segments (only limited by the memory capacity.)
PATH trigger
Comments and blank lines

Inline commands from technology packages that support the spline func-
tionality

A spline block must not include any other instructions, e.g. variable assign-
ments or logic statements. A spline block does not trigger an advance run
stop.

Precondition

A program is selected.
m  Operating mode T1

Procedure 1. Position the cursor in the line after which the spline block is to be inserted.
2. Select the menu sequence Commands > Motion > SPLINE block.
3. Set the parameters in the inline form.
(>>> 8.3.4.1 "Inline form for spline block" Page 183)
4. Press Cmd OK.

5. Press Open/close fold. Spline segments and other lines can now be in-
serted into the spline block.

(>>> 8.3.4.4 "Programming an SPL or SLIN segment" Page 185)
(>>> 8.3.4.5 "Programming an SCIRC segment" Page 185)
(>>> 8.3.4.9 "Programming triggers in the spline block" Page 188)
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8.3.4.1 Inline form for spline block

? PP ?

CIT | | v
SPLINE | S1 E‘FONT& Vel=

2.00 |m/s | cPoaT1 [ 2]

Fig. 8-13:

Inline form for spline block

Item

Description

1

Name of the spline block. The system automatically generates a
name. The name can be overwritten.

(>>> 8.1 "Names in inline forms" Page 171)

Position the cursor in this box to edit the motion data. The corre-
sponding option window is opened.

(>>> 8.3.4.2 "Option window “Frames” (spline block)" Page 183)

m  CONT: end point is approximated.
= [Empty box]: the motion stops exactly at the end point.

The velocity is valid by default for the entire spline block. It can
also be defined separately for individual segments.

= 0.001..2m/s

Name for the motion data set. The system automatically gener-
ates a name. The name can be overwritten.

Position the cursor in this box to edit the motion data. The corre-
sponding option window is opened.

(>>> 8.3.4.3 "Option window “Motion parameters” (spline block)"
Page 184)

The motion data are valid by default for the entire spline block.
They can also be defined separately for individual segments.

8.3.4.2 Option window “Frames” (spline block)

Tool Base

@i—{TOOL_DATA[ 1] - 1

NULLFRAME - —@

External TCP

ot

|

Frames

Fig. 8-14: Option window “Frames” (spline block)
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ltem | Description
1 Tool selection.

If True in the box External TCP: workpiece selection.

= [1]...[16]
2 Base selection.

If True in the box External TCP: fixed tool selection.

= [1]...[32]
3 Interpolation mode

m  False: The tool is mounted on the mounting flange.
m  True: The tool is a fixed tool.

8.3.4.3 Option window “Motion parameters” (spline block)

CP acceleration [%0]  Jerk limitation
00 &+

BUUEILEEEEERRERRE A E AR FFEEETTL 11

Approximation distance [mm]  Axis velocity [%]

. 100/ o

ETTTTrET FTFFTPET TP e T A

Axis acceleration [%] Onentation control

(@——E w00f & |Defaut

BenBRERE i i EnRaRnEE

Circle orientation control

®_/[ base-related

Fig. 8-15: Option window “Motion parameters” (spline block)

Motion parameters

ltem Description

1 Path acceleration. The value refers to the maximum value speci-
fied in the machine data.

= 1...100%
2 Jerk limitation. The jerk is the change in acceleration.

The value refers to the maximum value specified in the machine
data.

m 1...100%
3 This box is only displayed if CONT was selected in the inline form.

Furthest distance before the end point at which approximate posi-
tioning can begin.

The maximum distance is that of the last segment in the spline. If
there is only one segment present, the maximum distance is half
the segment length. If a higher value is entered, this is ignored
and the maximum value is used.

4 Axis velocity. The value refers to the maximum value specified in
the machine data.

= 1...100%

184 / 221 Issued: 20.07.2012 Version: KSS 8.2 END V2 en (PDF



8 Programming for user group “User” (inline forms

ltem Description

Axis acceleration. The value refers to the maximum value speci-
fied in the machine data.

= 1...100%

Orientation control selection.

Orientation control reference system selection.

This parameter only affects SCIRC segments (if present) in the
spline block.

8.3.4.4 Programming an SPL or SLIN segment

Precondition

Procedure

NOTICE When programming motions, it must be ensured that the

energy supply system is not wound up or damaged dur-

ing program execution.

A program is selected.
Operating mode T1
The spline block fold is open.

Move the TCP to the end point.

Position the cursor in the line after which the segment is to be inserted in
the spline block.

Select the menu sequence Commands > Motion > SPL or SLIN.
Set the parameters in the inline form.

(>>> 8.3.4.6 "Inline form for spline segment" Page 186)

Press Cmd OK.

8.3.4.5 Programming an SCIRC segment

Precondition

Procedure

NOTICE When programming motions, it must be ensured that the

energy supply system is not wound up or damaged dur-

ing program execution.

A program is selected.
Operating mode T1
The spline block fold is open.

Move the TCP to the auxiliary point.

Position the cursor in the line after which the segment is to be inserted in
the spline block.

Select the menu sequence Commands > Motion > SCIRC.
Set the parameters in the inline form.

(>>> 8.3.4.6 "Inline form for spline segment" Page 186)
Press Teach Aux.

Move the TCP to the end point.

Press Cmd OK.
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8.3.4.6 Inline form for spline segment

FCEL FIT p2 E Vel= E.DEI mfs | CPDAT2 E‘ FNGLE‘=‘EID.DCI

Fig. 8-16: Inline form for spline segment

a

The boxes in the inline form can be displayed or hidden one by one with Tog-
gle parameters.

ltem Description

1 Motion type
= SPL
= SLIN
= SCIRC
2 Point name for end point. Only for SCIRC: point names for auxil-

iary point and end point.

The system automatically generates a name. The name can be
overwritten.

(>>> 8.1 "Names in inline forms" Page 171)

Touch the arrow to edit the point data. The corresponding option
window is opened.

(>>> 8.3.4.7 "Option window “Frames” (spline segment)"
Page 187)

3 Velocity

This only refers to the segment to which it belongs. It has no effect
on subsequent segments.

= 0.001...2m/s

4 Name for the motion data set. The system automatically gener-
ates a name. The name can be overwritten.

Touch the arrow to edit the point data. The corresponding option
window is opened.

(>>> 8.3.4.8 "Option window “Motion parameters” (spline seg-
ment)" Page 187)

The motion data only refer to the segment to which they belong.
They have no effect on subsequent segments.

5 Only available if the motion type SCIRC has been selected.

Specifies the overall angle of the circular motion. This makes it
possible to extend the motion beyond the programmed end point
or to shorten it. The actual end point thus no longer corresponds
to the programmed end point.

m Positive circular angle: the circular path is executed in the di-
rection Start point » Auxiliary point > End point.

= Negative circular angle: the circular path is executed in the di-
rection Start point » End point » Auxiliary point.

= -9,999° ... +9,999°
If a circular angle less than -400° or greater than +400° is entered,

a request for confirmation is generated when the inline form is
saved asking whether entry is to be confirmed or rejected.
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8.3.4.7 Option window “Frames” (spline segment)

Collision detection

®__

False ‘ - ‘

Frames

Fig. 8-17: Option window “Frames” (spline segment)

ltem Description

1 m  True: For this motion, the robot controller calculates the axis
torques. These are required for collision detection.

= False: For this motion, the robot controller does not calculate
the axis torques. Collision detection is thus not possible for this
motion.

8.3.4.8 Option window “Motion parameters” (spline segment)

CP acceleration [%] Jerk limitation [%%]
@ | - 100‘ e - 50 H ol | -2
Axis velocity [%] Axis acceleration %]
@——i - ‘ 100 (N - 100 4 ——@
Orientation control Circle orientation control
©—— Default ‘ - ‘ base-related - i——®
‘ Motion parameters | Circle configuration @

Fig. 8-18: Option window “Motion parameters” (spline segment)

ltem Description

1 Path acceleration. The value refers to the maximum value speci-
fied in the machine data.

= 1...100 %
2 Jerk limitation. The jerk is the change in acceleration.

The value refers to the maximum value specified in the machine
data.

= 1..100%

3 Axis velocity. The value refers to the maximum value specified in
the machine data.

= 1..100%
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ltem Description

4 Axis acceleration. The value refers to the maximum value speci-
fied in the machine data.
B 1..100%

5 Orientation control selection

6 Only in the case of SCIRC segments: Orientation control refer-
ence system selection.

7 Only in the case of SCIRC segments: Circular parameters are dis-
played on this tab. The parameters cannot be changed.

8.3.4.9 Programming triggers in the spline block

Precondition A program is selected.
m  Operating mode T1

m  The spline block fold is open.

Procedure 1. Position the cursor in the line after which the trigger is to be inserted in the
spline block.

2. Select the menu sequence Commands > Logic > Spline trigger.

3. The inline form Set output is displayed by default. A different inline form
can be displayed by pressing the Toggle type button.

4. Set the parameters in the inline form.
5. Press Cmd OK.

Description The specific inline form that is displayed depends on which type has been se-
lected using Toggle type.

Inline form type Description
Set output The trigger sets an output.

(>>> 8.3.4.10 "Inline form for spline trigger type
“Set output™ Page 189)
Set pulse output The trigger sets a pulse of a defined length.

(>>> 8.3.4.11 "Inline form for spline trigger type
“Set pulse output™ Page 190)

Trigger assignment The trigger assigns a value to a variable. Only
available in the user group “Expert”.

(>>> 8.3.4.12 "Inline form for spline trigger type
“Trigger assignment™ Page 191)

Trigger function call | The trigger calls a subprogram. Only available in
the user group “Expert”.

(>>> 8.3.4.13 "Inline form for spline trigger type
“Trigger function call™ Page 191)

@ | Further information on triggers, on offsetting the switching point and
l on the offset limits can be found in the Operating and Programming
Instructions for System Integrators.
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8.3.4.10 Inline form for spline trigger type “Set output”

¥ T

TRIGGER WHEN PA'I'I-I=\I\mm ONSTART DELAY= 0\ms DO

TRLJE

<5 5

Fig. 8-19: Inline form for spline trigger type Set output

Item Description
1 If the statement is to be shifted in space, the desired distance from
the start or end point must be specified here. If no shift in space is
desired, enter the value 0.
= Positive value: shifts the statement towards the end of the mo-
tion.
= Negative value: shifts the statement towards the start of the
motion.
Only for the user group “Expert”: Toggle path makes it possible to
enter a variable, constant or function in this box. The functions are
subject to constraints.
(>>> 8.3.4.14 "Limits for functions in the spline trigger" Page 192)
2 Toggle OnStart can be used to set or cancel the parameter
ONSTART.
= Without ONSTART: the PATH value refers to the end point.
= With ONSTART: the PATH value refers to the start point.
3 If the statement is to be shifted in time (relative to the value in item
1), the desired duration must be specified here. If no shift in time
is desired, enter the value 0.
m Positive value: shifts the statement towards the end of the mo-
tion. Maximum: 1,000 ms
= Negative value: shifts the statement towards the start of the
motion.
Only for the user group “Expert”: Toggle Delay makes it possible
to enter a variable, constant or function in this box. The functions
are subject to constraints.
(>>> 8.3.4.14 "Limits for functions in the spline trigger" Page 192)
4 Output number
= 1...4096
5 State to which the output is switched
= TRUE
= FALSE
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8.3.4.11 Inline form for spline trigger type “Set pulse output”

TRIGGER WHEN PA'I'I-I=\I\mm ONSTART DELAY= 0\ms DO

B s
© ® ©

Fig. 8-20: Inline form for spline trigger type Set pulse output

Item Description

1 If the statement is to be shifted in space, the desired distance from
the start or end point must be specified here. If no shift in space is
desired, enter the value 0.

m Positive value: shifts the statement towards the end of the mo-
tion.

= Negative value: shifts the statement towards the start of the
motion.

Only for the user group “Expert”: Toggle path makes it possible to
enter a variable, constant or function in this box. The functions are
subject to constraints.

(>>> 8.3.4.14 "Limits for functions in the spline trigger" Page 192)
2 Toggle OnStart can be used to set or cancel the parameter
ONSTART.

= Without ONSTART: the PATH value refers to the end point.

= With ONSTART: the PATH value refers to the start point.

3 If the statement is to be shifted in time (relative to the value in item
1), the desired duration must be specified here. If no shift in time
is desired, enter the value 0.

m Positive value: shifts the statement towards the end of the mo-
tion. Maximum: 1,000 ms

= Negative value: shifts the statement towards the start of the
motion.

Only for the user group “Expert”: Toggle Delay makes it possible
to enter a variable, constant or function in this box. The functions
are subject to constraints.

(>>> 8.3.4.14 "Limits for functions in the spline trigger" Page 192)

4 Output number
= 1...4096
5 State to which the output is switched

=  TRUE: “High” level
=  FALSE: “Low” level
6 Length of the pulse

= 0.10...3.00s
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8.3.4.12 Inline form for spline trigger type “Trigger assignment”

TRIGGER WHEN PATH= 0 [ mm OEART DELAY= 0|ms DO |i[3] =77

Fig. 8-21: Inline form for spline trigger type Trigger assignment

Iltem

Description

1

If the statement is to be shifted in space, the desired distance from
the start or end point must be specified here. If no shift in space is
desired, enter the value 0.

= Positive value: shifts the statement towards the end of the mo-
tion.

= Negative value: shifts the statement towards the start of the
motion.

Only for the user group “Expert”: Toggle path makes it possible to
enter a variable, constant or function in this box. The functions are
subject to constraints.

(>>> 8.3.4.14 "Limits for functions in the spline trigger" Page 192)

Toggle OnStart can be used to set or cancel the parameter
ONSTART.

= Without ONSTART: the PATH value refers to the end point.
= With ONSTART: the PATH value refers to the start point.

If the statement is to be shifted in time (relative to the value in item
1), the desired duration must be specified here. If no shift in time
is desired, enter the value 0.

m Positive value: shifts the statement towards the end of the mo-
tion. Maximum: 1,000 ms

= Negative value: shifts the statement towards the start of the
motion.

Only for the user group “Expert”: Toggle Delay makes it possible
to enter a variable, constant or function in this box. The functions
are subject to constraints.

(>>> 8.3.4.14 "Limits for functions in the spline trigger" Page 192)

Variable to which a value is to be assigned

Note: Runtime variables cannot be used.

Value to be assigned to the variable

8.3.4.13 Inline form for spline trigger type “Trigger function call”

N ¢

TRIGGER WHEN PATH= 0 (mm ONSTART DELAY= 0 |ms DOJDr[)I PRIO= —lL

Fig. 8-22: Inline form for spline trigger type Trigger function call
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ltem Description

1 If the statement is to be shifted in space, the desired distance from
the start or end point must be specified here. If no shift in space is
desired, enter the value 0.

m  Positive value: shifts the statement towards the end of the mo-
tion.

= Negative value: shifts the statement towards the start of the
motion.

Only for the user group “Expert”: Toggle path makes it possible to
enter a variable, constant or function in this box. The functions are
subject to constraints.

(>>> 8.3.4.14 "Limits for functions in the spline trigger" Page 192)
2 Toggle OnStart can be used to set or cancel the parameter
ONSTART.

= Without ONSTART: the PATH value refers to the end point.

= With ONSTART: the PATH value refers to the start point.

3 If the statement is to be shifted in time (relative to the value in item
1), the desired duration must be specified here. If no shift in time
is desired, enter the value 0.

= Positive value: shifts the statement towards the end of the mo-
tion. Maximum: 1,000 ms

= Negative value: shifts the statement towards the start of the
motion.

Only for the user group “Expert”: Toggle Delay makes it possible
to enter a variable, constant or function in this box. The functions
are subject to constraints.

(>>> 8.3.4.14 "Limits for functions in the spline trigger" Page 192)
4 Name of the subprogram to be called

5 A priority must be entered in the PRIO box. Priorities 1, 2, 4 to 39
and 81 to 128 are available. Priorities 3 and 40 to 80 are reserved
for cases in which the priority is automatically assigned by the
system. If the priority is to be assigned automatically by the sys-
tem, the following is programmed: PRIO = -1.

If several triggers call subprograms at the same time, the trigger
with the highest priority is processed first, then the triggers of
lower priority. 1 = highest priority.

8.3.4.14 Limits for functions in the spline trigger

The values for PATH and DELAY can be assigned using functions. The follow-
ing constraints apply to these functions:
= The KRL program containing the function must have the attribute Hidden.
m The function must be globally valid.
= The functions may only contain the following statements or elements:
Value assignments
IF statements
Comments
Blank lines
RETURN
Read system variable
Call predefined KRL function
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8.3.5 Copying spline inline forms

Overview

Precondition

Copy

The following copying operations can be carried out:

Copy an individual motion into a spline block
Copy a spline block

Copy a spline segment to another spline block
Copy a spline segment out of a spline block

“Expert” user group
m  Program is selected or open.
m  Operating mode T1

Copy an individual motion into a spline block:

The following individual motions can be copied and pasted into a spline block:

SLIN
SCIRC
LIN
CIRC

|
|
|
|
Precondition:

m The following frame data (= data in the option window Frames) of the in-
dividual motion and the block are identical: Tool, Base and Interpolation
mode

Copy spline block:

A spline block can be copied and pasted at a different point in the program.
Only the empty block is pasted. It is not possible to copy a block and its con-
tents at the same time.

The contents must be copied and pasted separately.

Copy a spline segment to another spline block:

One or more spline segments can be copied and pasted to another block.
Precondition:

m The following frame data (= data in the option window Frames) of the
spline blocks are identical: Tool, Base and Interpolation mode

Copy a spline segment out of a spline block:

One or more spline segments can be copied and pasted outside a spline
block. The motion types change as follows:

Spline segment... ... becomes an individual motion
SLIN SLIN

SCIRC SCIRC

SPL PTP

m  Forindividual SLIN, SCIRC motions: the frame and motion data from the
segment are applied if available; otherwise, the data from the spline block
are applied.

m  Forindividual PTP motion: the position and frame data from the SPL are
applied to the PTP. Motion data are not applied.

8.3.6 Converting spline inline forms from 8.1

Description

More parameters can be set in spline inline forms in KSS 8.2 than in KSS 8.1.
This allows more detailed determination of the motion characteristics.

KUKA
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Programs with inline forms from 8.1 can be used in 8.2. For this, values must
be assigned to the new parameters. This is done by opening the inline form
and closing it again. Default values are automatically assigned to all new pa-
rameters.

Precondition (]

Procedure 1.
2.
3.
4.
5.
8.4

Precondition

A program is selected.
Operating mode T1

Position the cursor in the line with the inline form.

Press Change. The inline form is opened. The default values are automat-
ically set for all new parameters.

If required, modify the values.
Press Cmd OK.
Repeat steps 1 to 4 for all spline inline forms in the program.

Modifying motion parameters

Procedure 1.
2.
3.
4.
8.5

Description

Precondition

A program is selected.
Operating mode T1

Position the cursor in the line containing the instruction that is to be
changed.

Press Change. The inline form for this instruction is opened.
Modify parameters.
Save changes by pressing Cmd Ok.

Re-teaching a point

The coordinates of a taught point can be modified. This is done by moving to

the new position and overwriting the old point with the new position.

Procedure 1.
2.
3.
4.
5.
6.
8.6

8.6.1

A program is selected.
Operating mode T1

Move the TCP to the desired position.

Position the cursor in the line containing the motion instruction that is to be
changed.

Press Change. The inline form for this instruction is opened.

For PTP and LIN motions: Press Touch Up to accept the current position
of the TCP as the new end point.

For CIRC motions:

Press Teach Aux to accept the current position of the TCP as the new
auxiliary point.

Or press Teach End to accept the current position of the TCP as the
new end point.

Confirm the request for confirmation with Yes.
Save change by pressing Cmd Ok.

Programming logic instructions

Inputs/outputs

Digital inputs/outputs
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The robot controller can manage up to 4096 digital inputs and 4096 digital out-
puts. The configuration is customer-specific.

Analog inputs/outputs

The robot controller can manage 32 analog inputs and 32 analog outputs. The
configuration is customer-specific.

Permissible range of values for inputs/outputs: -1.0 to +1.0. This corresponds
to a voltage range from -10 V to +10 V. If the value is exceeded, the input/out-
put takes the maximum value and a message is displayed until the value is
back in the permissible range.

The inputs/outputs are managed via the following system variables:

Inputs Outputs
Digital $IN[1] ... $IN[4096] $OUT[1] ... SOUT[4096]
Analog $ANIN[1] ... SANIN[32] $ANOUTI1] ... SANOUT[32]
8.6.2 Setting a digital output - OUT
Precondition m A program is selected.
m  Operating mode T1
Procedure 1. Position the cursor in the line after which the logic instruction is to be in-

serted.

2. Select the menu sequence Commands > Logic > OUT > OUT.
3. Set the parameters in the inline form.

(>>> 8.6.3 "Inline form “OUT"™" Page 195)
4. Save instruction with Cmd Ok.

8.6.3 Inline form “OUT”

The instruction sets a digital output.

2

State=‘TRUE § CONT |

Fig. 8-23: Inline form “OUT”

ltem | Description

1 Output number
= 1...4096

2 If a name exists for the output, this name is displayed.
Only for the user group “Expert”:
A name can be entered by pressing Long text. The name is freely
selectable.

3 State to which the output is switched
= TRUE
= FALSE

4 m  CONT: Execution in the advance run
= [Empty box]: Execution with advance run stop
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8.6.4 Setting a pulse output - PULSE

Precondition

Procedure

A program is selected.
Operating mode T1

Position the cursor in the line after which the logic instruction is to be in-
serted.

Select the menu sequence Commands > Logic > OUT > PULSE.
Set the parameters in the inline form.

(>>> 8.6.5 "Inline form “PULSE™ Page 196)

Save instruction with Cmd Ok.

8.6.5 Inline form “PULSE”

The instruction sets a pulse of a defined length.

PU

2o e 9

H test_output L State= ‘ TRUE CO'\IT

Tme— 015 Sec

Fig. 8-24: Inline form “PULSE”

Iltem | Description

1 Output number
= 1...4096

2 If a name exists for the output, this name is displayed.
Only for the user group “Expert”:

A name can be entered by pressing Long text. The name is freely
selectable.

3 State to which the output is switched

TRUE: “High” level
FALSE: “Low” level

CONT: Execution in the advance run
[Empty box]: Execution with advance run stop

5 Length of the pulse
= 0.10...3.00s

8.6.6 Setting an analog output - ANOUT

Precondition

Procedure

A program is selected.
Operating mode T1

Position the cursor in the line after which the instruction is to be inserted.
Select Commands > Analog output > Static or Dynamic.

Set the parameters in the inline form.

(>>> 8.6.7 "Inline form “ANOUT” (static)" Page 197)

(>>> 8.6.8 "Inline form “ANOUT” (dynamic)" Page 197)

Save instruction with Cmd Ok.
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8.6.7 Inline form “ANOUT?” (static)

This instruction sets a static analog output.

A maximum of 8 analog outputs (static and dynamic together) can be used at
any one time. ANOUT triggers an advance run stop.

The voltage is set to a fixed level by means of a factor. The actual voltage level
depends on the analog module used. For example, a 10 V module with a fac-
tor of 0.5 provides a voltage of 5 V.

?_9

Fig. 8-25: Inline form “ANOUT” (static)

ltem | Description

1 Number of the analog output
= CHANNEL_1 ... CHANNEL_32
2 Factor for the voltage

m 0...1 (intervals: 0.01)

8.6.8 Inline form “ANOUT” (dynamic)

This instruction activates or deactivates a dynamic analog output.

A maximum of 4 dynamic analog outputs can be activated at any one time.
ANOUT triggers an advance run stop.

The voltage is determined by a factor. The actual voltage level depends on the
following values:

m  Velocity or function generator

For example, a velocity of 1 m/s with a factor of 0.5 results in a voltage of
5V.

m Offset

For example, an offset of +0.15 for a voltage of 0.5 V results in a voltage
of 6.5 V.

ANOUT J>ON'| CHANNEL_I - ‘ 1.00 Oﬁset=‘ O.DG‘ Delay=‘ 0.00 ‘[sec]

Fig. 8-26: Inline form “ANOUT” (dynamic)

T W
TECHVAL[1]

=

ltem | Description

1 Activation or deactivation of the analog output
= ON
= OFF

2 Number of the analog output
= CHANNEL_1 ... CHANNEL_32

3 Factor for the voltage
m 0...10 (intervals: 0.01)

Issued: 20.07.2012 Version: KSS 8.2 END V2 en (PDF 197 / 221



KUKA KUKA System Software 8.2

ltem | Description
4 m  VEL_ACT: The voltage is dependent on the velocity.

= TECHVAL[1] ... TECHVAL[6]: The voltage is controlled by a
function generator.

5 Value by which the voltage is increased or decreased

= -1...+#1 (intervals: 0.01)

6 Time by which the output signal is delayed (+) or brought forward
)

= -0.2..+0.5s

8.6.9 Programming a wait time - WAIT

Precondition

A program is selected.
m  Operating mode T1

Procedure 1. Position the cursor in the line after which the logic instruction is to be in-
serted.

2. Select the menu sequence Commands > Logic > WAIT.
3. Set the parameters in the inline form.

(>>> 8.6.10 "Inline form “WAIT™ Page 198)
4. Save instruction with Cmd Ok.

8.6.10 Inline form “WAIT”

WAIT can be used to program a wait time. The robot motion is stopped for a
programmed time. WAIT always triggers an advance run stop.

?

Fig. 8-27: Inline form “WAIT”

Iltem | Description
1 Wait time

= 20s

8.6.11 Programming a signal-dependent wait function - WAITFOR

Precondition

A program is selected.
m  Operating mode T1

Procedure 1. Position the cursor in the line after which the logic instruction is to be in-
serted.

2. Select the menu sequence Commands > Logic > WAITFOR.
3. Set the parameters in the inline form.

(>>> 8.6.12 "Inline form “WAITFOR™ Page 199)
4. Save instruction with Cmd Ok.
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8.6.12 Inline form “WAITFOR”

The instruction sets a signal-dependent wait function.

If required, several signals (maximum 12) can be linked. If a logic operation is
added, boxes are displayed in the inline form for the additional signals and

C 90000 o

B - -
WAITFORJI §L(‘ ‘ IN 7” ‘)‘CONT

Fig. 8-28: Inline form “WAITFOR”

ltem | Description

1 Add external logic operation. The operator is situated between the
bracketed expressions.
= AND
OR
= EXOR
Add NOT.
= NOT

= [Empty box]

Enter the desired operator by means of the corresponding button.

2 Add internal logic operation. The operator is situated inside a
bracketed expression.

= AND
OR

= EXOR

Add NOT.

= NOT

= [Empty box]

Enter the desired operator by means of the corresponding button.
3 Signal for which the system is waiting

= IN
= OUT
m CYCFLAG
= TIMER
= FLAG
4 Number of the signal
= 1...4096
5 If a name exists for the signal, this name is displayed.

Only for the user group “Expert”:

A name can be entered by pressing Long text. The name is freely
selectable.

6 =  CONT: Execution in the advance run

= [Empty box]: Execution with advance run stop
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8.6.13 Switching on the path - SYN OUT

Precondition

Procedure

A program is selected.
m  Operating mode T1

1. Position the cursor in the line after which the logic instruction is to be in-
serted.

2. Select the menu sequence Commands > Logic > OUT > SYN OUT.
3. Set the parameters in the inline form.
(>>> 8.6.14 "Inline form “SYN OUT", option “START/END"" Page 200)
(>>> 8.6.15 "Inline form “SYN OUT”, option “PATH"" Page 203)
4. Save instruction with Cmd Ok.

8.6.14 Inline form “SYN OUT”, option “START/END”

A switching action can be triggered relative to the start or end point of a motion
block. The switching action can be delayed or brought forward. The motion
block can be a LIN, CIRC or PTP motion.

Possible applications include:

m  Closing or opening the weld gun during spot welding
= Switching the welding current on/off during arc welding

m Starting or stopping the flow of adhesive in bonding or sealing applica-
tions.

SYN OUT | \ State= TRUE START

at Delay—

Fig. 8-29: Inline form “SYN OUT”, option “START/END”

Iltem | Description
1 Output number

= 1...4096

2 If a name exists for the output, this name is displayed.
Only for the user group “Expert”:

A name can be entered by pressing Long text. The name is freely

selectable.
3 State to which the output is switched
= TRUE
= FALSE
4 Point at which switching is carried out
m  START: Switching is carried out at the start point of the motion
block.
= END: Switching is carried out at the end point of the motion
block.
= PATH:

5 Switching action delay
= -1,000... +1,000 ms

Note: The time specification is absolute. The switching point var-

ies according to the velocity of the robot.

Issued: 20.07.2012 Version: KSS 8.2 END V2 en (PDF



Example 1

Example 2

Start point and end point are exact positioning points.

LIN Pl VEL=0.3m/s CPDAT1
LIN P2 VEL=0.3m/s CPDAT2
SYN OUT 1 '' State= TRUE at START Delay=20ms
SYN OUT 2 '' State= TRUE at END Delay=-20ms
LIN P3 VEL=0.3m/s CPDAT3
LIN P4 VEL=0.3m/s CPDAT4

+ ms

Fig. 8-30

OUT 1 and OUT 2 specify approximate positions at which switching is to oc-
cur. The dotted lines indicate the switching limits.

Switching limits:

m  START: The switching point can be delayed, at most, as far as exact po-
sitioning point P3 (+ ms).

= END: The switching point can be brought forward, at most, as far as exact
positioning point P2 (- ms).

If greater values are specified for the delay, the controller automatically switch-
es at the switching limit.

Start point is exact positioning point, end point is approximated.

LIN Pl VEL=0.3m/s CPDAT1

LIN P2 VEL=0.3m/s CPDAT2

SYN OUT 1 '' State= TRUE at START Delay=20ms
SYN OUT 2 '' State= TRUE at END Delay=-20ms
LIN P3 CONT VEL=0.3m/s CPDAT3

LIN P4 VEL=0.3m/s CPDAT4

+ms:
P M
: S0oUT 2_.
: OUT1 : g .n‘/P3

Fig. 8-31

KUKA
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OUT 1 and OUT 2 specify approximate positions at which switching is to oc-
cur. The dotted lines indicate the switching limits. M = middle of the approxi-
mate positioning range.

Switching limits:

m  START: The switching point can be delayed, at most, as far as the start of
the approximate positioning range of P3 (+ ms).

= END: The switching point can be brought forward, at most, as far as the
start of the approximate positioning range of P3 (-).

The switching point can be delayed, at most, as far as the end of the ap-
proximate positioning range of P3 (+).

If greater values are specified for the delay, the controller automatically switch-
es at the switching limit.

Example 3 Start point and end point are approximated

LIN Pl VEL=0.3m/s CPDAT1

LIN P2 CONT VEL=0.3m/s CPDAT2

SYN OUT 1 '' State= TRUE at START Delay=20ms
SYN OUT 2 '' State= TRUE at END Delay=-20ms
LIN P3 CONT VEL=0.3m/s CPDAT3

LIN P4 VEL=0.3m/s CPDAT4

i+ ms]

Fig. 8-32

OUT 1 and OUT 2 specify approximate positions at which switching is to oc-
cur. The dotted lines indicate the switching limits. M = middle of the approxi-
mate positioning range.

Switching limits:
= START: The switching point can be situated, at the earliest, at the end of
the approximate positioning range of P2.

The switching point can be delayed, at most, as far as the start of the ap-
proximate positioning range of P3 (+ ms).

= END: The switching point can be brought forward, at most, as far as the
start of the approximate positioning range of P3 (-).

The switching point can be delayed, at most, as far as the end of the ap-
proximate positioning range of P3 (+).

If greater values are specified for the delay, the controller automatically switch-
es at the switching limit.
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8.6.15 Inline form “SYN OUT”, option “PATH”

Example 1

A switching action can be triggered relative to the end point of a motion block.
The switching action can be shifted in space and delayed or brought forward.
The motion block can be a LIN or CIRC motion. It must not be a PTP motion.

QP@ @@@ ?

SYN OUT I Smte— PATH 0|mm Delay= ‘ 5

TRUE ms

Fig. 8-33: Inline form “SYN OUT”, option “PATH”

ltem | Description

1 Output number
= 1...4096

2 If a name exists for the output, this name is displayed.
Only for the user group “Expert”:

A name can be entered by pressing Long text. The name is freely

selectable.

3 State to which the output is switched
= TRUE
= FALSE

4 Point at which switching is carried out

= PATH: Switching is carried out at the end point of the motion
block.

m  START: (>>> 8.6.14 "Inline form “SYN OUT”, option “START/
END™ Page 200)

= END: (>>> 8.6.14 "Inline form “SYN OUT’, option “START/
END”" Page 200)

5 Distance from the switching point to the end point
= -2,000... +2,000 mm
This box is only displayed if PATH has been selected.

6 Switching action delay
= -1,000... +1,000 ms

Note: The time specification is absolute. The switching point var-
ies according to the velocity of the robot.

Start point is exact positioning point, end point is approximated.

LIN Pl VEL=0.3m/s CPDAT1

SYN OUT 1 '' State= TRUE at START PATH=20mm Delay=-5ms
LIN P2 CONT VEL=0.3m/s CPDAT2

LIN P3 CONT VEL=0.3m/s CPDAT3

LIN P4 VEL=0.3m/s CPDAT4

KUKA
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-5ms 20mm P3

Fig. 8-34

OUT 1 specifies the approximate position at which switching is to occur. The
dotted lines indicate the switching limits. M = middle of the approximate posi-
tioning range.

Switching limits:

m  The switching point can be brought forward, at most, as far as exact posi-
tioning point P1.

m  The switching point can be delayed, at most, as far as the next exact po-
sitioning point P4. If P3 was an exact positioning point, the switching point
could be delayed, at most, as far as P3.

If greater values are specified for the shift in space or time, the controller au-
tomatically switches at the switching limit.

Example 2 Start point and end point are approximated

LIN P1 CONT VEL=0.3m/s CPDATI1

SYN OUT 1 '' State= TRUE at START PATH=20mm Delay=-5ms
LIN P2 CONT VEL=0.3m/s CPDAT2

LIN P3 CONT VEL=0.3m/s CPDAT3

LIN P4 VEL=0.3m/s CPDAT4

-5ms 20mm P3

Fig. 8-35

OUT 1 specifies the approximate position at which switching is to occur. The
dotted lines indicate the switching limits. M = middle of the approximate posi-
tioning range.
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Switching limits:
m  The switching point can be brought forward, at most, as far as the start of
the approximate positioning range of P1.

®m  The switching point can be delayed, at most, as far as the next exact po-
sitioning point P4. If P3 was an exact positioning point, the switching point
could be delayed, at most, as far as P3.

If greater values are specified for the shift in space or time, the controller au-
tomatically switches at the switching limit.

8.6.16  Setting a pulse on the path - SYN PULSE

Precondition

Procedure

A program is selected.
m  Operating mode T1

1. Position the cursor in the line after which the logic instruction is to be in-
serted.

2. Select the menu sequence Commands > Logic > OUT > SYN PULSE.
3. Set the parameters in the inline form.

(>>> 8.6.17 "Inline form “SYN PULSE™ Page 205)
4. Save instruction with Cmd Ok.

8.6.17 Inline form “SYN PULSE”

A pulse can be triggered relative to the start or end point of a motion block. The
pulse can be delayed or brought forward and shifted in space.

@@PG?GP(?GP

SYN PULSE State—

TRUE Tme— 0.10

Delay= ‘ 5 ‘ ms

Fig. 8-36: Inline form “SYN PULSE”

ltem | Description

1 Output number
= 1...4096

2 If a name exists for the output, this name is displayed.
Only for the user group “Expert”:

A name can be entered by pressing Long text. The name is freely
selectable.

3 State to which the output is switched

= TRUE
= FALSE

4 Duration of the pulse

= 01..3s

KUKA
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ltem | Description

5 m  START: The pulse is triggered at the start point of the motion
block.

= END: The pulse is triggered at the end point of the motion
block.

See SYN OUT for examples and switching limits.
(>>> 8.6.14 "Inline form “SYN OUT”, option “START/END™

Page 200)
m  PATH: The pulse is triggered at the end point of the motion
block.

See SYN OUT for examples and switching limits.
(>>> 8.6.15 "Inline form “SYN OUT”, option “PATH™" Page 203)

6 Distance from the switching point to the end point
= -2,000...+2,000 mm

This box is only displayed if PATH has been selected.
7 Switching action delay

= -1,000 ... +1,000 ms

Note: The time specification is absolute. The switching point var-
ies according to the velocity of the robot.

8.6.18 Modifying a logic instruction

Precondition A program is selected.

m  Operating mode T1

Procedure 1. Position the cursor in the line containing the instruction that is to be
changed.

2. Press Change. The inline form for this instruction is opened.
3. Change the parameters.
4. Save changes by pressing Cmd Ok.
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9 Messages

9 Messages
9.1 Automatic External error messages
No. Message text Cause
P00:1 PGNO_TYPE incorrect value The data type for the program

permissible values (1,2,3)

number was entered incorrectly.

P00:2 PGNO_LENGTH incorrect value The selected program number
Range of values 1 < PGNO_LENGTH < | length in bits was too high.
16
P00:3 PGNO_LENGTH incorrect value If BCD format was selected for
permissible values (4,8,12,16) reading the program number, a
corresponding number of bits must
also be set.
P00:4 PGNO_FBIT incorrect value The value “0” or a non-existent
not in the $IN range input was specified for the first bit
of the program number.

P00:7 PGNO_REQ incorrect value The value “0” or a non-existent

not in the $OUT range output was specified for the output
via which the program number is
to be requested.

P00:10 Transmission error Discrepancy detected when

incorrect parity checking parity. A transmission
error must have occurred.

P00:11 Transmission error The higher-level controller has

incorrect program number transferred a program number for
which there is no CASE branch in
the file CELL.SRC.

P00:12 Transmission error The attempt to read the program

incorrect BCD encoding number in BCD format led to an
invalid result.
P00:13 Incorrect operating mode The I/O interface output has not
been activated, i.e. the system
variable $|_O_ACTCONF cur-
rently has the value FALSE. This
can have the following causes:
= The mode selector switch is
not in the “Automatic External”
position.

m  Thesignal $I_O_ACT currently
has the value FALSE.

P00:14 Move to Home position in operating The robot has not reached the

mode T1 HOME position.

P00:15 Incorrect program number More than one input set with “1 of

n-.

KUKA
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10 KUKA Service

10.1 Requesting support

Introduction The KUKA Roboter GmbH documentation offers information on operation and
provides assistance with troubleshooting. For further assistance, please con-
tact your local KUKA subsidiary.

Information The following information is required for processing a support request:

Model and serial number of the robot

Model and serial number of the controller

Model and serial number of the linear unit (if applicable)
Model and serial number of the linear unit (if applicable)
Version of the KUKA System Software

Optional software or modifications

Archive of the software

For KUKA System Software V8: instead of a conventional archive, gener-
ate the special data package for fault analysis (via KrcDiag).

m  Application used
= Any external axes used
m Description of the problem, duration and frequency of the fault

10.2 KUKA Customer Support

Availability KUKA Customer Support is available in many countries. Please do not hesi-
tate to contact us if you have any questions.

Argentina Ruben Costantini S.A. (Agency)
Luis Angel Huergo 13 20
Parque Industrial
2400 San Francisco (CBA)
Argentina
Tel. +54 3564 421033
Fax +54 3564 428877
ventas@costantini-sa.com

Australia Headland Machinery Pty. Ltd.
Victoria (Head Office & Showroom)
95 Highbury Road
Burwood
Victoria 31 25
Australia
Tel. +61 3 9244-3500
Fax +61 3 9244-3501
vic@headland.com.au
www.headland.com.au

KUKA
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Belgium KUKA Automatisering + Robots N.V.
Centrum Zuid 1031
3530 Houthalen
Belgium
Tel. +32 11 516160
Fax +32 11 526794
info@kuka.be
www.kuka.be

Brazil KUKA Roboter do Brasil Ltda.
Avenida Franz Liszt, 80
Parque Novo Mundo
Jd. Guanga
CEP 02151 900 Séao Paulo
SP Brazil
Tel. +55 11 69844900
Fax +55 11 62017883
info@kuka-roboter.com.br

Chile Robotec S.A. (Agency)
Santiago de Chile
Chile
Tel. +56 2 331-5951
Fax +56 2 331-5952
robotec@robotec.cl
www.robotec.cl

China KUKA Automation Equipment (Shanghai) Co., Ltd.
Songjiang Industrial Zone
No. 388 Minshen Road
201612 Shanghai
China
Tel. +86 21 6787-1808
Fax +86 21 6787-1805
info@kuka-sha.com.cn
www.kuka.cn

Germany KUKA Roboter GmbH
Zugspitzstr. 140
86165 Augsburg
Germany
Tel. +49 821 797-4000
Fax +49 821 797-1616
info@kuka-roboter.de
www.kuka-roboter.de
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France KUKA Automatisme + Robotique SAS
Techvallée
6, Avenue du Parc
91140 Villebon S/Yvette
France
Tel. +33 1 6931660-0
Fax +33 1 6931660-1
commercial@kuka.fr
www.kuka.fr

India KUKA Robotics India Pvt. Ltd.
Office Number-7, German Centre,
Level 12, Building No. - 9B
DLF Cyber City Phase Il
122 002 Gurgaon
Haryana
India
Tel. +91 124 4635774
Fax +91 124 4635773
info@kuka.in
www.kuka.in

Italy KUKA Roboter Italia S.p.A.
Via Pavia 9/a - int.6
10098 Rivoli (TO)
Italy
Tel. +39 011 959-5013
Fax +39 011 959-5141
kuka@kuka.it
www.kuka.it

Japan KUKA Robotics Japan K.K.
Daiba Garden City Building 1F
2-3-5 Daiba, Minato-ku
Tokyo
135-0091
Japan
Tel. +81 3 6380-7311
Fax +81 3 6380-7312
info@kuka.co.jp

Korea KUKA Robotics Korea Co. Ltd.
RIT Center 306, Gyeonggi Technopark
1271-11 Sa 3-dong, Sangnok-gu
Ansan City, Gyeonggi Do
426-901
Korea
Tel. +82 31 501-1451
Fax +82 31 501-1461
info@kukakorea.com
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Malaysia KUKA Robot Automation Sdn Bhd
South East Asia Regional Office
No. 24, Jalan TPP 1/10
Taman Industri Puchong
47100 Puchong
Selangor
Malaysia
Tel. +60 3 8061-0613 or -0614
Fax +60 3 8061-7386
info@kuka.com.my

Mexico KUKA de Mexico S. de R.L. de C.V.
Rio San Joaquin #339, Local 5
Colonia Pensil Sur
C.P. 11490 Mexico D.F.
Mexico
Tel. +52 55 5203-8407
Fax +52 55 5203-8148
info@kuka.com.mx

Norway KUKA Sveiseanlegg + Roboter
Sentrumsvegen 5
2867 Hov
Norway
Tel. +47 61 18 91 30
Fax +47 61 18 62 00
info@kuka.no

Austria KUKA Roboter Austria GmbH
Vertriebsbiiro Osterreich
Regensburger Strasse 9/1
4020 Linz
Austria
Tel. +43 732 784752
Fax +43 732 793880
office@kuka-roboter.at
www.kuka-roboter.at

Poland KUKA Roboter Austria GmbH
Spodtka z ograniczong odpowiedzialnoscig
Oddziat w Polsce
Ul. Porcelanowa 10
40-246 Katowice
Poland
Tel. +48 327 30 32 13 or -14
Fax +48 327 30 32 26
ServicePL@kuka-roboter.de
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Portugal KUKA Sistemas de Automatizacion S.A.
Rua do Alto da Guerra n° 50
Armazém 04
2910 011 Setubal
Portugal
Tel. +351 265 729780
Fax +351 265 729782
kuka@mail.telepac.pt

Russia OO0 KUKA Robotics Rus
Webnaja ul. 8A
107143 Moskau
Russia
Tel. +7 495 781-31-20
Fax +7 495 781-31-19
kuka-robotics.ru

Sweden KUKA Svetsanlaggningar + Robotar AB
A. Odhners gata 15
421 30 Vastra Frélunda
Sweden
Tel. +46 31 7266-200
Fax +46 31 7266-201
info@kuka.se

Switzerland KUKA Roboter Schweiz AG
Industriestr. 9
5432 Neuenhof
Switzerland
Tel. +41 44 74490-90
Fax +41 44 74490-91
info@kuka-roboter.ch
www.kuka-roboter.ch

Spain KUKA Robots IBERICA, S.A.
Pol. Industrial
Torrent de la Pastera
Carrer del Bages s/n
08800 Vilanova i la Geltra (Barcelona)
Spain
Tel. +34 93 8142-353
Fax +34 93 8142-950
Comercial@kuka-e.com
www.kuka-e.com
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South Africa Jendamark Automation LTD (Agency)
76a York Road
North End
6000 Port Elizabeth
South Africa
Tel. +27 41 391 4700
Fax +27 41 373 3869
www.jendamark.co.za

Taiwan KUKA Robot Automation Taiwan Co., Ltd.
No. 249 Pujong Road
Jungli City, Taoyuan County 320
Taiwan, R. O. C.
Tel. +886 3 4331988
Fax +886 3 4331948
info@kuka.com.tw
www.kuka.com.tw

Thailand KUKA Robot Automation (M)SdnBhd
Thailand Office
c/o Maccall System Co. Ltd.
49/9-10 Soi Kingkaew 30 Kingkaew Road
Tt. Rachatheva, A. Bangpli
Samutprakarn
10540 Thailand
Tel. +66 2 7502737
Fax +66 2 6612355
atika@ji-net.com
www.kuka-roboter.de

Czech Republic KUKA Roboter Austria GmbH
Organisation Tschechien und Slowakei
Sezemicka 2757/2
193 00 Praha
Horni PocCernice
Czech Republic
Tel. +420 22 62 12 27 2
Fax +420 22621227 0
support@kuka.cz

Hungary KUKA Robotics Hungaria Kift.
Fo ut 140
2335 Taksony
Hungary
Tel. +36 24 501609
Fax +36 24 477031
info@kuka-robotics.hu
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USA KUKA Robotics Corp.
22500 Key Drive
Clinton Township
48036
Michigan
USA
Tel. +1 866 8735852
Fax +1 586 5692087
info@kukarobotics.com
www.kukarobotics.com

UK KUKA Automation + Robotics
Hereward Rise
Halesowen
B62 8AN
UK
Tel. +44 121 585-0800
Fax +44 121 585-0900
sales@kuka.co.uk
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T KUKA

Index

Symbols

#BSTEP 138

#ISTEP 138

#MSTEP 138

$ANIN 195

$ANOUT 195

$IN 195

$OUT 195
$ROBRUNTIME 74, 75

Numbers
2004/108/EC 35
2006/42/EC 35
3-point method 107
89/336/EEC 35
95/16/EC 35
97/23/EC 35

A

ABC 2-point method 104

ABC World method 104
Accessories 11, 13

Actual position 66

Administrator 52

Advance run 139

ANOUT 196

Applied norms and regulations 35
Approximate positioning 152, 176
Archiving overview 145
Archiving, logbook 148

Archiving, network 147

Archiving, to USB stick 147
ASCIl Mode (menu item) 138
Automatic External error messages 207
Automatic mode 32

Auxiliary point 152

Axis range 15

Axis range limitation 24

Axis range monitoring 24

B

Backward motion 141

Base calibration 106

BASE coordinate system 53, 106
Block pointer 135

Block selection 141, 158

Brake defect 27

Brake release device 25

Braking distance 15

Cc

Calibrating an external kinematic system 118
Calibration 99

Calibration points (menu item) 74
Calibration, base 106

Calibration, external TCP 110

Calibration, fixed tool 110

Calibration, linear unit 116

Calibration, root point, kinematic system 118
Calibration, tool 99

Calibration, TOOL kinematic system 122
Calibration, workpiece 110

Cancel program 134

CE mark 14

CELL.SRC 142

CIRC motion 173

CIRC, motion type 152

Circular angle 181, 186

Cleaning work 33

Cold start 48

Cold start, initial 47, 48

Collision detection 175

Comment 144

Connecting cables 11, 13

Connection manager 38

Continuous Path 151

Coordinate system for jog keys 42
Coordinate system for Space Mouse 41
Coordinate systems 53

Coordinate systems, angles 54
Coordinate systems, orientation 54
Copy 145

Counterbalancing system 33

Counters, displaying 72

CP motions 151

Creating a new folder 132

Creating a new program 133

Cut 145

D

Danger zone 15

Data, restoring 148

Declaration of conformity 14
Declaration of incorporation 13, 14
Decommissioning 34

DEF line (menu item) 137

DEF line, displaying/hiding 137
Deleting mastering 97

Detail view, activating 137

Dial gauge 87

Directory structure 131

Displaying, robot controller information 74
Displaying, robot information 74
Disposal 34

Documentation, industrial robot 9
Drive bus 47

E

EC declaration of conformity 14
Edit (button) 42

Editing a program 142

Editor 133

Electronic Mastering Device 82
EMC Directive 14, 35

EMD 82

EMERGENCY STOP 38
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EMERGENCY STOP device 21, 22, 27
EMERGENCY STOP, external 22, 29
EMERGENCY STOP, local 29

EN 60204-1 36

EN 61000-6-2 36

EN 61000-6-4 36

EN 614-1 36

EN ISO 10218-1 36

EN ISO 12100 36

EN ISO 13849-1 35

EN ISO 13849-2 36

EN ISO 13850 35

Enabling device 22, 27

Enabling device, external 23

Enabling switch 39

Enabling switches 22

error messages, Automatic External 207
Exiting, KSS 45

External axes 13, 16, 66, 74

External kinematic system, calibration 118

F

Faults 28

File list 131

File, renaming 133

Filter 132

Find 145

First mastering 83, 91
Fixed tool, calibration 110
Flags, displaying 70, 71
FLANGE coordinate system 54, 100
Folder, creating 132
Function test 29

G
General safety measures 27
Guard interlock 20

H

Hazardous substances 34
Header 131

Hibernate 48

HOME position 137

HOV 59

I

Identification plate 39
Increment 64

Incremental jogging 64
Indirect method 108, 109
Industrial robot 11, 13

Info (menu item) 74

Inline forms 171
Inputs/outputs, analog 68, 195
Inputs/outputs, Automatic External 69
Inputs/outputs, digital 67, 194
Intended use 13

INTERN.ZIP 147

Interpolation mode 175, 184
Introduction 9

J

Jerk 179, 181, 184, 187

Jerk limitation 179, 181, 184, 187
Jog keys 38, 55, 60

Jog mode 23, 27

Jog mode “Jog keys” 57

Jog mode “Space Mouse” 57
Jog mode, activating 59

Jog override 59

Jogging, axis-specific 54, 60
Jogging, Cartesian 54, 60, 63
Jogging, external axes 65
Jogging, robot 54

K

KCP 15, 27, 37

Keyboard 38

Keyboard key 38

Keypad 44

Kinematics group 42, 57

KUKA Control Panel 37

KUKA Customer Support 74, 209
KUKA smartHMI 41

KUKA smartPAD 15, 37
KUKA.Load 124

KUKA .LoadDataDetermination 124

L

Labeling 26

Language 48

Liability 13

LIN motion 172

LIN, motion type 151

Line break (menu item) 138
Linear unit 13, 115

Load data 124

Loss of mastering 83, 86, 91, 95
Low Voltage Directive 14

M

Machine data 30, 74, 75, 77
Machinery Directive 14, 35

Main menu, calling 44
Maintenance 32, 126

Manipulator 11, 13, 15, 18

Manual mode 31

Mastering 79

Mastering after maintenance work 89
Mastering marks 81

Mastering methods 80

Mechanical axis range limitation 24
Mechanical end stops 24

MEMD 90

Messages 207

Micro Electronic Mastering Device 90
Mode selection 19, 20

Modifying a logic instruction 206
Modifying coordinates 194
Modifying motion parameters 194
Module 50

Monitoring, velocity 23

218 / 221

Issued: 20.07.2012 Version: KSS 8.2 END V2 en (PDF



T KUKA

Motion programming, basic principles 151
Motion types 151
Motor, exchange 89

N

Name, archive 75

Name, control PC 74

Name, robot 74, 75

Navigator 131

Numeric entry, external TCP 112

Numeric entry, external tool 123

Numeric entry, linear unit 117

Numeric entry, root point, kinematic system 119
Numeric input, tool 106

o

Offset 83, 85, 91, 94, 197
Opening a program 133
Operating hours 75

Operating hours meter 75
Operating mode, changing 52
Operation 37

Operator 15, 17, 52

Operator safety 19, 20, 27
Options 11, 13

Orientation control 176
Orientation control (spline) 182, 185, 188
Orientation control, LIN, CIRC 154
Orientation control, SPLINE 165
OuUT 195

Output, analog 196

Output, digital 195

Overload 27

Override 59, 139

Override (menu item) 66
Overview of the industrial robot 11

P

Palletizing robots 101, 106

Panic position 22

Paste 145

Payload data 124

Payload data (menu item) 125
Performance Level 19

Personnel 16

Plant integrator 16

Point-to-point 151

Positionally accurate robot, checking activation
79

Positioner 13, 118

POV 139

Pre-mastering position 81
Pressure Equipment Directive 33, 35
Preventive maintenance work 33
Printing a program 145

Product description 11

Program lines, deleting 144
Program management 131
Program override 139

Program run mode, selecting 138
Program run modes 138

Program, cancel 134
Program, closing 135
Program, creating 133
Program, opening 133
Program, selecting 133
Program, starting 140
Program, stopping 140, 141, 142
Programmer 52

Programming, inline forms 171
Programming, User 171
Protective equipment 23

PTP motion 171

PTP, motion type 151

PULSE 196

Pulse 196

Pulse, path-related 205

R

Rating plate 77

RDC, exchange 89
Re-teaching 194

Reaction distance 15
Recommissioning 28, 77
Reference mastering 89
Release device 25
Renaming a file 133
Renaming the base 114
Renaming the tool 114
Repair 32

Replace 145

Resetting a program 142
Robot controller 11, 13
Robot data (menu item) 74
ROBROOT coordinate system 53

S

Safe operational stop 15, 23
Safeguards, external 26
Safety 13

Safety controller 20

Safety functions 27

Safety functions, overview 19
Safety instructions 9

Safety STOP 0 15

Safety STOP 1 15

Safety STOP 2 16

Safety STOP 0 15

Safety STOP 1 15

Safety STOP 2 16

Safety stop, external 23
Safety zone 15, 17, 18
Safety, general 13

SCIRC motion, programming 180
SCIRC segment, programming 185
Selecting a program 133
Selecting the base 59
Selecting the tool 59

Serial number 75

Service life 15, 74

Service, KUKA Roboter 209
Shutdown (menu item) 45
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Simulation 32

Single point of control 34
Singularities 169

SLIN motion, programming 178
SLIN segment, programming 185
smartHMI 12, 41

smartPAD 15, 37

Software 11, 13

Software components 11

Software limit switches 23, 27, 97
Software limit switches, modifying 97
Space Mouse 38, 55, 60, 62, 63
Special characters 171

SPL segment, programming 185
Spline block, programming 182
Spline motion, orientation control 182, 185, 188
Spline, motion type 155

SPOC 34

Stamp 144

Start backwards key 38

Start key 38, 39

Start types 48

Start-up 28, 77

Start-up mode 30

Start-up wizard 77

Starting a program, automatic 140
Starting a program, backwards 141
Starting a program, manual 140
Starting Automatic External mode 142
Starting the KSS 44

Status bar 41, 42, 131

Status keys 38

STOP 0 14, 16

STOP 1 14, 16

STOP 2 14, 16

Stop category 0 16

Stop category 1 16

Stop category 2 16

STOP key 38

Stop reactions 18

Stopping a program 140, 141, 142
Stopping distance 15, 18

Storage 34

Storage capacities 74

Submit interpreter 43

Submit interpreter, status indicator 43
Supplementary load data (menu item) 125
Support request 209

Switching action, path-related 200
Switching on the robot controller 44
SYN OUT 200

SYN PULSE 205

System integrator 14, 16, 17

T
T116

T2 16

Target group 9

TCP 99

TCP, external 110
Teach pendant 11, 13

Teaching 194

Technology packages 12, 74, 171
Terms used, safety 14

Timers, displaying 73

Tool calibration 99

Tool Center Point 99

TOOL coordinate system 53, 99
Tool, external 122

Touch screen 37, 44
Trademarks 9

Training 9

Transportation 28

TRIGGER, for spline 188
Turn-tilt table 13, 118

Type, robot 74

Type, robot controller 74

u

Unmastering 97

USB connection 39

USB sticks 12

Use, contrary to intended use 13
Use, improper 13

User 15, 16

User group, changing 51

User group, default 52

User interface 41

Vv

Velocity 59, 139

Velocity monitoring 23
Version, kernel system 74
Version, operating system 74
Version, robot controller 74
Version, user interface 74
Voltage 69, 195, 197

w

WAIT 198

Wait function, signal-dependent 198
Wait time 198

WAITFOR 198

Warnings 9

Working range limitation 24
Workpiece base calibration 120
Workpiece base, numeric entry 122
Workspace 15, 17, 18

Workspace monitoring, bypassing 65
WORLD coordinate system 53

X
XYZ 4-point method 101
XYZ Reference method 103
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